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1 The SafeGuard Management Center

The SafeGuard Management Center is the central instrument for carrying out all administrative
activities.

The SafeGuard Management Center provides for serving multiple databases and domains by way
of tenant-specific configurations (Multi Tenancy). You are able to administrate different
SafeGuard Enterprise Databases and maintain different configurations. These configurations can
also be exported to and imported from files to ease configuration.

The SafeGuard Management Center does not need to be necessarily installed on one computer
only. It can be installed on any computer on the network from which the databases can be
accessed.

Only privileged users - security officers - can access the SafeGuard Management Center. Several
Security Officers can work with the data simultaneously.
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1.1

111

Logon to the SafeGuard Management Center

When installing and configuring SafeGuard Enterprise, all essential configuration settings are
carried out and an account is created for a Master Security Officer. This account is required the
first time you log on to the SafeGuard Management Center. To start the Management Center, the
user needs to know the password for the certificate store and have the certificate’s private key.

For further information see the Installation Manual.

Logon depends on whether you run the SafeGuard Management Center in Single Tenancy or in
Multi Tenancy mode.

Logon in Single Tenancy mode

1. Start the SafeGuard Management Center via the Start menu. You will see a logon dialog.

SafeGuardi® Management Center Authenti... E3
Flease select the security officer For authentication:
= 5
Certificate Store password:
| xxxxxxxx 1 |
Token PIN:
[8]4 Cancel |

2. Logonasan MSO and enter the certificate store password specified during initial
configuration. Click OK.

Note: If you enter an incorrect password, an error message will be displayed and a delay will be
imposed for the next logon attempt. The delay period will be increased with each failed logon
attempt. Failed attempts will be logged.

The SafeGuard Management Center is opened.
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1.1.2 Logon in Multi Tenancy mode

The Logon process to the Management Center is extended when you have configured several
databases (Multi Tenancy), see Working with multiple database configurations on page 20.

1. Start the SafeGuard Management Center via product folder of the Start menu. The Select
Configurations dialog will be displayed.

P Select Configuration x|

Please select the configuration you would like to use or select "hNew" to
create a new configuration

|?Cnmpany_uTIMACO_Administrator (SGEMSRY: SafeGuard _UTIM. ., j

Mew Delete | Irnpork, .. | Export... |

i Zancel |

2. Select the database configuration you want to use from the drop-down list and click OK. The
selected database configuration is connected to the Management Center and will become
active.

3. Toauthenticate to the SafeGuard Management Center you are prompted to select the Security
Officer name for this configuration and to enter their certificate store password. Confirm with

OK.
1l SafeGuard® Management Center x|

Configuration:
MyCompany2 (SEMSRY: best)

Please select the Security Officer For authentication:

(M50 M

Certificate store password;

| xxxxxxxx |

Token PIN:
| |

ok Cancel |

The SafeGuard Management Center will be opened and connected to the selected database
configuration.

Note: If you enter an incorrect password, an error message will be displayed and a delay will be
imposed for the next logon attempt. The delay period will be increased with each failed logon
attempt. Failed attempts will be logged.
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Operating steps in the SafeGuard Management Center

The following steps are essential for working with SafeGuard Enterprise to ensure that the
companywide security policies can be applied to the endpoint computers:

Create or import the organizational structure.

Create additional security officers.

Define initial (principal) policy items.

Save to the database.

Export and import configurations.
Day-to-day use

After logging on for the first time, settings can be added as required. The various security officers
can perform actions in accordance with the roles assigned to them.

If new settings are saved to the database, they can be transferred to the endpoint computers where
they become active.
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2.1 The Management Center work area
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—Buttons for all administrative actions

Navigation area

The navigation area contains buttons for all administrative actions:
Users & Computers

To import groups and users from an active directory, from the domain or from an individual
computer.

Policies
To create policy items.
Keys & Certificates

To manage keys and certificates.
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Tokens

To manage tokens and smartcards

Security Officers

To create new security officers or roles and define actions for which additional authorization
is required.

Reports

Enables records to be created of all security-related events and their management.

Navigation window

Objects to be processed or which can be created are displayed in the navigation window
(Active Directory objects such as OUs, users and computers, policy items,...) depending on
the administrative task selection.

Action area

For defining settings for the objects selected in the navigation window. The action area contains
various tabs with which objects are processed and settings are carried out.

The action area also includes information about the selected objects.

Associated views

Additional objects and information as required are displayed in these views. They provide useful
information for system administration and they make use of the system easier. For example, keys
can be allocated using drag-and-drop objects.

Toolbar

Contains symbols for the different Management Center actions. Symbols are displayed as and
when they are available for the selected object.

After logon, the Management Center always opens with the view in which it was closed.
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3 Creating the organizational structure

Users and computers can also be defined in SafeGuard Enterprise and do not have to be imported
from the Active Directory. If there is no existing organizational structure, it can be quickly created
in SafeGuard Enterprise along with a structure for managing policy items. It is also possible to
assign policies and/or encryption rules to local users.

A security officer with the respective rights can set up workgroups or domains which have not yet
been imported in order to manage the automatically registered users and computers.

New users/computers logging on to SafeGuard Enterprise are displayed under their
corresponding containers after initial synchronization with the database in the SafeGuard
Management Center. The security officers can then manage them exactly the same as imported
objects.

The directory for these users/computers, .Auto registered, is automatically created in the root
directory and under each domain/workgroup. It cannot be renamed or moved. Objects assigned
to this directory cannot be moved manually either.

¥ vafeiward® Management Lenter (MU on SNSRY bafeluard)

=4[5 Root [Fiker is active]
" e Koy | Eolcies | Invenkory | Licenses

(&) uhesiicatend Usens Key Hame. Description Avalabin Kiys [Fiter b acttor] 0]
[ futo registernd £

=HLL) wnimaco cou
{3 st regerered

Rk _Mioek@SaN
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3.1 Registering as a new user

For logging on as a new user, see Power-on Authentication (POA) on page 178. When a new user
logs on to SafeGuard Enterprise for the first time, their database status is checked during the
initial synchronization with the database and the new object is displayed under the respective
container in accordance with the information in the database. If no new workgroup or domain
has been created, the new user is added in Auto.registered under the Root directory. If a domain
has already been created, but the user/computer has not yet been imported, they are added in
Auto.registered under the domain.

Note: Local users cannot log on to SafeGuard Enterprise with an empty password. Local users
who log on to SafeGuard Enterprise with an empty password remain as guests and are not saved
to the database. If, in addition, Windows Autologin is activated for these users, logon is denied to
them. For a successful logon at SafeGuard Enterprise a new password must be created in this case
and the Windows Autologin must be deactivated in the registry of the endpoint computer.

Logon Database status Displayed in the Management Center
information about
the local object
Local users Local users not known Under master directory, .Auto
registered newly added under its
computer
Local users, Domain nodes known Already present under domain nodes
computers + Users/computers present
domains - -
Domain nodes known Auto registered newly added under
Users/computers not present | domain nodes

10
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11

Logon
information about
the local object

Computer
workgroups +
workgroup

Database status

Workgroup known

Users/computers not
physically present

Displayed in the Management Center

Already present under workgroup

Workgroup known

Name of computer
workgroups present under
Auto registered

Newly added under .Auto registered
workgroup

Caution:

In this case you need to check whether
the Computer workgroups are present
twice in the workgroup. To
differentiate between identical
computers, go to Properties and enter
the Description. We recommend
however that you manually remove
the computer from the .Auto
registered workgroup directory.

Workgroup known
Users/computers not present

Newly added under .Auto registered
workgroup

Workgroup not known
Computer workgroups known
under .Auto registered root
directory

Already present under Root directory,
Auto registered

Workgroup not known
Computer workgroups not
known under .Auto registered
root directory

Newly added under .Auto registered
root directory

Computer domains
+ domain

Domain known
Computer domains present

Already present under domain

Domain not known

Newly added under .Auto registered
root directory

Domain not yet synchronized

Newly added under .Auto registered
domain
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3.2 Sample use cases for auto-registration

Below you find two use cases on the behavior of auto-registered objects.

Use case 1: Administrating users/computers not part of an Active Directory

In a company not all user or computer objects might necessarily be part of an Active
Directory (AD), e.g. local users. A company might have one or few workgroups so that an
AD is not needed.

This company wants to deploy SafeGuard Enterprise and then add policies to its user/
computer objects. Therefore the company's organizational structure will be built up
manually in the SafeGuard Management Center as follows:

Users & Computers tree:
Root
|_.Authenticated Computers
|_.Authenticated Users
|_.Auto registered
|_SampleWorkgroup (entry added manually)
|_.Auto registered

|_SampleComputer001 (entry
created on logon)

|_SampleComputer002 (entry
created on logon)

The user and computer objects remain in the .Auto registered folder. But they can be
administered properly with the SafeGuard Management Center (adding or removing
policies etc).

12
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Use case 2: SafeGuard Enterprise Database and Active Directory out of sync

A user and computer (SafeGuard Enterprise client) are already part of the company's Active
Directory (AD). But the SafeGuard Enterprise database and the AD are out of sync: user
and computer are not listed in the SafeGuard Management Center yet.

The user logs on to the computer (SafeGuard Enterprise client) with the following
credentials:

SampleUser
SamplePassword
Sample Domain

This information is sent to the SafeGuard Enterprise Server. In the SafeGuard
Management Center the following entries are created:

Users & Computers tree:
Root
|_.Authenticated Computers
|_.Authenticated Users
|_.Auto registered
|_SampleDomain (entry created on sync with AD)
|_.Auto registered
|_SampleComputer (entry created on logon)
|_SampleUser (entry created on logon)

Upon the next synchronization between the AD and the SafeGuard Enterprise database the
SampleComputer and the SampleUser are moved automatically to their correct
organizational units (OU).

The MSO can add policies to the .Auto registered folder if desired, but those policies will
apply to SampleComputer and SampleUser only as long as those objects are part of the
Auto registered folder.

Once they are moved to their organizational units (OU) by synchronization between the
AD and the SafeGuard Enterprise Database, the policies set for those OUs will apply to
SampleComputer and SampleUser as well.
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3.3

3.4

3.5

Keys and certificates for auto-registered objects

A certificate is produced as required by the server for each auto-registered object.
A local user gets two keys:

the key to the .Auto registered container

the private key generated as required by the server
Local users neither get other keys for their assigned container nor a root key.

Workgroups do not get a key.

Policies for auto-registered objects

Unlimited policies can be created for auto-registered objects.

Local users are added to the “Authenticated Users” group. Computers are added to the
“Authenticated Computers” group. The policies activated for these groups apply accordingly.

Creating new workgroup

Security officers with the respective rights assigned can create a container under the root
directory which represents a Windows workgroup. Workgroups do not have a key. They cannot
be renamed.

1. Inthe SafeGuard Management Center, click Users & Computers.

2. Right-click Root [filter is active] in the navigation window on the left and select New > Create
new workgroup (auto registration).

3. In Common information enter the following:
a) Enter a Full name for the workgroup.
b) Optionally you can add a description of the workgroup.
c) The type of object is displayed under Connection state, in this case Workgroup.
d) To prevent policy inheritance, you may activate Block Policy Inheritance.

e) Confirm details with OK.

The workgroup is now created. The default .Auto registered directory is automatically created
under the workgroup container. It cannot be renamed or deleted.

14
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3.6

3.7

15

Deleting workgroups

Security officers can delete workgroups. Members assigned to the workgroup are also deleted.
They are automatically re-registered at next logon.

1. In the SafeGuard Management Center click Users & Computers.

2. In the navigation window on the left right-click the workgroup you want to delete and select
Delete. Confirm with Yes.

The workgroup is now deleted. Any members are also deleted.

Creating a new domain

Security officers with the respective rights can create a new domain under the root directory. You
only have to create a new domain, if you do not want to or are not able to import a domain from
the Active Directory (AD), for instance because there is no AD available.

7 SafeGuard® Management Center (M50 on SGNSRY:SafeGuard)

Fle Edt Yew GoTo Actions Tooks Help

J Move ER, GoTo &

Key | Ealicies | Inventary | Synchranize | Licenses |
- thenticated Users
Key Name |Desmutmn Availabls Keys [Filter is active]
{3 Auta registered —
4 UTMAco.ou I Create new domain (auto registration) x|
{8 ko registered Common information
&8 soard Graup Full name: [comaint
&8, BoardMembers
+}{ ] Buikin Distinguished name:
#{7) Computers Description: I
&8 Desktops 5 -
+1{Z] Domain Controllers ormain etbios:
{7 ForeignecurityPrincipals Connection stats: ‘Duma‘n
&) Headquarter
&B Laptops FD“"E _ )
B NewEnployess Block Folicy Inheritance
4 T Users
=HE workgroupt
$ {2 .Auto registered
Filter
~Inherited Keys
oK Cancel
Filker 3 Chiject Name Chject Type Object Path
Policies
5 Keys & Certificates
i Tokens
& security Officers
Reports
»

Aistart| | (B & 2 | Ocisen | @ Sefecuard® Manageme... | ¥ Create new domain (... @

1. In the SafeGuard Management Center click Users & Computers.

2. Right-click Root [filter is active] in the navigation window on the left and select New > Create

new domain (auto registration).
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3.8

3.

In Common information enter the following information about the domain controller . All
three name entries must be correct otherwise the domain will not be synchronized:

a) Full name: For example computer name.domain.com or the IP address of the domain
controller

b) Distinguished name: DNS name, for example

DC=computername3,DC=domain,DC=country
c) A description for the domain (optional)
d) Domain Netbios: Name of the domain controller
e) The type of object is displayed under Connection state, in this case Domain.
f) To prevent policy inheritance, you may activate Block Policy Inheritance.

g) Confirm details with OK.

The new domain has now been created. Users and/or computers are automatically assigned to
this domain during auto registration. The default .Auto registered directory is automatically
created under the domain container. It cannot be renamed or deleted.

Renaming a domain

A security officer with the respective rights can rename a domain and define additional
properties.

1.

2.

In the SafeGuard Management Center click Users & Computers.

Right-click the domain you want to rename in the navigation window on the left and select
Properties.

In Common information under Full name change the domain name and the description if
required.

You may change the name of the domain controller in Domain NetBios.

You can also define the Wake on LAN mode for automatic reboot in the Container Settings
tab.

. Confirm with OK.

The changes are now saved.

16
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3.9 Deleting a domain

Security officers with the respective rights can delete domains. Members assigned to the domain
are also deleted.

1. In the SafeGuard Management Center click Users & Computers.

2. In the navigation window on the left right-click the domain you want to delete and select
Delete. Confirm with Yes.

The domain is now deleted. Any members are also deleted.

3.10 Deleting auto registered computers

When an auto-registered computer is deleted, all local users of this computer are also deleted.
They are automatically re-registered the next time they log on to this computer.

3.11 Filter for local objects

17

Users & Computers

In Users & Computers you can filter the view in the navigation area on the left according to local
users or search for specific local users.

1. In the SafeGuard Management Center click Users & Computers.
2. In the bottom left of the navigation window click Filter.
3. Activate Local user as Type. If you are looking for a specific user, enter the name of this user.

4. Click the magnifier icon.

The Users & Computers view is filtered according to the criteria.

Logging

Successful/unsuccessful registration of the user, computer or workgroup is logged. You can view
a list of this information in the SafeGuard Management Center under Reports in the event
viewer.
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3.12 Importing the organizational structure from an Active Directory

You have the option of importing an existing organizational structure to the SafeGuard
Enterprise Database, e.g. via an Active Directory.

1. In the SafeGuard Management Center select Tools > Options.

2. Select the Directory tab and click Add.

3. In LDAP Authentication do the following:

a) For Server name or IP enter the NetBIOS name of the domain controller or its IP address.

b) For User credentials enter your Windows user name and password for the (test)
environment.

c¢) Confirm with OK.

Note: For Windows single computer a directory must be approved on the PC to enable a
connection via LDAP.

4. Click Users & Computers.
5. Inthe left-hand navigation window, click the root directory Root [filter is active].
6. Select the Synchronize tab in the action area on the right.

7. Select the required directory from the Directory DSN list. Click the magnifier icon, top right.
A graphical representation of the Active Directory structure of the organizational units (OU)
in your company will appear.

8. You do not need to import the entire contents of the Active Directory. Check the
organizational units (OU) to be synchronized.

9. Click Synchronize at the bottom of the action area.

Note: When synchronizing users and their group membership, membership to a ‘primary group'
will not be synchronized as it is not visible for the group.

The domains are synchronized. Synchronization details are displayed. You can view a
synchronization protocol in the status bar at the left. When clicking on it, you can copy this
protocol to the clipboard and paste it into an e-mail or file in case you would like to inform your
users on the synchronization results.

18
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3.13 Importing a new domain from an Active Directory

19

If you only want to import a new domain from the Active Directory, proceed as follows:
1. In the left-hand navigation window, click the root directory Root [filter is active].

2. Select File > New > Import new domain from AD.

3. Select the Synchronize tab in the action area on the right.

4. Select the required directory from the Directory DSN list. Click the magnifier icon, top right.
A graphical representation of the Active Directory structure of the organizational units (OU)
in your company will appear.

5. Check the domain to be synchronized and click Synchronize at the bottom of the navigation
area.
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4 Working with multiple database configurations

The SafeGuard Management Center allows for use of multiple database configurations (Multi
Tenants). If you want to make use of this feature you need to enable it during installation. For
details see the SafeGuard Enterprise Installation manual.

With Multi Tenancy you are able to configure different SafeGuard Enterprise Database
configurations and maintain them for one instance of the SafeGuard Management Center. This
is particularly useful when you want to have different configurations for different domains,
organizational units or company locations.

Prerequisite: The feature Multi Tenancy must have been installed via a Custom installation.

Initial configuration must have been carried out. For details see the SafeGuard Enterprise
Installation manual.

To ease configuration the following is possible:
Create multiple database configurations.
Select from a list of previously created database configurations.
Import a previously created database configuration from a file.

Export a database configuration to be reused at a later point in time.

1l Select Configuration Ed

Please select the configuration wou would like bo use or select "Hew” to
create a new configuration

|f!C0mpany_UTIM.C\CO_.C\dministratnr [SEMSRY: SaFeGuard_UTIM...Ej

e Delete | Irnport... | Expork, .. |

[0 4 Cancel |

20
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4.1 Creating further database configurations

4.2

To create a further SafeGuard Enterprise Database configuration after initial configuration,
proceed as follows:

1.

2.

Start the SafeGuard Management Center. The Select Configuration dialog will be displayed.
Click New. The SafeGuard Management Center Configuration Wizard starts automatically.

The Wizard will guide you through the necessary steps of creating a new database
configuration. Make your settings as required. The new database configuration will be
generated.

To authenticate to the SafeGuard Management Center you are prompted to select the Security
Officer name for this configuration and to enter their certificate store password. Confirm with
OK.

The SafeGuard Management Center will be opened and connected to the new database
configuration. When the SafeGuard Management Center is started for the next time, the new
database configuration can be selected from the list.

Connecting to an existing database configuration

To work on an existing SafeGuard Enterprise Database configuration, proceed as follows:

1.

2.

Start the SafeGuard Management Center. The Select Configuration dialog will be displayed.

Select the required database configuration from the drop-down list and click OK. The selected
database configuration is connected to the Management Center and will become active.

. Toauthenticate to the SafeGuard Management Center you are prompted to select the Security

Officer name for this configuration and to enter their certificate store password. Confirm with
OK.

The SafeGuard Management Center will be opened and connected to the selected database
configuration.
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4.3 Exporting a configuration to a file

4.4

4.5

To save or reuse a database configuration you may export it to a file. To do so, proceed as follows:

1.

2.

Start the SafeGuard Management Center. The Select Configuration dialog will be displayed.
Click Export...

To secure the configuration file you are prompted to enter and confirm a password that will
encrypt the parts configuration file. Click OK.

Specify a file name and storage location for the exported configuration file *. SGNConfig.

. In case this configuration already exists you are asked if you want to overwrite the existing

configuration.

The database configuration is saved to the specified storage location.

Importing a configuration from a file

To use or change a database configuration you may import a previously created configuration
into the SafeGuard Management Center. There are two ways to do so:

via the SafeGuard Management Center (for Multi Tenancy)

by double-clicking the configuration file (for Single and Multi Tenancy)

Importing a configuration via the SafeGuard Management Center

1.

2.

Start the SafeGuard Management Center. The Select Configuration dialog will be displayed.
Click Import..., locate the required configuration file and click Open.
Enter the password for the configuration file defined during the export and click OK.

The selected configuration will be displayed. Confirm to activate it with OK.

. Toauthenticate to the SafeGuard Management Center you are prompted to select the Security

Officer name for this configuration and to enter their certificate store password. Confirm with
OK.

22
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4.6

The SafeGuard Management Center will be opened and connected to the imported database
configuration.

Importing a configuration by double-clicking the configuration file
(Single and Multi Tenancy)

Note: This task is available in Single-Tenancy and Multi Tenancy mode.

It is also possible to export a configuration and distribute it to several security officers. The
security officers then only need to directly double-click the configuration file to open a fully
configured SafeGuard Management Center.

This is advantageous when you use SQL authentication for the database and to avoid that the SQL
password is known by every administrator. You then only need to enter it once, create a
configuration file and distribute it to the respective Security Officers’ computers.

Prerequisite: The initial configuration of the SafeGuard Management Center must have been
carried out. For details see the SafeGuard Enterprise Installation manual.

1. Start the SafeGuard Management Center via the product folder of the Start menu.
2. Select Options from Tools menu and select the Database tab.

3. Enter or confirm the credentials for the SQL Database Server connection.

4. Click Export configuration to export this configuration to a file.

5. Enter and confirm a password for the configuration file.

6. Enter a file name and select a storage location.

7. Distribute this configuration file to the security officers’ computers. Let them know the
password for this file as well as the certificate store password needed to authenticate at the
SafeGuard Management Center.

8. The security officers just need to double-click the configuration file.

9. They are prompted to enter the password for the configuration file.

10.To authenticate to the SafeGuard Management Center, they are prompted to enter their
certificate store password.

The SafeGuard Management Center starts with the imported configuration and this
configuration will be made the new default configuration.
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4.7

4.8

Fast switching of database configurations

To ease administrative task for several tenants SafeGuard Management Center allows for fast
switching of database configurations.

To switch to another database configuration:
1. In the Management Center select Change configuration... from the File menu.

2. Select the database you want to switch to from the drop-down list and confirm with OK.

The SafeGuard Management Center is automatically restarted with the selected configuration.

Note: This task is also available in Single-Tenancy mode.

Checking database integrity

When logging on to the database the database integrity is automatically verified. Should this
check result in any errors, the Verify Database Integrity dialog is displayed.

You can also start the database integrity check manually at any time after logon and display the
Verify Database Integrity dialog:

1. Select Tools > Database integrity from the menu bar of the SafeGuard Management Center.

2. Check the tables by clicking Check all or Check selected. Erroneous tables are marked in the
dialog.

To repair them, click Repair.

24
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)

5.1

5.2

Exporting company and Master Security Officer
certificate

In a SafeGuard Enterprise installation the following two items are critical and require thorough
backup in a safe location:

the company certificate stored in the SafeGuard Database

the Master Security Officer (MSQO) certificate residing in the certificate store of the computer
on which the SafeGuard Management Center is installed.

Both certificates can be exported in form of .p12 files for backup purposes. Installations can then
be restored by importing the relevant company and Security officer certificate as .p12 files and
using them when setting up a new database rather than having to backup and restore the whole
database.

Note: We advise carrying out this task right after initial configuration of the SafeGuard
Management Center.

Exporting the Master Security Officer certificate

To back up the Master Security Officer certificate of the MSO logged on to the SafeGuard
Management Center, do the following:

1. In the SafeGuard Management Center menu bar, select Tools > Options.
2. Select the Certificates tab and click Export in the <Administrator> Certificate section.

3. You are prompted to enter a password for securing the exported file. Enter a password,
confirm it and click OK.

4. Enter a file name and storage location for the file to be exported and confirm with OK.

The Master Security Officer certificate of the currently logged on MSO is exported as a .p12 file
to the defined location and can be used for recovery purposes.

Exporting the company certificates

Note: Only Master Security Officers are entitled to export company certificates for backup
pUrposes.

1. In the SafeGuard Management Center menu bar, select Tools > Options.

2. Select the Certificates tab and click Export in the Company Certificate section.
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3. You are prompted to enter a password for securing the exported file. Enter a password,
confirm it and click OK.

4. Enter a file name and storage location for the file and confirm with OK.

The company certificate is exported as a .p12 file to the defined location and can be used for
recovery purposes.

Restoring a corrupt SafeGuard Management Center installation

In case the installation of the SafeGuard Management Center got corrupted, but the database is
still intact, the installation can be easily restored by installing the SafeGuard Management Center
afresh and using the existing database as well as the backed up Security Officer certificate.

Do the following:

1. Install the SafeGuard Management Center installation package afresh. Open the SafeGuard
Management Center. The Configuration Wizard is started automatically.

2. In Database Connection, select the relevant database server and configure the connection to
the database if required. Click Next.

3. In Database Settings activate Select an available database and select the relevant database
from the list.
4. In Security Officer Data, do either of the following:

If the backed up certificate file can be found on the computer, it will be displayed. Enter the
password you use for authenticating at the SafeGuard Management Center.

If the backed up certificate file cannot be found on the computer, click Import. Browse for
the backed up certificate file and confirm with Open. Enter the password for the selected
certificate file. Confirm with Yes. Enter and confirm a password for authenticating at the
SafeGuard Management Center.

5. Click Next and then Finish to complete the SafeGuard Management Center configuration.

The corrupt SafeGuard Management Center installation is restored.
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5.4 Restoring a corrupt database configuration

A corrupt database configuration can be restored by installing the SafeGuard Management
Center afresh to create a new instance of the database based upon the backed up certificate files.
This will ensure that all existing SafeGuard Enterprise endpoint computers still accept policies
from the new installation. This avoids having to set up and restore the whole database afresh.

The company and Master Security Officer certificates of the relevant database configuration
must have been exported to .p12 files and must be available and valid.

The passwords for the two .p12 files as well as for the certificate store must be known to you.

Do the following:

1.

7.

Install the SafeGuard Management Center installation package afresh. Open the SafeGuard
Management Center. The Configuration Wizard is started automatically.

In Database Connection, check Create a new database. Under Database settings, configure
the connection to the database. Click Next.

In Security Officer Data, select the relevant MSO and click Import.

In Import Authentication Certificate browse for the backed up certificate file. Under Key file
enter and confirm the password specified for this file. Confirm with OK.

The MSO certificate is imported. Click Next.

In Company Certificate, check Restore using an existing company certificate. Click Import
to browse for the backed up certificate file that contains the valid company certificate. You are
prompted to enter the password specified for the certificate store. Enter the password and
confirm with OK. Confirm the message with Yes. The company certificate is imported.

Click Next, then Finish.

The database configuration is restored.
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Licenses

To use the SafeGuard Enterprise Management Center as a live system, you need a valid license.
For example, in the SafeGuard Enterprise database, a valid license is a prerequisite for sending
policies to the endpoint computers. The appropriate token licenses are also needed for token
management.

License files are obtained from your sales partner. These files must be imported into the
SafeGuard Enterprise database after installation. The license file contains: data about the number
of licenses purchased per module/name of the licensee and a specified tolerance limit for
exceeding the number of licenses. If the number of available licenses or the tolerance limit is
exceeded, relevant warning/error messages are displayed when you start the SafeGuard
Management Center (see License exceeded on page 32).

In the Users & Computers area, the SafeGuard Management Center provides an overview of the
license status of the installed SafeGuard Enterprise system.

The license status display is available in the Licenses tab for the root node, for domains, OUs,
container objects and workgroups. Here security officers will find detailed information about the
license status and can, if they have the appropriate permission, import licenses to the SafeGuard
Enterprise database.

This chapter describes the licensing concept and how to manage licenses in the SafeGuard
Management Center.

License file

The license file that you are given to import to the SafeGuard Enterprise database is an .XML file
with a signature. The license file includes the following information:

Company name

Additional information (for example, department, subsidiary)
Date issued

Versions of SafeGuard Enterprise for which the license is valid.
Number of licenses per module

Token license information

License expiry date

License type (demo or full license)

Signature with license signature certificate

28



SafeGuard® Enterprise 5.50, Administrator help

6.2

6.3

6.3.1

6.3.2

29

Token licenses

To manage tokens or smartcards the appropriate token licenses are required. If the appropriate
licenses are not available, creating polices for tokens in the SafeGuard Management Center is not
possible.

Evaluation and demo licenses

The default license file (evaluation license) or individual demo license files can be used for
evaluation or initial rollout. These licenses are time sensitive and have an expiration date.
However, there are no functional restrictions.

Note: Evaluation and demo licenses may not be used for normal live operation.

Default license file

When the SafeGuard Enterprise Management Center is installed, a default license file is
automatically loaded. This evaluation license (named SafeGuard Enterprise Evaluation License)
holds five licenses for each module and it has a time limit of two years as of the release date of the
SafeGuard Enterprise version in question.

Individual demo license files

If the default license file is insufficient for carrying out an evaluation, there is also the option of
obtaining a demo license customized to your specific needs. In such a case, please contact your
sales partner. The usage of this type of demo license is also subject to a time limit. The license is
also restricted to the number of licenses per module agreed upon with your sales partner in the
individual case.

When you start the SafeGuard Management Center, a warning message reminds you that you are
using demo licenses. If the number of available licenses specified in the demo license is exceeded,
or if the time limit is reached, an error message is displayed, see License exceeded on page 32.
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License status overview
You access the license status overview as follows:
1. In the SafeGuard Management Center navigation area, click Users & Computers.

2. In the navigation window, on the left-hand side, click on the root node, the domain,
the OU, the container object or the workgroup.

3. Inthe action area, switch to the Licenses tab on the right-hand side.

The license status appears.
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The display is divided into three areas. The upper area shows the name of the customer for whom
the license has been issued, plus the issue date.

The middle area provides details of the license. The individual columns contain the following
details:

Column Explanation

Status (icon) Uses an icon to show the status of the licenses (valid,
warning, error) for the module in question.

Feature Shows the installed module.
Purchased Licenses Shows the number of licenses purchased for the installed
module.
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Column Explanation

Used Licenses Shows the number of licenses used for the installed
module.

Highest Granted Version | Shows the highest SafeGuard Enterprise version for
which the licenses are valid.

Highest Used Version Shows the latest installed SafeGuard Enterprise version.
Expires Shows the license's expiry date.

Type Shows the license type - demo or normal full license.
Tolerance Limit Shows the tolerance limit specified for exceeding the

number of purchased licenses.

If you display tab Licenses for a domain/OU, the overview shows the status based on the
computer in the relevant branch.

Beneath this overview are details of the licensed token modules.

In the lower area, a message with a background color based on the traffic light principle (green =
valid, yellow = warning, red = error) and an icon shows the global status of the license regardless
of the domain or OU selected. In case of warning or error messages, the lower area also offers
information on how to regain a valid license status.

The icons in the middle and lower areas mean the following:
& Valid license

& Invalid license: Warning

w Invalid license: Error

For information about a license status with a warning or an error, see License exceeded on page 32.

To refresh the license status overview, click Recount used licenses.
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Importing license files

Prerequisite: To import a license file to the SafeGuard Enterprise database a security officer
needs the "Import license file" permission.

A license file is imported as follows:

1. You have the Management Center open, in the Users & Computers area.

2. In the navigation window, on the left-hand side, click the root node, the domain or
the OU.

3. Inthe Action area, switch to the Licenses tab on the right-hand side.
4. Click the Import License File button. A window opens allowing you to select the license file.
5. Select the license file you want to import, and click Open.

6. An overview of the contents of the new license file is displayed. Confirm that you wish to
import the license file.

The license file has now been imported to the SafeGuard Enterprise database.

After importing a license file, the module licenses purchased are marked with the license type
regular. Any modules for which no licenses were purchased and for which the evaluation license
(default license file) or individual demo licenses are used are marked with license type demo.

Note: Whenever a new license file is imported, only those modules that are included in this
license file are affected. All other module license information is retained as is from the database.
This import behavior simplifies subsequent evaluation of additional modules after you have
already purchased one or more modules.

License exceeded

A tolerance value has been set in your license file for exceeding the number of licenses purchased
and the license validity period. If the number of available licenses per module or the validity
period is exceeded, first of all a warning message is displayed. This does not impact the system's
live operation and, in this case, no restriction on its functionality takes effect. You now have the
opportunity to review the license status and upgrade or renew your license. The tolerance value
is usually set to 10% of the number of licenses purchased (minimum value: 5, maximum value:
5,000).
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If the tolerance value is exceeded, an error message is displayed. In this case, a restriction is placed
also on the functionality; the deployment of policies to the endpoint computers is disabled. This
cannot be manually reversed in the SafeGuard Management Center. The license has to be
upgraded or renewed before you can use the full functionality once more. Apart from disabling
policy deployment, the functional restriction does not have an impact on the endpoint
computers, and policies already assigned remain active. Also, clients can still be uninstalled
despite the disabling of policy distribution.

The following sections describe how the system behaves in the case of licenses being exceeded in
the categories Warning and Error, and the action that needs to be taken to reverse the functional
restriction.

Invalid license: Warning

If the number of available licenses (or the highest permitted SafeGuard Enterprise version, for
example due to a software update) is exceeded, a warning message appears when you start the
SafeGuard Management Center.

The SafeGuard Management Center opens and displays the license status overview in the
Licenses tab in the Users & Computers area.
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A warning message tells you that the license is invalid. Using the detailed information shown
about the license file you can determine for which module the number of available licenses has
been exceeded. This license status can be reversed by extending, renewing or upgrading the
license, see Invalid license: Error on page 34.
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Invalid license: Error

If the tolerance value for the number of licenses or the period of validity set in the license is
exceeded, the SafeGuard Management Center displays an error message.

In the SafeGuard Management Center, the deployment of policies to the endpoint computers is

disabled.

An error message is also displayed in the Licenses tab in the Users & Computers area.
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Licensed token modules: AET SafeSign Identity Client, Charismathics Smart Security Interface, Siemens HiPath Security Card API,
Aladdin eToken PKI Client, RSA Authentication Client, ActivIdentity ActivClient, a.sign Client

You can:

- Remove unused computers from the database to fall back into your license limit.
- Contact your sales partner to extend your licenses,
- Load a new license file.

For further information please refer to the SafeGuard Enterprise Administrator's Manual.

Recount used licenses

Load license file...

Using the detailed information shown about the license file you can determine for which module
the number of available licenses has been exceeded.

You have the following options for reversing the functionality restriction:

Redistribute licenses

In order that you have enough available licenses, you can uninstall the software on unused
computers and thereby remove the computers from the SafeGuard Enterprise database.

Upgrade/renew licenses

Contact your sales partner to get your license upgraded or renewed. You will be given a new
license file to import to the SafeGuard Enterprise database.
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Import new license file

If you have renewed or upgraded your license, you can import the license file you receive to
the SafeGuard Enterprise database. The newly imported file replaces the invalid license file.

When you redistribute licenses or import a valid license file, the functional restriction is reversed
and the system will continue to run normally.
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SafeGuard Enterprise Security Officers

SafeGuard Enterprise can be administered by one or more security officers. The role-based
management of SafeGuard Enterprise allows splitting the administration among several users.
Any user may be assigned one or more roles. To enhance security additional authorization of an
action can be assigned to an officer’s role.

A top-level administrator, the Master Security Officer (MSQ) with all the rights and a certificate
that does not expire is created by default during initial configuration of the SafeGuard
Management Center. Further security officers can then be assigned for specific tasks such as
helpdesk or auditing.

For your convenience, security officers can be hierarchically arranged in the SafeGuard
Management Center navigation area to reflect your company’s organizational structure.
However, this does not imply any hierarchy in terms of rights and roles.

Security Officer roles

For easy operation SafeGuard Enterprise offers already predefined roles for security officers with
a variety of functions. Additionally, a security officer with the necessary rights can define new
roles from a list of actions/rights and assign them to particular security officers.

The following types of roles are provided:
Master Security Officer (MSO) role
Predefined roles

Customized roles

Master Security Officer

After installing SafeGuard Enterprise, a Master Security Officer (MSO) is created by default
during initial configuration of the SafeGuard Management Center. The Master Security Officer
is the top-level security officer and possesses all the rights and is able to access all objects, i.e.
comparable to a Windows administrator. The Master Security Officer rights cannot be modified.

There may be several Master Security Officers created for one instance of the SafeGuard
Management Center. We strongly recommend to create at least one additional MSO for security
reasons. Additional MSOs may be deleted, but there must always remain one user with the role
of MSO who has been explicitly created as MSO in the SafeGuard Enterprise Database.
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A Master Security Officer can delegate tasks to another person. There are two ways to do this:

A new security officer can be created in Security Officers.

A user or all members of a container imported from the Active Directory and visible in the
SafeGuard Management Center in the root directory can be promoted to security officer in
Users and Computers.

One or more roles and domains can then be assigned to them. For example, a user may be
assigned the role of Supervising Officer plus the role of Helpdesk Officer.

However, the Master Security Officer can also create custom roles and assign them to particular
users.

Predefined roles

In the SafeGuard Management Center, the following security officer roles, apart from the MSO,
are predefined. The assignment of rights to these predefined roles cannot be changed. For
example, if a predefined role has the right to “Create policy items and policy groups”, this right
cannot not be deleted from the role. Neither can a new right be added to a predefined role.
Additional officer authentication however, may be assigned to predefined roles at any point in
time.

Supervising Officer

Supervising Officers are able to see their own node in the Security Officer area and have the
right to manage security officers belonging to their node.

Security Officer

Security Officers dispose of extensive rights including SafeGuard Enterprise configuration,
policy and key management, permissions for monitoring and recovery.

Helpdesk Officer

Helpdesk Officers have the rights to perform recovery actions. Additionally they may display
most function areas of the SafeGuard Management Center.

Audit Officer

To be able to monitor SafeGuard Enterprise, Audit Officers may display most function areas
of the SafeGuard Management Center.

Recovery Officer

Recovery Officers have the rights to repair the SafeGuard Enterprise Database.
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Customized roles

As a security officer equipped with the necessary rights you can define new roles from a list of
actions/rights and assign them to an existing or new security officer. As with predefined roles, you
may enable the additional officer authentication for a function of the role at all times.

When assigning a new role, note the following regarding additional authentication:

Note: If a user has two roles with the same rights assigned and additional authentication is
assigned to one of the roles, this automatically applies to the other role.

A security officer equipped with the necessary rights may add or delete rights to or from a custom
role. Unlike predefined roles, custom roles can even be deleted, as required. If the roles is deleted,
itis no longer assigned to any user. If a user only has one role assigned and this role is deleted, the
user is not able to log on to the SafeGuard Management Center any more.

Note: The role and the actions defined within it determine what a user may and may not do. This
is also true if the user has been assigned more than one role. After the user has logged on to the
Management Center only those areas are activated and displayed that are needed to perform their
role. This also applies to the scripts and API areas. It is therefore important to always activate
displaying the area in which the respective actions are defined. Actions are sorted by function area
and are hierarchically structured. This structure shows which actions are required before certain
other actions can be performed.

Additional officer authentication

Additional officer authentication (also referred to as two persons rule) may be assigned to specific
actions of a role. This means that the user of this role is only permitted to perform a certain action
if a user of another role is present and confirms the performance of this action.

Additional authentication may be assigned to predefined or custom roles alike. As soon as there
are at least two officers with the same role, also the own role can be selected.

The role which is to perform the additional authorization must have been assigned to a user and
there need to be at least two security officers in the SafeGuard Enterprise Database. Once
additional authentication is required for an action, it is required no matter if the user owns
another role that does not require additional authentication for this action.

If an officer without the right to change the additional authentication creates a role, settings for
additional authentication of the new role will be pre-filled to match those set for the creating
officer.

Note: Two security officers must not use the same Windows account on the same PC. Otherwise
it is not possible to separate their access rights properly. Additional authentication may only be
useful when security officers must authenticate via cryptographic tokens/smartcards.
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Prerequisite: To create a new role, you need the right to display and create security officer roles.
To assign additional authentication you need the right to "Change additional authentication
settings".

Do the following:

1. Inthe SafeGuard Management Center select Security Officers.
2. Right-click Custom Roles and select New > New custom role.
3. In New custom role, enter a name and description for the role.

4. Assign the actions to this role: Check the boxes next to the required action in the Active
column. Actions are sorted by function area and are hierarchically structured. This structure
shows which actions are required before certain other actions can be performed.

5. If required, assign Additional officer authentication: Click the default setting None and
select the required role from the list. If an officer without the right to change the additional
authentication creates a role, then the additional authentication is prefilled depending on the
additional authentication set for the officer's roles. Additional authentication can be selected,
if set to more than one role of the officer.

6. Click OK.
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The new role is displayed in the navigation window under Custom Roles. When you click the
role, the permitted actions are displayed in the action area on the right.
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Assigning a role to a security officer
Prerequisite: To assign a role, you need the right to display and modify security officers.
Do the following:

1. Select the respective officer in the navigation window. Their properties are displayed in the
action area on the right.

2. Assign the required roles by checking the relevant boxes next to the available roles. Predefined
roles are displayed in bold.

3. Click the double-headed arrow symbol Refresh in the toolbar.

The role is now assigned to the security officer.

Displaying officer and role properties

Prerequisite: To get an overview of the security officer properties or the role assignment, you
need the right to display security officers and security officer roles.

Do the following:
1. In the SafeGuard Management Center, click Security Officers.
2. Inthe navigation area on the left, double-click the object you want get an overview of.

The information displayed in the action area on the right depends on the object selected.

Display MSO properties

The general and modification information of the MSO is diplayed.

Display security officers properties
The general and modification information for the security officer is displayed.

1. In Properties, select the Actions tab to display a summary of actions permitted and the roles
assigned to the security officer.
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Display security officers rights and roles

A summary of actions of all roles assigned to the security officer is displayed. The tree view
displays what actions are required before certain other actions can be performed. Additionally,
the assigned roles can be displayed.

1. In Actions, select an action to display all assigned roles that contain this action.

2. Double-click a role to close the Properties dialog and then display the role’s properties.

Display role properties
The general and modification information for the role are displayed.

1. In Properties, select the Assignment tab to display the security officers assigned to this role.

Display role assignment

1. In Assignment, double-click a security officer to close the Properties dialog and then display
the security officer’s general data and roles.

Modifying a role
You may do the following:
Modify additional authentication only.

Modify all properties of the role.

The icon next to the roles shows which action is available:

Icon Description

*"ﬂ The role can be modified (add/remove actions).
if Additional authentication can be changed.
E Both modifications are available.

Note: Predefined roles and the actions assigned to them cannot be modified. If additional
authentication is activated, it can be modified for any role, even for predefined roles.
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Modify additional authentication only

Prerequisite: To assign additional authentication you need the right to display security officer
roles and to "Change additional authentication settings".

Do the following

1. In the Management Center select Security Officers.

2. In the navigation window under Custom Roles, click the role you want to change. In the
action area on the right, click the required setting in the Additional officer authentication
column and select a different role from the list. Predefined roles are displayed in bold.

3. Click the Save icon in the Toolbar to save your changes to the database.

Additional officer authentication has been changed for this role.

Modify all properties of a role

Prerequisite: To change a custom role, you need the right to display and modify security officer
roles. To reassign additional authentication you also need the right to "Change additional
authentication settings".

Do the following:
1. In the Management Center select Security Officers.

2. Inthe navigation window under Custom Roles, right-click the role you want to change and
select Modify Security Officer Role.

3. Change the properties as required. Change additional authentication properties by clicking
the value in this column and selecting the required role.

4. Click the Save icon in the Toolbar to save your changes to the database.

The role has been modified.
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Copying a role

To create a new role that has similar properties as an existing role, you may use the existing role
as a template for the new role. You may select a predefined or custom role as template.

Prerequisite: Using existing roles as a template is only available if the currently authenticated
security officer has all the rights contained in the specific role template. So, this function may be
disabled for officers with a limited set of actions.

Do the following:

1. In the SafeGuard Management Center select Security Officers.

2. Inthe navigation window, right-click the role you want to copy and select New > New copy of
role. In New custom role, all properties of the existing role are already preselected.

3. Enter a new name for this role and change the properties as required.
4. Click the Save icon in the Toolbar to save your changes to the database.

The new role is created.

Deleting a role

Note: Predefined roles cannot be deleted.

Prerequisite: To delete a role, you need the right to display and delete security officer roles.
Do the following:

1. In the Management Center select Security Officers.

2. Inthe navigation window under Custom Roles, right-click the role you want to delete and
select Delete. Depending on the role’s properties a corresponding warning message will be
displayed.

Note: When you delete a role, all security officers this role is assigned to will lose it. If the role is
the only one assigned to a security officer, the security officer will no longer be able to log on to
the SafeGuard Management Center unless a superior security officer assigns a new role to the
security officer. If the role is used for additional authentication, the MSO will be requested to
perform additional authentication.

3. To delete the role, confirm the message with Yes.

4. Click the Save icon in the Toolbar to save your changes to the database.

The role is deleted from the navigation window as well as from the database.
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7.8 Creating a Master Security Officer

Prerequisite: To create a new Master Security Officer, you need the right to display and create
security officers.

Do the following:
1. Inthe SafeGuard Management Center select Security Officers.

2. In the navigation window, right-click the Master Security Officers node and select New >
New Security Officer.

3. Make the relevant entries in New master security officer:

Field/check box Description

Enabled The officer can be deactivated until further notice. This means that the
officer is in the system but they cannot log on to the SafeGuard
Management Center yet. They can only log on and perform their
administrative tasks when another officer activates them.

Name Enter the name of the officer as given in the certificates created by
SafeGuard Enterprise in cn =. The officer is also displayed under this name
in the Management Center navigation window. This name must be unique.

Maximum value:; 256 characters

Description Optional
Maximum value:; 256 characters

Cell phone Optional
Maximum value; 128 characters

E-mail Optional
Maximum value: 256 characters

Token logon The logon can be done in the following way:

No token The officer may not log on with a token. They have to log on
by inputting the logon information (user name/password).

Optional Logon can be either with a token or by inputting the logon
information. The security officer is free to choose.

Mandatory A token has to be used to log on. To do this, the private key
belonging to the security officer's certificate must be on the token.
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Field/check box Description

Certificate An officer always needs a certificate to log on to the Management Center.
The certificate can either be created by SafeGuard Enterprise or an existing
one can be used. If logging on with a token is essential, the certificate has to
be added to the officer's token.

Create:

The certificate and key file are created as new and saved in a selected
location. Enter and confirm a password for the .p12 key file. The .p12 file
must be available to the officer when logging on. The certificate created is
automatically assigned to the officer and displayed in Certificate. If
SafeGuard Enterprise password rules are used, rules in the Active Directory
should be deactivated.

Note:

Max. length of saving path and filename: 260 characters.

When creating a security officer, the certificate’s public part is sufficient.
When logging on to the Management Center, however, the certificate’s
private section, the key file, is required as well. If it is not available in the
database, it must be available to the security officer, e.g. on a memory stick,
and may be stored in the certificate store during logon.

Certificate Import:

An existing certificate is used which is assigned to the officer during
import. If the import is from a .p12 key file, the certificate's password must
be known.

If a PKCS#12 certificate container is selected, all certificates are loaded into

the list of assignable certificates. The certificate is then assigned after the
import, by selecting the certificate in the drop down list.

4. Click OK to confirm.

The newly created Master Security Officer is displayed in the navigation window under the
Master Security Officers node. Their properties can be displayed by selecting the respective
officer in the navigation window. The MSQO can log on to the SafeGuard Management Center with
the name displayed.
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7.9 Creating a security officer

Prerequisite: To create a security officer, you need the right to display and create security officers.

Do the following:

1. Inthe SafeGuard Management Center select Security Officers.

2. In the navigation window right-click the security officer’s node where you want to locate the
new security officer and select New > New Security Officer.

3. Make the relevant entries in the New security officer dialog:

Tl Mew security officer ]
Enabled: ]

Narne: ;5||

Description:

E-Mail:

|
Cell phone: |
|
|

Walidity:

Token logon: ® Mo token

7i27(2008 | to | 7i27(2108 v |

O optional O Mandatory

Certificate: ;5|

j Ereates . Irnpork. ..

Roles: (14 [] Supervising Officer
[[] Security Officer

[] Helpdesk Officer
[] Audit Officer

[] Recovery Officer
1 Palicy ifficer

[ test
[ testz

Ok Cancel |

Field/check box Description

Enabled

The officer can be deactivated until further notice. This means that the
officer is in the system but they cannot log on to the SafeGuard
Management Center yet. They can only log on and perform their
administrative tasks when another officer activates them.

Name

Enter the name of the officer as given in the certificates created by
SafeGuard Enterprise in cn =. The officer is also displayed under this name
in the Management Center navigation window. This name must be unique.
Maximum value: 256 characters

Description

Optional
Maximum value: 256 characters
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Field/check box Description

Cell phone Optional
Maximum value: 128 characters
E-mail Optional
Maximum value: 256 characters
Validity Select from when and to when (date) the officer should be able to log on to

the Management Center.

Token logon

The logon can be done in the following way:
No token The officer may not log on with a token. They have to log with
their credentials (user name/password).

Optional Logon can be either with a token or with the credentials. The
security officer is free to choose.

Mandatory A token has to be used to log on. To do this, the private key
belonging to the security officer's certificate must be on the token.

Certificate

An officer always needs a certificate to log on to the Management Center.
The certificate can either be created by SafeGuard Enterprise or an existing
one can be used. If logging on with a token is essential, the certificate has to
be added to the officer's token.

Create:

The certificate and key file are created as new and saved in a selected
location. Enter and confirm a password for the .p12 key file. The .p12 file
must be available to the officer when logging on. The certificate created is
automatically assigned to the officer and displayed in Certificate. If
SafeGuard Enterprise password rules are used, rules in the Active
Directory should be deactivated.

Note:

Max. length of saving path and filename: 260 characters.

When creating a security officer, the certificate’s public part is sufficient.
When logging on to the Management Center, however, the certificate’s
private section, the key file, is required as well. If it is not available in the
database, it must be available to the security officer, e.g. on a memory stick,
and may be stored in the certificate store during logon.

Certificate

Import:

An existing certificate is used which is assigned to the officer during
import. If the import is from a .p12 key file, the certificate's password must
be known.

If a PKCS#12 certificate container is selected, all certificates are loaded into
the list of assignable certificates. The certificate is then assigned after the
import, by selecting the certificate in the drop down list.
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Field/check box Description

Security Officer | Roles

Roles Predefined or custom roles can be assigned to the officer. The rights
associated with each role are displayed under Action Permitted in the
action area when clicking the respective role or when right-clicking the
officer and selecting Properties, Actions. More than one role can be
assigned to a user.

Predefined roles are displayed in bold.

Performing an additional authentication is expressly linked with owning a
particular role.

4. Click OK to confirm.

The newly created security officer is displayed in the navigation window under the respective
Security Officers node. Their properties can be displayed by selecting the respective officer in the
navigation window. The security officer can log on to the SafeGuard Management Center with
the name displayed. Next you need to assign directory objects/domains to the officer so they can
perform their tasks.

7.10 Assigning directory objects to a security officer

For the security officer to be able to perform their tasks they need to have access rights to directory
objects. Access can be granted to domain and workgroup nodes as well as to the ".Autoregistered”
node under the Root directory.

Prerequisite: To assign directory objects to an officer you need the Users and Computers rights
to "Display security officers access rights" and to "Grant/deny access rights to directory".

Do the following:

1. In the SafeGuard Management Center select Users and Computers.

2. Inthe navigation window on the left, select the required directory objects.
3. Inthe action area on the right, click the Access tab.

4. Toassign the rights for the selected objects, drag & drop the required officer from the far right
into the Access table. To unassign drag the security officer back to the Officers table.

5. Click the Save icon in the Toolbar to save the changes to the database.

The selected objects are available to the selected security officer.
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7.11 Promoting security officers

You may do the following:
promote a user to security officer in the Users and Computers area

promote a security officer to Master Security Officer in the Security Officers area

7.11.1 Prerequisites for promoting a user

A security officer equipped with the necessary rights can promote users to security officers and
assign roles to them.

Security officers created in this way can log on to the SafeGuard Management Center with their
Windows credentials or their token/ smartcard PIN. They can operate and be administrated just
like any other security officers.

The following prerequisites must be met:

Users to be promoted must have been imported from an Active Directory and need to be
visible in the SafeGuard Management Center Users & Computers area.

For a promoted user to log on to the SafeGuard Management Center as security officer a user
certificate must have been created or imported and assigned to them. For logging on with the
Windows credentials the .p12 file containing the private key must exist in the SafeGuard
Enterprise Database. For logging on with token or smartcard PIN, the .p12 file containing the
private key must reside on the token or smartcard.

7.11.2 Promote a user to security officer
Prerequisite: To promote a user, you need to be a Master Security Officer.
Do the following:
1. In the SafeGuard Management Center select Users & Computers.

2. Select the user you want to promote and click the Certificate tab in the action area on the
right.
If a certificate has been assigned to the user, it is displayed in the action area.

If a certificate has not yet been assigned to the user, assign it by clicking the Import
certificate icon in the Toolbar. Locate the necessary certificate store (*.cer) and private key
(*.p12) file and confirm with OK.

3. Right-click the user you want to promote to security officer and select Make this user an
Officer.
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4. Activate the requested roles in Select role(s) and confirm with OK.

Predefined roles are displayed in bold. If a child officer has more roles assigned than the
logged-in officer the additional roles are displayed in italics.

5. Click the Save icon in the Toolbar to save the changes to the database.

The user is now promoted and displayed in the Security Officers area with their user name. Their
properties can be displayed by selecting the respective officer in the navigation window. If the

user’s private key is stored in the database, No token is activated. If the user’s private key resides
on the token or smartcard, Optional is activated.

You may drag & drop the security officer to the required position in the Security Officers tree
view if required.

The security officer can log on to the SafeGuard Management Center with the name displayed.

i'kﬁaleliuan‘le Management Center - mso on Company [SGNSRY: SafeGuard)
Fl¥ Edit View GoTo Actions Taook Help

Security Officers A Administrator@UTIMACO

= Master Security Officers

Jgg e Y Enabled: [wl This user imparted From the AD was promoted bo Security Officer,
L8 oz Name: | administrator@UTIMACE

=t & security offi

Jg ecurity Uiicers Description; |ADS Cfficer Administrator@UTIMACD
Administrator@UTIMACC

ﬂg 50 Londan Cell phone: |

8 50 Paris £-Mail: |

ﬂ% Predefined Roles
B (3] Custom Roles Validity: | vrzzizone = |t | @esizioe v

Token logon: OMotoken @ optional O Mandatory

Certificate; ‘CN=tssr, DU=5afeGuard Enterprise Officer Certificate; CH=tesr, OU=5afeGuard Enterprise Officer Certificate; 42F067234B53091 7404FZFBCISE1T

Roles: [w] Supervising Officer
[] security Officer

[] Helpdesk Dfficer
[ Audit Officer

[] Recovery Officer
[ Palicy CFficer

[ test

[ testz

B Users and Computers

Policies

ﬂ@ Keys and Certificates

Bj Tokens
Bsemyoieers
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7.11.3 Promote a security officer to Master Security Officer

Prerequisite: To promote a security officer you need the right display and modify security
officers.

Do the following:

1. Inthe SafeGuard Management Center select Security Officers.

2. In the navigation window, right-click the security officer you want to promote and select
Promote to Master Security Officer.

3. If the promoted officer has children you are prompted to select a new parent node for the
children.

The security officer is promoted and displayed under the Master Security Officers node. As a
Master Security Officer the promoted officer will receive all rights to all objects and thus lose all
assigned roles and all individually granted domain access in Users and Computers.

7.12 Demoting Master Security Officers

Prerequisite: To demote Master Security Officers to security officers you need to be a Master
Security Officer.

Do the following:

1. In the SafeGuard Management Center select Security Officers.

2. In the navigation window, right-click the Master Security Officer you want to demote and
select Demote to Security Officer.

3. You are prompted to select a parent node for the officer and to assign at least one role.

The security officer is demoted and displayed under the selected Security Officers node. The
demoted officer will lose all rights to all objects and only receive those rights that are assigned to
their role(s). A demoted officer does not have any rights on domains. You need to individually
grant domain access rights in the Users and Computers area under the Access tab.
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7.13 Changing the security officer certificate

53

Prerequisite: To change the certificate of a security officer or Master Security Officer, you need
the right to display and modify security officers.

Do the following:
1. Inthe SafeGuard Management Center select Security Officers.

2. Inthe navigation window right-click the security officer you want to change the certificate for.
The current certificate assigned is displayed in the action area on the right under Certificates.

3. Inthe action area, click the Certificates drop-down list and select a different certificate.

4. Click the Save icon in the Toolbar to save the changes to the database.

7.14 Arranging security officers in the tree view

For your convenience, security officers may be hierarchically arranged in the Security Officers
navigation window to reflect the company’s organizational structure.

The tree view can be arranged for all security officers, except for Master Security Officers. MSOs
are displayed in a flat list under the MSO node. The security officers node contains a tree view
where each node represents a security officer. However, this does not imply any hierarchy in
terms of rights and roles.

Prerequisite: To move a security officer in the tree view you need the right to display and modify
security officers.

Do the following:
1. In the SafeGuard Management Center select Security Officers.

2. In the navigation window, drag & drop the officer you want to move to the respective node.

All children of the selected officer will also be moved.
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7.15 Fast switching of security officers

For your convenience, you may quickly restart the SafeGuard Management Center, to logon as a
different officer.

Do the following

1. Inthe SafeGuard Management Center select File > Change Security Officer. The SafeGuard
Management Center is restarted and the Logon dialog is displayed.

2. Select the security officer you want to log on with to the SafeGuard Management Center and
enter their password. If you are working in Multi Tenancy mode you will be logged on to the
same database configuration.

The SafeGuard Management Center is restarted displaying the view assigned to the logged on
officer.

7.16 Deleting a security officer

Prerequisite: To delete a security officer or Master Security Officer, you need the right to display
and delete security officers.

Do the following

1. In the SafeGuard Management Center select Security Officers.

2. Inthe navigation window, right-click the security officer or Master Security Officer you want
to delete and select Delete. Note that you cannot delete the officer you are logged on with.

3. If the officer has children you are prompted to select a new parent node for the children.
The officer is deleted from the database.

Note: One Master Security Officer explicitly created as an officer and not only promoted to
security officer must always remain in the database. If a user promoted to security officer is
deleted from the database, their user account is deleted from the database as well.

Note: If the officer to be deleted has been assigned a role that includes additional authentication
and the officer is the only one this role is assigned to, the officer will be deleted nonetheless. It is
assumed that the Master Security Officer will be able to take over additional authorization.
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8.1

8.1.1
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Data encryption

The core of SafeGuard Enterprise is the encryption of data on different data storage devices.
Encryption can be volume or file-based with different keys and algorithms.

Files are encrypted transparently. When users open, edit and save files, they are not prompted for
encryption or decryption.

As a security officer, you specify the settings for encryption in a security policy of the type Device
Protection.

Volume-based encryption

With volume-based encryption, all data on a volume (including boot files, pagefiles, hibernation
files, temporary files, directory information etc.) are encrypted. Users do not have to change
normal operating procedures or consider security.

Note: If an encryption policy exists for a volume or a volume type and encryption of the volume
fails, the user is not allowed to access it.

To apply volume-based encryption to endpoint computers, create a policy of the type Device
Protection and set the Media encryption mode toVolume-based.

Fast initial encryption

SafeGuard Enterprise offers fast initial encryption as a special mode for volume-based
encryption. It reduces the time needed for initial encryption (or final decryption) of volumes on
endpoint computers by accessing only disk space that is actually in use.

For fast initial encryption, the following prerequisites apply:

Fast initial encryption only works on NTFS-formatted volumes.

NTFS-formatted volumes with a cluster size of 64 KB cannot be encrypted with the fast initial
encryption mode.

Note: This mode leads to a less secure state if a disk has been used before its current usage with
SafeGuard Enterprise. Unused sectors may still contain data. Fast initial encryption is therefore
disabled by default.

To enable fast initial encryption, select the setting Fast initial encryption in a policy of the type
Device Protection.

Note: For volume decryption, the fast initial encryption mode will always be used, regardless of
the specified policy setting. For decryption, the prerequisites listed also apply.
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8.1.2

8.1.3

8.1.4

8.1.5

Volume-based encryption and Windows 7 system partition

For Windows 7 Professional, Enterprise and Ultimate, a system partition is created on endpoint
computers without a drive letter assigned. This system partition cannot be encrypted by
SafeGuard Enterprise.

Volume-based encryption and Unidentified File System Objects

Unidentified File System Objects are volumes that cannot be clearly identified as plain or device-
encrypted by SafeGuard Enterprise. If an encryption policy exists for an Unidentified File System
Object, access to this volume will be denied. If no encryption policy exists, the user can access the
volume.

Note: If an encryption policy with Key to be used for encryption set to an option that enables key
selection (for example, Any key in user key ring) exists for an Unidentified File System Object
volume, there is a period of time between the key selection dialog being displayed and access
being denied. During this time period the volume can be accessed. As long as the key selection
dialog is not confirmed, the volume is accessible. To avoid this, specify a preselected key for
encryption. This period of time also occurs for Unidentified File System Object volumes
connected to an endpoint computer, if the user has already opened files on the volume when an
encryption policy takes effect. In this case, it cannot be guaranteed that access to the volume will
be denied as this could lead to data loss.

Encryption of volumes with enabled Autorun functionality

If you apply an encryption policy to volumes for which Autorun is enabled, the following can
occur:

The volume is not encrypted.

If the volume is an Udentified File System Object (see VVolume-based encryption and
Unidentified File System Objects, page 56), access is not denied.

Access to BitLocker To Go encrypted volumes

If SafeGuard Enterprise is used with BitLocker To Go support enabled and a SafeGuard
Enterprise encryption policy exists for a BitLocker To Go encrypted volume, access to the volume
will be denied. If no SafeGuard Enterprise encryption policy exists, the user can access the
volume.

Note: If the Autorun settings for a BitLocker To Go encrypted USB stick are set to the default
values, it can occur that access will not be denied although a SafeGuard Enterprise encryption
policy exists. This only occurs under Windows Vista.
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8.2

8.2.1
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File-based encryption

File-based encryption ensures that all data is encrypted, apart from Boot Medium and directory
information. With file-based encryption, even optical media such as CD/DVD can be encrypted.
Also, data can be exchanged with external computers on which SafeGuard Enterprise is not
installed, if policies permit.

Note: Data encrypted using “file-based encryption” cannot be compressed. Nor can compressed
data be file-based encrypted.

Note: Boot volumes are never file-based encrypted. They are automatically exempted from file-
based encryption, even if a corresponding rule is defined.

To apply file-based encryption to endpoint computers, create a policy of the type Device
Protection and set the Media encryption mode to File-based.

Excluding applications from encryption

You can define applications to be ignored by the SafeGuard Enterprise filter driver and thereby
excluded from transparent encryption/decryption.

One example is a backup program. To ensure that data is not decrypted when creating a backup,
this application can be exempted from encryption/decryption. The data is backed up in encrypted
form.

A typical use case is for example to define backup programs as exempted so they will always be
able to read and back up encrypted data.

Applications which might trigger malfunctions when used alongside SafeGuard Enterprise, but
do not require encryption, can generally be exempted from encryption.

You can define applications to be excluded from encryption/decryption in a policy of the type
Device Protection with the target Local Storage Devices. The full name of the executable file
(optionally including path information) is used to specify Unhandled Applications.
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SafeGuard Enterprise Key Management

When importing the directory structure, the standard version of SafeGuard Enterprise
automatically generates keys for:

Domains
Containers/OUs
Groups

and assigns them to the corresponding objects. Computer and user keys are generated as
required.

Keys cannot be deleted! They are retained permanently in the SafeGuard Enterprise database.

The first time a endpoint computer is booted, SafeGuard Enterprise generates a computer key for
that computer (defined machine key).

Each user obtains all their keys at logon from their user key ring. The user key ring comprises the
following:

A personal key
the keys of the groups of which the user is a member
the keys of the overall Container/OUs of the groups of which the user is a member.

The keys in the user key ring determine the data which that user can access. The user can access
only that data for which they have a specific key.

To display all keys for a user, click Users & Computers and select the Keys tab.

To display all keys, click Keys & Certificates in the SafeGuard Management Center. You can
generate lists for Assigned Keys and Inactive Keys.
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1. Click Users & Computers to open the display

2. The keys of all ticked objects are displayed in the action area and in the respective views.

3. Action area: Display depends on the selections in the navigation area. All keys assigned to the
object are displayed.

4. All available keys are displayed here. Keys already assigned to the selected object are grayed
out. Select Filter to switch between keys already assigned to an object (active) and keys not yet
assigned to an object (inactive),

After the import, each user receives a number of keys which can be used for data encryption.
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9.1 Keys for data encryption

Users are assigned keys for the encryption of specific volumes when defining policies of the type

Device Protection. VVolumes are as follows:

! Device Protection

Marne:

2%

|Device Protection

Description:

Device pratection targek

=9 Local Storage Devices

;Hﬂ Local Skorage Devices
:_Hﬂ Mass starage
ﬂ Boot VYolumes
H 28 Other Yolumes
ﬂ Removable Media
ﬂ Ciptical Drives
;Hﬂ Dirive Letkers

LN
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When you carry out the settings for each media you are offered the option: Keys to be used for
encryption.

1/ SaleGiuard® Management Cente,- M50 on utimaco (SGNSRY: SafeGuard) - [0l %]
File  Edt “iew GoTo Actions Took Help ‘

@Wo % % @OE

B Device Protection

_—j- Policy Ttems
(3] Authentication

g General Sef
Logging
Passphrase
% Password
Erm

#- Questions

Device Protection |

Target:

- Local Storage Devices| Mass storage!, Boot Yalume

|Loca| Shorage Devices) Mass storage! Boot Yolumes

Media encryption mode
| General Settings
Algorithm ta be used for encryption

User may add or remave keys to o From encrypted volume
Reaction ko unencrypted volumes

Valume based

AES256

g% Fal Key to be used For encrypti Any key in user key ring, except user key El
_—j@ Policy Groups Defined key For encryption Any key in user key rin
@ Pal-Group CPU minimum value (%)
~{E] Images CPU maximun valug (%) Any group key in user key ring
Information bext User is allowed to create alocal key Defined machine key
White Lists -/ Yolume Based Settings Any key in key ring, except locally created keys

Defined key on list
ot configured

User may decrypt volume Ha
Proceed on bad sectors Ves
-| File Based Settings
Initial encryption of &ll fles Ves
User may cancel initial encryption Ho
User i allowed to access unencrypted fles es
User may decrypt files Mo
User may define a Media Passphrase For devices Mo
R Users and Computers Unhandled Applications nat configured
Copy 5G Portable ko Removable Media Yes

Default inital encryption key

nat configured
not configurad

& Keys and Certificates Plaintext Folder

Bj Tokens

3 Security Officers

|iri
Defines which key is used For encryption,

- You can define specific keys (e.q. machine key or a defined key) or you can allow the user to select a key,
Reports You can alsa restrick the keys which a user is alowed to use,

L [ i)

Here you decide which keys a user can or must use for encryption:

Any key in user key ring

After logging on to Windows users can select which keys they would like to use to encrypt a
particular volume.

A dialog is displayed in which the user can select the required key.

Any key in user key ring except user key
A user may not use their own personal key to encrypt data.

Any group key in user key ring
The user may only select one of the group keys in their user key ring.

Defined computer key

is the unique key generated exclusively for this computer by SafeGuard Enterprise the first
time this machine is booted up. The user has no other options.

A defined computer key is typically used for the boot and system partition and for drives on
which Documents and Settings are located.
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1! Find Keys X

Defined key on list

This option allows you to define a specific key which the user must use for encryption. To
specify a key for a user in this way you need to define a key under Defined key for encryption
(is displayed once you select Defined key on list).

Click the [...] button next to the option Defined key for encryption to display a dialog in
which you can specify a key.

Ensure that the user is also in possession of the corresponding key when specifying keys in
this way.

Search here for key names or key IDs.

Find: | Kews j

Search Mame: |Group Enter a search term.

[wl Clear results after each search

Key Mame |L|

é@ Group_Incoming Forest Trust Builders

é@ Group_Metwork Configuration Operataors

f;@ Group_Performance Log Users

é@ Group_Performance Monitar Users

2@ Group_Pre-wWindows 2000 Compatible Access
é@ Group_Prink Opetators

S5 Group_RAS and 145 Servers All matching keys are displayed here.
é@ Group_Remote Desklop Users

é@ Group_Replicatar

f;@ Group_Schema Admins

é@ Group_Server Operators

2@ Group_Terminal Server License Servers

é@ Group_Users

Group_\Windows Authorization Access Group

37 item(s) found |+

Clear All [0]4 | Cancel |

H

ighlight the selected key and click OK.

The selected key will be used for encryption on the endpoint computer.

9.2 C

ertificates

SafeGuard Enterprise can be verified with signed SHAL, MD2 and MD5 certificates.

If Certification Authority (CA) certificates are deleted in the database and you do not wish to
use them again, you should remove these certificates manually from all Administrator PCs in
the local store.

SafeGuard Enterprise can then only communicate with expired certificates if old and new keys
are present on the same card.
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9.3

The combination of CA certificates and CRL (Certificate Revocation List) on a smartcard
must match. Otherwise users cannot log on to the respective computers. Please check that the
combination is correct. SafeGuard Enterprise does not carry out this check!

The logon certificates for security officers must be located in “MY”.

CA certificates cannot be obtained from a token and stored in the database or certificate store.
If you wish (or need) to use CA certificates, these need to be available in file form and not just
on a token. The same applies for CRLs.

Note that, when importing a user certificate, the certificate's public and private sections are
both imported. If only the public part is imported, only authentication with a token is
supported.

Virtual Clients

Virtual Clients are specific encrypted key files that can be used for recovery in a Challenge/
Response procedure when the required user information is not available and usually, Challenge/
Response would not be supported, for example when the POA is corrupted.

To enable a Challenge/Response procedure in this complex disaster situation, specific files called
Virtual Clients can be created and must be distributed to the user prior to the Challenge/Response
session. Challenge/Response can then be initiated with the help of these Virtual Clients via a key
recovery tool on the endpoint computer. The user then only needs to inform the helpdesk officer
of the required key or keys and enter the response code in order to regain access to the encrypted
volumes.

Recovery is either possible with the help of a single key or by using an encrypted key file
containing several keys.

In the SafeGuard Management Center Keys & Certificates area you have the following
possibilities:

Create and export Virtual Clients
Create and export encrypted key files containing several keys
Display and filter Virtual Clients and exported key files

Delete Virtual Clients
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9.3.1 Creating Virtual Clients

Virtual Client files can be used by different computers and for several Challenge/Response
sessions.

1. Open the SafeGuard Management Center and click Keys & Certificates.

2. Click Virtual Clients in the left-hand navigation window.

1’ safeGuard® Management Center (M50 on SGNSRY:SafeGuard)

File Edit Wiew GoTo Actions Tools Help

Keys & Certificates 3 Virtual Clientks

+5 Keys ~Filker
#HE] Certificates
;}@ Clients |Symbolic name: j | j Z
@ Exported Key Files
| Mame

T New Yirtual Client x|

Mame:

|virtual Client 2

OF Cancel

3. In the toolbar click Add Virtual Client.

4. Enter a unique name for the Virtual Client and click OK. The Virtual Clients are identified in
the database by these names.

5. Save the Virtual Client to the database by clicking the Save icon in the toolbar.

The new Virtual Client is displayed in the action area.
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9.3.2 Exporting Virtual Clients

65

After creating the Virtual Client you need to export it to a file. This file is always called

recoverytoken . tok and needs to be distributed to the help desk. This file must be available to

in the endpoint computer environment when starting a Challenge/Response session via a

recovery tool, for example when the POA is corrupted. The user must place the Virtual Client file
recoverytoken.tok in the same folder as the recovery tool so that a Challenge/Response may

be supported.
1. Open the SafeGuard Management Center and click Keys & Certificates.

2. Click Virtual Clients in the left-hand navigation window.

1’ safeGuard® Management Center (M50 on SGNSR¥:SafeGuard)

Fle Edit “iew GoTa Actions Tools Help

Filter

+
j@ |t5 ’V‘Symbahc name: j | j d
@ Exported Key Files
Mame M| Cres
B | Wirtual Client 1 E
| virtual Client 2 MsC
N x

Fallowing Files were successfully exported:
WBackendel\WserMgmiiHelpdeskiRecovenrecoverytoken tok

3. Inthe action area search for the respective Virtual Client by clicking the magnifier icon. The

available Virtual Clients are displayed.
4. Select the required entry in the action area and click Export Virtual Client in the toolbar.
5. Select a location to store the file recoverytoken. tok and click OK.
6. A message is displayed stating the successful storage and the location of the file.

7. Distribute this Virtual Client file recoverytoken. tok to the respective SafeGuard
Enterprise users.

Store this file in a save place, e.g. on a memory stick. In case of a Challenge/Response this file
needs to be located in the same folder as the recovery tool.
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9.3.3 Creating and exporting key files for Virtual Client recovery

When multiple keys are needed to recover access to encrypted volumes during a Virtual Client
recovery, the security officer can combine them in one exported file. This key file is encrypted

with a random password which is stored in the database. The password is unique for each created
key file.

The encrypted key file needs to be transferred to the user and must be available to the user when
starting a Challenge/Response session via a recovery tool.

In the Challenge/Response session the password for the key file is transmitted with the response

code. The key file can then be decrypted with the password and all volumes encrypted with the
available keys can be accessed again.

1. Open the SafeGuard Management Center and click Keys & Certificates.

2. Click Virtual Clients and then Exported Key Files in the left-hand navigation window.

' safeGuard@ Managen‘knt Center {MS0 on SGNSRY:SafeGuard)
File Edit Wew GoTo Actions Tools  Help

Keys & Certificates
R Keys ~Filter
+HE] Certificates
'J- X § Key File name: | ﬂ
j@ Virtual Clients s

@ Exported Key Files

Exported ke files Comments
¥ |[=] 0x2F01C3016BCESA4EEAD1 IFB7F4A619E
1! Export keys to a key file x|
Direckary: | VWBackendserManagemertiHelpdeskiRecover J
N Eile name: |Ux8B90C8F26D?C9?4490A4CFCCB?IBES»QQ

Comments: |

Keys

Ox02C44C7367EAY243B453FEDAFIEA5T 15

0x0DEDEODFC?ODED4EI0CZ31 8080491095

3. Inthe toolbar click New export key file.

4. In Export keys to a key file enter the following:
Directory: Click [...] to select a location for the key file.

File name: The key file is encrypted with a random password which is displayed here, in
File name. You cannot change this name.

Click Add key or Remove key to add or remove keys. A popup window is displayed to
search for and select the required keys. Confirm the selection with OK.

Click OK to confirm all entries.
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9.3.4

9.3.5
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5. Distribute this key file to the respective endpoint computer environment. It must be available
to them prior to entering the response code on the client side.

Displaying and filtering Virtual Client views

To find the requested Virtual Client or keys more easily during a Challenge/Response there are
several filter and search possibilities in the SafeGuard Management Center under Keys &
Certificates.

Views for Virtual Clients

1. Click Virtual Clients in the left-hand navigation window.

2. Click the magnifier icon to generate a complete list of all Virtual Clients.

3. Filter the Virtual Clients by Symbolic name or Key GUID.

Views for exported key files

1. Click Virtual Clients, then Exported Key Files.

2. Click the magnifier icon to generate a complete list of all exported key files.

3. Click the + icon next to the required key file to display the keys contained in the file.

Deleting Virtual Clients

To delete a Virtual Client proceed as follows:

1. Open the SafeGuard Management Center and click Keys & Certificates.
2. Click Virtual Clients in the left-hand navigation window.

3. Inthe action area search for the respective Virtual Client by clicking the magnifier icon. The
available Virtual Clients are displayed.

4. Select the required entry in the action area and click Delete Virtual Client in the toolbar.

5. Save the changes to the database by clicking the Save icon in the toolbar.

The Virtual Client is deleted from the database.
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10 Working with policies

The following sections explain the administrative tasks concerning policies, for example creating,
grouping and backing up policies.

All policy settings available with SafeGuard Enterprise are described in Security Policies.

10.1 Creating policies

To create a new policy, do the following:

1. Logon to the SafeGuard Management Center with the password set during initial
configuration.

2. Click Policies in the navigation area.
3. In the navigation window, right-click Policy Items and select New.
4. Select the policy type. A dialog for naming the policy of the selected policy type is displayed.

5. Enter a name and optionally a description for the new policy.
Policies for Device Protection:

When creating a policy for device protection, you also have to specify the target for device
protection in this dialog. Possible targets are:

Mass storage (boot volumes/other volumes)
Removable media

Optical drives

For each target, a separate policy has to be created. Later on you can combine the individual
policies in a policy group named Encryption, for example.

6. Click OK.

The new policy is displayed in the navigation window below Policy Items. In the action area, all
settings for the selected policy type are displayed.

68



SafeGuard® Enterprise 5.50, Administrator help

10.2 Editing policy settings

When selecting a policy in the navigation window, you can edit the policy settings in the action
area.

Aredicon in front of a,,not configured* setting indicates that for this policy setting a
@ not configured value has to be defined. To be able to save the policy, you first have to select a setting
other than ,,not configured”.

10.2.1 Setting policy settings to default values

In the toolbar the following icons are available for setting policy settings:

Displays default values for not configured policy settings.
[
Sets marked policy setting to “not configured”.
<$>.'
Sets all policy settings in an area to “not configured”.
%
Sets the default value for the marked policy
Q&Cf'
Sets all policy settings in an area to the default value.
%

10.2.2 Differentiating between machine- and user-specific policies

Policy color blue Policy is applied to machines only, not users.

Policy color black Policy is applied to machines and users

10.3 Policy groups

SafeGuard Enterprise policies need to be combined in policy groups. A policy group may contain
different policy types.

If you sum up policies of the same type in a group, the settings will be merged automatically. In
this case, you can define priorities for utilizing the settings. The settings of a policy with a higher
priority overwrite the settings of a policy with a lower priority. If an option is set to not
configured, the setting will not be overwritten in a policy of a lower priority.
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Exception concerning device protection:

Policies for device protection will only be merged, if they were defined for the same target (e.g.
boot volume). If they point at different targets, the settings will be added.

10.3.1 Combining policies into groups

The individual policies of different types must have been created beforehand.

To group policies, do the following:

1.

2.

9.

Click Policies in the navigation area.
in the navigation window, right-click Policy Groups and select New.
Click New Policy Group. A dialog for naming the policy group is displayed.

Enter a name and optionally a description for the policy group. Click OK.

. The new policy group is displayed in the navigation window below Policy Groups.

Select the policy group. The action area shows all elements required for grouping the policies.
To add the policies to the group, drag them from the list of available policies to the policy area.
You can define a priority for each policy by arranging the policies in order using the context

menu.

If you sum up policies of the same type in a group, the settings will be merged automatically.
In this case, you can define priorities for utilizing the settings. The settings of a policy with a
higher priority overwrite the settings of a policy with a lower priority. If an option is set to not
configured, the setting will not be overwritten in a policy of a lower priority.

Exception concerning device protection:
Policies for device protection will only be merged, if they were defined for the same target (e.g.
boot volume). If they are pointed at different targets, the settings will be added.

Save the policy via File > Save.

The policy group now contains the settings of all individual policies.
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10.3.2 Policy grouping results
The result of policy grouping is displayed separately.
To display the result, click the Resulting tab.

For each policy type a separate tab is shown.

The settings resulting from combining the individual policies into a group are displayed.
For policies for device protection, a tab for each policy target (e.g. boot volumes, drive X etc.)
is shown.

10.4 Backing up policies and policy groups

You can create backups of policies and policy groups as XML files. If necessary, the relevant
policies/policy groups can then be restored from these XML files.

To create a backup of a policy/policy group:
1. Select the policy/policy group in the navigation window under Policy Items or Policy Groups.

2. Right-click to display the context menu and select Backup Policy.

The Backup Policy command is also available in the Actions menu.

3. Inthe Save As dialog enter afile name for the XML file and select the a storage location for the
file. Click Save.

The backup of the policy/policy group is stored as an XML file in the specified directory.

10.5 Restoring policies and policy groups
To restore a policy/policy group from an XML file, do the following:
1. Select Policy Items/Policy Groups in the navigation window.

2. Right-click to display the context menu and select Restore Policy.

The Restore Policy command is also available in the Actions menu.
3. Select the XML file from which the policy/policy group is to be restored and click Open.

The policy/policy group is restored.
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10.6 Assigning policies

To assign policies, proceed as follows:

1. Click Users & Computers. Select the container object (e.g. OU or domain) in the navigation
window. Click the Policies tab if necessary.

All items required for policy assignment are displayed in the action area.

# SafeGuard® Management Center (M50 on SGNSRY:SafeGuard) =(0] x|
Eile Edit Wiew GoTo Actions Tools  Help |
|& @ | e I ® wve | | G

ers & Co = ers,D aco,D e

;}E Root [Filter is active]
@ JAuthenticated Computers
4@ Authenticated Users
@ JAuto registered

ZHER UTIMACO.EDU
{2 .Auka registered

Key Policies |1nventorv | Licenses |

FEEY e A ez £ Modification Date Avallable Palicies L]

-{5] Authentication: OU_EN

&8, Board Group - Configuration Pratection
,% EoardMembers -4 Device Protection

Q{j Buitin Bl General Settings: Global
: - gg General Settings: OL_EN
ﬂ% Camputers B il

gk Desktops . . . .

1#H) Domain Controfrs Assigning policy via drag&drop By Pesspivass

{7 FareignecurifyPrincipals oy Password

#H@] Headguart e PIN

= E Specific Machine Settings
=@ Policy Graups
@) General Settings

Displays all policies assigned to the container objectyf g e
Displays all existing

&5, Laptops
NewEmo

policies.
- Activation
Distinguished Mame Distinguished Mame ‘ Modification Date ‘ Available Groups o
7@ JAuthenticated Users Authenticated User 4/28/2008 3:07:25 AM BCeY Roat [Filker is active]
L@ .Authenticated Computers Authenticated Computers 42; Al Authenticated Computers
i JAuthenticated Users
po— ] uTmaco.EDU

&7 Keys & Certificates

B:l Tokens

3 Security Officers

Reports

(L]

2. Toassign a policy, drag the policy from the list and drop it into the policy area.

3. You can define a Priority for each policy by arranging the policies in order using the context
menu. The settings of higher-ranked policies override those below.
If you select No Override for a policy, its settings will not be overridden by those from other
policies.

Note: If you select No Override for a low-priority policy, this policy will take higher priority than
a higher-ranking policy.
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1 safeGuard® Management Center (MSO on SGNSRY:SafeGuard) =]
File Edit Yiew GoTo Actions Tools Help

J@B'lq | |Q ) =l & & wmnve G0 T
Users & Computers ﬂ B CN=Users,DC=Utimaco,DC=edu

;}Q Ruoot [Filker is active]

i-{[F Authenticated Computers
JAuthenticated Users

Key  Policies |[nventory | Licenses |

Mo Override

; JAuko registered
=HE uTMACo EDU

[}] JAuto registered
Board Group

Available Policies a|
=H&A Policy Tems

& a2 {07225 AM
@ Authentication: OU_EN 3 4f28{2008 3:07:25 AM

E’ Configuration Protection

- ool

: ‘ﬁ Device Pratection
+% :DTtr.dMsmhers g% General Settings: Global
j{:‘ C‘jm“p_luters g% General Settings: OU_EN
% Desktops Legang
: Domain Controllers Passphr:se
[:] ForeignSecurityPringpals . . . & Passwir
Hearlouarter You can set the priority (using the context menu) e PN
. E E Specific Machine Settings
-8 Laptops and you can define whether the policy may L@ ol crous
e be overridden by other settings. EL ) General settings
g oUEN

Already applied policie
are grayed out.

[72)

[~ Activation
Distinguished MName Distinguished Name |MD\j\ﬁEatiUl‘l Date | Available Groups I
_@ JAuthenticated Users Authenticated User 4/28/2008 3:07:25 &M IERCAA Fioot [Filker is active]
AAAAAAAAA Q@] .~uthenticated Computers Authenticated Computers 412 Al

5 A

JAuthenticated Computers
JAuthenticated Users

12 polices Authenticated Users and .Authenticated Computers indicatp tHgt™ ="

&7 Keys & Centiicates the policy applies to all users and computers in the containe

3 Tokens object.

3 Security Officers

Reports

»

4. The .Authenticated users and .Authenticated computers are displayed in the activation area.

The policy now applies to all groups within the OU and/or domain.

10.6.1 Activating policies for individual groups
Policies are always assigned to an OU, a domain or a workgroup. They apply by default to all
groups in those container objects (.Authenticated users and .Authenticated computers groups are
displayed in the activation area).

However, you can also define policies and activate them for one or more groups. These policies
then apply exclusively to these groups.

To define a policy which is to apply only to a specific group, proceed as follows:

1. Assign the policy to the OU the group is contained in.

2. .Authenticated Users and .Authenticated Computers are displayed in the activation area.
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3. Drag these two groups from the activation area to the list of available groups. In this
constellation, the policy is not effective either for users or computers.

4. Now drag the required group (or multiple groups) from the list of available groups into the
activation area.

No Crverride Available Policies 1

1

¢ b Authentication: OU_EN

H @ Configuration Protection
@ Dervice Protection

B General Settings: Global

Hg General Settings: OU_EM
Logging

: Passphrase j

Activation

Distinguished Mame

Distinguished Mame Modification Date [&wailable Groups n

CN=DnsAdmins, C=Users, DC=Utimaca,D. . :29:25 AM ;}Q Rt [Fiker is active] -
@ Authenticated Computers

Authenticated Users and Authenticated Computers are B et o

rem Oved =HIE UTIMACO EDU

8 Board Group

8 BoardMembers

#H 7] Buikin

D Camputers

8 Deskkops

~{&] Damain Contrallers

g

D ForeignSecurityPrincipals
+H{F] Headquarter

8 Laptops

8 NewEmplayees

Drag group into activation area to activate policy for this S sers
group. B ceruiers

8 DnsUpdateProxy
LD Peenain Aemine

This policy now applies exclusively to this group.

If policies have also been assigned to the higher-ranking OU, this policy applies to this group in
addition to those defined for the whole OU.

10.7 Disabling policy deployment

Security officers can diable the deployment of policies to the endpoint computers by using the
button Enable/disable policy deployment in the SafeGuard Management Center toolbar or by
selecting the command Enable/disable policy deployment from the Edit menu. When clicking
the button, selecting the command or pressing F3, no policies will be sent to the endpoint
computers. By clicking the button, selecting the command or pressing F3 again, you can reverse
the disabling of policy deployment and policies will be sent again.

Note: For disabling policy deployment, a security officer needs the right “Enable/disable policy
deployment”. This right has been assigned by default to the predefined roles Master Security
Officer and Security Officer. However, this right can also be assigned to new user-defined roles.
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10.8 Rules for assigning and analyzing policies

The management and analysis of policies is carried out according to the rules outlined in this
chapter.

10.8.1 Assigning and activating policies

To enable a policy to be implemented for a user/computer, you need to assign it to a container
object (root nodes, domain, OU, Builtln container or workgroup). For the policy assigned to the
user/computer to become effective, when you assign a policy anywhere in the hierarchy, all
computers (authenticated computers) and all users (authenticated users) are activated
automatically (assignment without activation is not enough). All users and all computers are
combined into these groups.

10.8.2 Policy inheritance

Policies can only be passed between container objects. Only container objects can pass on policies
from higher-ranking container objects. Policies can be activated within a container provided it
contains no further container objects (at group level). There can be no inheritance between
groups.

10.8.3 Policy inheritance hierarchy

Where policies are assigned along a hierarchy chain, the policy implemented is the highest
ranking; closest in the case of a target object (user/computer). This means that as the distance to
the target object increases a policy will be superseded by policies which are closer.

10.8.4 Direct and indirect assignment of policies
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Direct assignment

The user/computer obtains a policy which is assigned directly to the container object in which it
is located (membership alone is not sufficient). The container object has not passed on this policy!

Indirect assignment

The user/computer obtains a policy which the container object in which it is actually located
(membership as a user of a group located in another container object is not sufficient) has
inherited from a higher-ranking container object.
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10.8.5 Activating/deactivating policies

For a policy to be effective for a computer/user, it has to be activated at group level (policies can
only be activated at group levels). It makes no difference if this group is in the same container
object or not. All that matters here is that the user or computer has been directly or indirectly
(through inheritance) assigned to the policy.

Ifacomputer or user is outside an OU or inheritance line and isa member of a group which is inside
this OU, this activation does not apply to this user or computer. Because there is no valid
assignment for this user or computer (directly or indirectly). The group was, indeed, activated but
an activation can only apply to users and machines for which there is also a policy assignment. .e.
the activation of policies cannot go beyond container boundaries if there is no direct or indirect
policy assignment for that object.

A policy becomes effective when it has been activated for user groups or computer groups. The
user groups and then the computer groups are analyzed (authenticated users and authenticated
computers are also groups). Both results are OR-linked. If this OR-link gives a positive value for
the computer/user relationship, the policy applies.

Note: If more than one policy is active for an object the individual policies are, while complying
with the rules described, merged. I.e. the actual settings for an object can be composed of multiple
different policies.

A group can have the following activation settings:

Activated
A policy has been assigned. The group is displayed in the activation area of the SafeGuard
Management Center.

Not activated
A policy has been assigned. The group is not in the activation area.

If a policy is assigned to a container, the activation setting for a group (activated) determines
whether that policy for that container feeds into the calculation of the resulting policy.

Inherited policies cannot be controlled by these activations. “Block policy inheritance” would
have to be set at the more local OU so the more global policy cannot be effective here.
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Examplel:

EHER uTIMAco . com
_lJ Auth-User

ALTH
_—J AUTHCHRYPTOTOKEN
3 Giinther

& Emil

1] AUTHNONCRYPTO TOKEN
% Auth-User-Group
Computerl

=H&) AUTHMANLELL <~ P1 active for all

Gunther and Emil are members of
Auth-User-Group

There is a valid assignment of policy P1 for the OU AUTHMANUELL and an
activation for the group Auth-User-Group. Emil and Gunther are members of the
Auth-User-Group group. Although user Gunther is also a member of the Auth-
User-Group group, policy P1 does not apply to him but only to user Emil. As there
is no valid assignment of policy P1 for user Gunther (user Gunther does not belong
to the OU AUTHMANUELL) the activation of the Auth-User-Group group has

no effect for him.

Example 2

=HLEN uTIMAcCo,Com

_lj Auth-User Ke
L2 auTH

:_} AUTHCHRYPTOTOKER
3 aGlinther

_-'+_} AUTHMANUELL

41 (] AUTHNONCRYPTOTOKEN
- Computerl

% fanuelle Gruppe

+H ] Buitin

_-3—_]- Certliser (DO MOT DELETE)
:J-D Computers

_{-J- Derveloprent

_1_-_} Comain Contrallers

:_|- FBE-User

-Christian

here

8 Chriskian

-8 Doris
S FBE-User
D ForeignZecuritvPrincipals

drmy Global_group

P1 was assigned

Structure of the ADs as on the right

Policy P1 is assigned to the OU Auth-User
and is effective only for the OU Auth-User
and its sub-OUs

For Authenticated Users and for
Authenticated Computer, Policy P1is
NOT activated

Policy P1 is only activated for the global group
Global_Group (only user Gunther isa
member of this group. The Global_Group
itself is directly beneath the domain node.)

Policy P1 is effective for user Gunther because
he has received (indirectly) a valid assignment
of the policy from the OU Auth-User. This
example illustrates that the activation of a
policy can be done anywhere in the Active
Directory. All that matters here is that there is
a valid assignment.
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10.8.6 User/group settings

Policy settings for users (settings shown in black in the SafeGuard Management Center) take
priority over policy settings for computers (settings shown in blue in the SafeGuard Management
Center). If user settings are done in a policy for computers, those settings will be overridden by
the policy for the user.

Note: Only the user settings will be overridden. If a policy for users also includes machine settings
(settings shown in blue), these will not be overridden by a user policy!

Example 1:

If password length 4 has been defined for acomputer group, the user group is assigned value 3 for
the same setting and this user is subject to password length 3 on a computer in the computer
group.

Example 2:

If a server interval of 1 minute is defined for a user group, and the value 3 for a machine group,
value 3 is used because value 1 minute is a machine setting which was defined in a policy for users.

10.8.7 Contradictory encryption policies

Two policies - P1 and P2 - are created. File based encryption for Drive E:\ was defined for P1, and
volume based encryption for Drive E:\ was defined for P2. P1 is assigned the OU FBE-User and
P2 the OU VBE-User.

Case 1: A user from OU FBE-User logs on first to the Client XP-100 (container computer). Drive
E:\isfile based encrypted. If a user from the OU VBE-User then logs on to Client XP-100, Drive
E:\ will be volume based encrypted. If both users have the same key, both can access the drives or
files.

Case 2: A user from OU VBE-User logs on first to the computer XP-100 (container computer).
The drive is volume based encrypted. If, now, a user from OU FBE-User logs on and has the same
key as users from OU VBE-User, Drive E:\ (the volume based encryption is kept) will be file based
encrypted within the volume based encryption. However, if the user from OU FBE-User does not
have the same key, they cannot access Drive E:\.
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10.8.8 Priority within an assignment

The policy with the highest priority (1) ranks above a policy with a lesser priority within an
assignment.

Note: If a policy with a lesser priority but which has been designated “No override” is assigned to
the same level as a higher ranking policy, this policy will take priority despite its lower ranking.

10.8.9 Priority within a group

The policy with the highest priority (1) ranks above a policy with a lesser priority within a group.

10.8.10 Status indicators
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Setting status indicators allows the standard rules for policies to be changed.

Block policy inheritance

Set for containers for which you do not wish higher-ranking policies to apply (right-hand
mouse click the object in the Properties navigation window).

No Override

Set during assignment process this policy cannot be overridden by another policy.

Block Policy Inheritance

If you do not want a container object to inherit a policy from a higher object, select “Block Policy
Inheritance” to prevent this. If “Block Policy Inheritance” has been selected for a container object
it will not be affected by higher-ranking policy settings (exception: “No Override” activated when
policy was assigned).

No Override

The further away the policy assignment with “No Override” is from the target object, the stronger
the effect of this policy for all the lower-ranking container objects will be. This means that a higher
ranking container subject to “No Override” overrides the policy settings of a lower ranking
container. So, e.g., a domain policy can be defined whose settings cannot be overridden, even if
“Block policy inheritance” has been set for an OU!

Note: If a policy with a lesser priority but which has been designated “No Override” is assigned
to the same level as a higher ranking policy, this policy will take priority despite its lower ranking.
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10.8.11 Settings in policies

Replay Machine Settings

You will find this setting under:
Policy Items > policy of the type General Settings > Loading of settings > Policy loopback

If you select “Replay Machine Settings” in the field Policy Loopback of a policy of the type
General Settings and the policy comes from a computer (“Replay Machine Settings” does not
affect user policies), this policy is replayed at the end of the analysis. This then overrides any user
settings and the machine settings apply. All machine settings inherited directly or indirectly by
the machine (including policies which have not been applied by the “Replay Machine Settings”
policy loopback) are rewritten.

Ignore User

You will find this setting under:
Policy Items > policy of the type General Settings > Loading of Settings > Policy Loopback

If you select “Ignore User” for a policy for a computer in the field Policy Loopback of a policy of
the type General Settings and the policy comes from a machine, only the machines settings are
analyzed. User settings are not analyzed.

No Loopback

You will find this setting under:
Policy Items > policy of the type General Settings > Loading of Settings > Policy Loopback

No loopback describes the standard behavior. User policies take priority over computer policies.

Analyzing the settings “Ignore User” and “Replay Machine Settings”

If there are active policy assignments, the machine policies are analyzed and consolidated first. If,
with the Policy Loopback option, this amalgamation of individual policies gives the value “Ignore
User”, the policies that would have been fixed for the user will not be analyzed. This means that
the same policies apply both for the user and for the machine.

If, after amalgamating the individual machine policies, the value with the Policy Loopback
attribute is “Replay machine settings”, the user policies are amalgamated with the machine
policies. After the amalgamation, the machine policies are rewritten and, where appropriate,
override settings from the user policies. If a setting is present in both policies, the machine policy
value overrides the user policy value.

If the consolidation of the individual machine policies results in the standard value (“No Policy
Loopback”), user settings take priority over machine settings.
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Order of the execution of policies

Ignore User Computers

Replay Machine Settings Computer -> User -> Computer The first “machine execution” is
required for the policies which are written before user logon (e.g. background image at logon).

No Loopback (standard setting): Computer -> User

10.8.12 Other definitions
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The decision as to whether it is a user or machine policy depends on the policy's origin. A user
object “brings” a user policy, while a computer “brings” a computer policy. The same policy can
be a machine or a user policy, depending on the perspective.

User policy

Any policy provided by the user for analysis. If a policy is implemented via only one user, the
machine-related settings of that policy are not applied, i.e. computer-related settings do not
apply. Default values do.

Computer policy

Any policy provided by the machine for analysis. If a policy is implemented via just one
computer, the user-specific settings for this policy are also applied! The computer policy
therefore represents a policy “for all users”.
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11 Working with configuration packages

In the SafeGuard Management Center you can create the following types of configuration
packages:

Configuration package for managed computers

Computers that have a connection to the SafeGuard Enterprise Server receive their policies via
this Server. For successful operation after installation of the SafeGuard Enterprise Client
software, you need to create a configuration package for managed computers and deploy it to
them.

After the first configuration of the endpoint computer via the configuration package, the
computer receives policies via the SafeGuard Enterprise Server after you have assigned them
in the Users & Computer area of the SafeGuard Management Center.

Configuration package for unmanaged computers

Unmanaged computers are never connected to the SafeGuard Enterprise Server at any point
in time, they operate in standalone mode. They receive their policies via configuration
packages. For successful operation, you need to create a configuration package containing the
relevant policy groups and distribute it to the endpoint computers via company distribution
mechanisms. New configuration packages needs to be created and distributed to the endpoint
computers whenever the policy settings are changed.

Configuration package for the SafeGuard Enterprise Server

For successful operation, you need to create a configuration package for the SafeGuard
Enterprise Server, defining the database and SSL connection, enabling the scripting APl and
S0 on.

For a detailed description on how to create the different kinds of configuration packages, see the
SafeGuard Enterprise Installation manual.

Note: Check your network and computers in regular intervals for outdated or unused
configuration packages and, for security reasons, make sure to delete them. Always ensure to
uninstall the “old” configuration packages before installing the new one on the computer/server.
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12 Administrative access options for endpoint computers

To cater for access requirements for administrative tasks after the installation of SafeGuard
Enterprise on endpoint computers, SafeGuard Enterprise offers the following administrative
access options:

Service accounts for Windows logon

With service accounts, administrators can log on (Windows logon) to endpoint computers
after the installation of SafeGuard Enterprise without activating the Power-on Authentication
and without being added as users to the computers. Service accounts lists are defined in the
Policies area of the SafeGuard Management Center and assigned via policies to the endpoint
computers. Users included on a service account list are treated as guest users when logging on
at the endpoint computer.

Note: Service account lists are assigned to endpoint computers via policies. They should be
assigned in the first SafeGuard Enterprise configuration package you create for the configuration
of the endpoint computers.

For detailed information on service accounts, see Service Account Lists for Windows logon,
page 85.

POA access accounts for POA logon on unmanaged endpoint computers protected by
SafeGuard Enterprise

For unmanaged endpoint computers, i.e., endpoint computers operating in standalone mode,
SafeGuard Enterprise offers POA access accounts. POA access accounts are predefined local
accounts that enable users to log on (POA logon) to endpoint computers after the Power-on
Authentication has been activated to perform administrative tasks. The accounts are defined
in the Users and Computers area of the SafeGuard Management Center (user ID and
password) and assigned to the endpoint computers via POA access groups included in
configuration packages.

For detailed information on POA access accounts, see POA access accounts for POA logon at
unmanaged endpoint computers, page 91.
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13 Service Account Lists for Windows logon

A typical scenario for most implementations is that a rollout team installs new computers in an
environment including the installation of SafeGuard Enterprise. For installation or verification

reasons, rollout operators may log on to the respective computer before the end user receives the
new machine and is able to activate the Power-on Authentication.

Thus, the scenario may be as follows:
1. SafeGuard Enterprise is installed on an endpoint computer.
2. After rebooting the computer, the rollout operator logs on.

3. The rollout operator is added to the POA and the POA becomes active. The rollout operator
becomes owner of the computer.

Upon receiving the computer the end user will not be able to log on to the POA and needs to
perform a Challenge/Response procedure.

To prevent that administrative operations on a SafeGuard Enterprise protected computer lead to
an activation of the Power-on Authentication and the addition of rollout operators as users and
machine owners to the computer, SafeGuard Enterprise offers the possibility of creating service
account lists for SafeGuard Enterprise protected computers. The users included in these lists are
thereby treated as SafeGuard Enterprise guest users.

With service accounts the scenario is as follows:
1. SafeGuard Enterpriseis installed on an endpoint computer.

2. After rebooting the computer, a rollout operator included on a service account list logs on
(Windows logon).

3. According to the service account list applied to the computer the user is identified as a service
account and will be treated as a guest user.

The rollout operator will not be added to the POA and the POA will not become active. The
rollout operator will not become owner of the computer. The end user can log on and activate the
POA.

Note: As the service account list functionality is especially helpful during the rollout phase of an
implementation, it is recommended to assign service account lists as early as in the first
SafeGuard Enterprise configuration package created in the SafeGuard Management Center for
configuring the SafeGuard Enterprise protected endpoint computer after installation.
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13.1 Creating service account lists and adding users

To create service account lists and add users, do as follows:

1.

2.

8.

Click Policies in the navigation area.

Select Service account lists in the policy navigation window.

In the context menu of Service account lists, click New > Service account list.
Enter a name for the service account list and click OK.

Select the new list under Service account lists in the policy navigation window.

Right-click in the action area to open the context menu for the service account list. In the
context menu, select Add.

A new user line is added. Enter the User Name and the Domain Name in the respective
columns and press Enter. To add further users, repeat this step.

Save your changes by clicking the Save icon in the toolbar.

The service account list is now registered and can be selected for assignment when creating a
policy.

13.2 Additional information for entering user and domain names

There are different methods for specifying users in service account lists using the two fields User
Name and Domain Name (see Covering different combinations for logging on, page 86).
Furthermore, certain restrictions apply for valid input in these fields (see Restrictions, page 88).

13.2.1 Covering different combinations for logging on

The two separate fields User Name and Domain Name per list entry offer the flexibility to cover
all available combinations for logging on, for example "user@domain” or "domain\user",

To handle several user name/domain name combinations, you can use asterisks (*) as wild cards.
An asterisk is allowed as the first sign, the last sign and the only sign.
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For example:

User Name: Administrator
Domain Name: *

This combination specifies all users with the user name "Administrator" who log on to any
network or local machine.

The predefined domain name [LOCALHOST] available in the drop-down list of the Domain
Name field stands for the logon on any local workstation.

For example:

User Name: "*admin"
Domain Name: [LOCALHOST]

This combination specifies all users whose user names end on "admin" and who log on to any
local machine.

Furthermore, users may log on in different ways, e.g.:

user: test, domain: mycompany or
user: test, domain: mycompany.com.

As domain specifications in the service account lists are not automatically resolved, there are
three possible methods for specifying the domain correctly:

You know exactly how the user is going to log on and enter the domain accordingly.
You create several service account list entries.
You use wild cards to cover all different cases (user: test, domain: mycompany?*).

Note: To avoid any problems caused by the fact that Windows may not use the same character
sequence, but truncate names, it is recommended to enter the FullQualifiedName and the
NetBIOS name or use wildcards.
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13.2.2 Restrictions

Asterisks are only allowed as the first sign, the last sign and the only sign. Following are examples
for valid and invalid strings using asterisks:

Valid strings are for example admin*, *, *strator, *minis*.

Invalid strings are for example **, Admin*trator, Ad*minst*.

Furthermore the following restrictions apply:

The character ? is not allowed in user logon names.

The characters /\[]:;|=,+*?<>"are not allowed in domain names.

13.3 Editing and deleting service account lists

As a security officer with the right Modify service account lists you can edit or delete service
account lists at any time:

To edit a service account list, double-click it in the policy navigation window. The service
account list is opened and you can add, delete or modify user names on the list.

To delete a service account list, select it in the policy navigation window, open the context
menu and select Delete.

13.4 Assigning a service account list via policy

To select and assign a service account list, do as follows:

1.

2.

3.

Create a new policy of the type Authentication or select an existing one.

Under Logon Options, select the required service account list from the drop-down list of the
Service Account List field.

Note: The default setting of this field is [No list], i.e. no service account list applies. Rollout
operators logging on to the computer after installation of SafeGuard Enterprise will therefore
not be treated as guest users and may activate Power-on Authentication and be added to the
computer. To undo the assignment of a service account list, select the [No list] option.

Save your changes by clicking the Save icon in the toolbar.

You can now transfer the policy to the respective computers to make the service accounts
available on the computer.
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Note: If you select different service account lists in different policies which are all relevant
according to the RSOP (Resulting Set of Policies, the settings valid for a specific computer/group),
the service account list assigned in the last policy applied will overrule all previously assigned
service account lists. Service account lists will not be merged.

13.5 Transferring the policy to the endpoint computer

The service account list functionality is especially helpful and important during initial installation
in the rollout phase of an implementation. It is therefore recommended to transfer the service
account settings to the endpoint computer immediately after installation. To make the service
account list available on the endpoint computer at this point, include a policy of the type
Authentication when you create the initial configuration package for configuring the endpoint
computer after installation.

You can change the service account list settings at any time and the changes will be transferred to
the endpoint computer via the server in the usual way.

13.6 Logging on to an endpoint computer using a service account

At the first Windows logon after rebooting the computer, a user included on a service account list
logs on to the respective machine as a SafeGuard Enterprise guest user. This first Windows logon
to the machine neither kicks off a pending Power-on Authentication nor adds the user to the
computer. The SafeGuard Enterprise System Tray icon balloon tool tip "Initial user
synchronisation completed” will not be displayed.

13.6.1 Service account status display on the endpoint computer
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In addition, the guest user logon status is also available via the System Tray Icon. For further
information the System Tray Icon refer to the SafeGuard Enterprise User help, chapter System
Tray icon and balloon tool tip (description of the user state field).
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13.7 Log events

Actions performed regarding service account lists are reported by the following log events:
SafeGuard Management Center

Service account list <name> created

Service account list <name> modified

Service account list <name> deleted

SafeGuard Enterprise protected computer

Windows user <domain/user name> logged on at <timestamp> to machine <domain/
workstation name> as SGN service account.

New service account list <name> imported.

Service account list <name> deleted.
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14 POA access accounts for POA logon at unmanaged

endpoint computers

For unmanaged computers protected by SafeGuard Enterprise, i. e., computers operating in
standalone mode, SafeGuard Enterprise offers POA access accounts. After SafeGuard Enterprise
has been installed and the Power-on Authentication (POA) has been activated, access to endpoint
computers to perform administrative tasks may be required. With POA access accounts, users
can log on at the Power-on Authentication on endpoint computers for administrative tasks
without having to initiate a Challenge/Response procedure. There is no automatic logon to
Windows. The users logging on with POA access accounts log on to Windows with their existing
Windows accounts.

14.1 Creating POA access accounts

To create POA access accounts, do as follows:

1. Click Users & Computers in the navigation area of the SafeGuard Management Center.
2. In the Users and Computers navigation window under POA, select POA Users.

3. Inthe context menu of POA Users, click New > Create new user.

The Create new user dialog is displayed.

4. In the Full name field, enter a name, i.e. the logon name, for the new POA user.

5. Optionally, enter a description for the new POA user.

6. Enter a password for the new POA access account and confirm it.

Note: To enhance security, the password should adhere to certain minimum complexity
requirements, e.g., minimal length of 8 characters, mixture of numerical and alphanumerical
characters etc. If the password you have entered is too short, a warning message will be displayed.

7. Click OK.

The new POA access account is created and the POA user (i.e. the POA access account) is
displayed under POA users in the Users & Computers navigation area.
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14.2 Changing the password for a POA access account

To change the password for a POA access account, do as follows:
1. Click Users & Computers in the navigation area of the SafeGuard Management Center.

2. Inthe Users & Computers navigation window under POA, POA Users, select the relevant
POA user.

3. In the context menu of the POA user, select Properties.

The properties dialog for the POA user is displayed.

4. In tab General under User Password, enter the new password and confirm it.
5. Click OK.

The new password applies for the relevant POA access account.

14.3 Deleting POA access accounts

To delete POA access accounts, do as follows:
1. Click Users & Computers in the navigation area of the SafeGuard Management Center.

2. Inthe Users and Computers navigation window under POA, POA Users, select the relevant
POA access account.

3. Right-click on the POA access account and select Delete from the context menu.

The POA access account, i.e. the POA user, is deleted and is no longer displayed in the Users and
Computers navigation window.

Note: If the user is part of one or several POA groups, the POA access account will also be
removed from all groups. However, the POA access account will still be available on the endpoint
computer until a new configuration package has been created and assigned. For further details on
POA groups, see Creating POA access account groups, page 93. For further details on changing the
POA access account assignment, see Changing POA access accounts assignments on endpoint
computers, page 96
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14.4 Creating POA access account groups

To be able to assign POA access accounts to endpoint computers via configurations packages, the
accounts must be arranged in groups. When creating configuration packages, you can select a
POA access account group for assignment.

To create POA access account groups, do as follows:

1. Click Users & Computers in the navigation area of the SafeGuard Management Center.
2. Inthe Users and Computers navigation area under POA, select POA Groups.

3. In the context menu of POA Groups, click New > Create new group.

The Create new group dialog is displayed.

4. In the Full name field, enter a name for the new POA group.

5. Optionally, enter a description for the new POA group.

6. Click OK.

The new POA access account group is created and is displayed under POA Groups in the Users
and Computers navigation area. You can now add users, i.e. POA access accounts, to the POA
access account group.

14.5 Adding accounts to POA access account groups

To add users, i.e. POA access accounts, to POA access account groups, do as follows:
1. Click Users & Computers in the navigation area of the SafeGuard Management Center.

2. Inthe Users and Computers navigation window under POA, POA Group, select the relevant
POA group.

In the action area of the SafeGuard Management Center on the right-hand side, the Members tab
is displayed.

3. In the SafeGuard Management Center toolbar, click the Add icon (green plus sign).
The Select member object dialog is displayed.
4. Select the user, i.e. POA access account, you want to add to the group.

5. Click OK.

The POA access account is added to the group and displayed in the Members tab.
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Note: You can also add accounts to groups by selecting the POA user, i.e. POA access account, in
the navigation window and following the steps described above. The only difference in this
approach is that the action area displays the Member of tab after selecting the user. This tab shows
the groups the user has been assigned to. The basic workflow is identical.

14.6 Removing members from POA access account groups
To remove members, i.e. POA access accounts, from POA access account groups, do as follows:
1. Click Users & Computers in the navigation area of the SafeGuard Management Center.

2. Inthe Users and Computers navigation window under POA, POA Group, select the relevant
POA group.

In the action area of the SafeGuard Management Center on the right-hand side, the Members tab
is displayed.

3. Select the user you want to delete from the group.

4. In the SafeGuard Management Center toolbar, click the Remove (Delete) icon (red cross
sign).

The user is removed from the group.

Note: You can also remove members from groups by selecting the POA user, i.e. POA access
account, in the navigation window and following the steps described above. The only difference
in this approach is that the action area displays the Member of tab after selecting the user. This
tab shows the groups the user has been assigned to. The basic workflow is identical.

14.7 Assigning POA access accounts to endpoint computers
To assign POA access groups to endpoint computers via configuration packages, do as follows:

1. Inthe SafeGuard Management Center, select Configuration Package Tool from the Tools
menu.

2. Select an existing configuration package or create a new one.
3. Specify a POA Group created beforehand in the Users and Computers area of the SafeGuard
Management Center, to be applied to the computers.

The default setting for the POA group is No Group.

Furthermore, an empty group is available for selection by default. This group can be used to
delete a POA access account group assignment on endpoint computers. For further details see
Deleting POA access accounts from endpoint computers, page 95.
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4.

5.

6.

Specify an output path for the configuration package.
Click Create Configuration Package.

Deploy the configuration package to the endpoint computers.

By installing the configuration package, the users, i.e. POA access accounts, included in the group
are added to the POA on the endpoint computers. The POA access accounts are available for POA
logon.

14.8 Deleting POA access accounts from endpoint computers

POA access accounts can be deleted from endpoint computers by assigning an empty POA access
account group. Do as follows:

1.

5.

6.

In the SafeGuard Management Center, select the Configuration Package Tool from the Tools
menu.

Select an existing configuration package or create a new one.

Specify an empty POA Group created beforehand in the Users area of the SafeGuard
Management Center, or select the empty POA group that is available by default in the
Configuration Package Tool.

Specify an output path for the configuration package.
Click Create Configuration Package.

Deploy the configuration package to the endpoint computers.

By installing the MSI file, all POA access accounts are removed from the endpoint computers, i.e.
all relevant users are removed from the POA.
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14.9 Changing POA access accounts assignments on endpoint
computers

To change the POA access accounts assignment for endpoint computers, do as follows:
1. Create a new POA access account group or modify an existing one.

2. Create a new configuration package and select the new or modified POA access account
group.

The new POA access account group is available on the endpoint computer, all users included are
added to the POA. The new group overwrites the old one. POA access account groups are not
merged.

14.10 Logging on to an endpoint computer using a POA access
account

To log on using a POA access account, do as follows;

1. Switch on the computer.

The Power-on Authentication logon dialog is displayed.

2. Enter the User name and the Password of the predefined POA access account.

You are not automatically logged on to Windows. Therefore, the Windows logon dialog is
displayed.

3. In the Domain field, select the domain <POA>.

4. Log on to Windows using your existing Windows user account.
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15 Security policies

The SafeGuard Enterprise policies include all settings which need to be active to implement
a companywide security policy on the endpoint computers.

The SafeGuard Enterprise policies can incorporate settings for the following areas (policy types):

General Settings
Contains for example settings for transfer rate, background images, etc.

Authentication
Contains settings for logon mode, device lock, etc.

PINs
Defines the requirements for used PINSs.

Passwords
Defines the requirements for used passwords.

Passphrases
Defines the requirements for used passphrases. Passphrases are used for secure data exchange
with SafeGuard Data Exchange during key generation.

Device protection

Contains the settings for volume- or file based encryption (including settings for SafeGuard Data
Exchange and SafeGuard Portable): algorithms, keys, the drives on which data is to be encrypted,
etc.

Specific machine settings
Contains settings for the Power-on Authentication (activate/deactivate), for secure Wake On
LAN, display options, etc.

Logging
Defines the events to be logged and their output destinations.

Configuration protection
Contains settings (allow/block) for the usage of ports and peripheral devices (PDAs,
removable media, printers, etc.).
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15.1 General settings

Policy setting Explanation

LOADING OF SETTINGS

Policy Loopback

Replay Machine Settings

If “Replay Machine Settings” is selected for a policy in the field
Policy Loopback, and the policy originates from a machine
(“Replay Machine* setting of a user policy does not have any
effect), this policy is implemented again at the end. This then
overrides any user settings and the machine settings apply.
Ignore User

If you select “Ignore User” for a policy (machine policy) in the
field Policy Loopback and the policy originates from a
machine, only the machine settings are analyzed. User settings
are not analyzed.

No Loopback

No loopback is the standard behavior in which user policies
take priority over machine policies.

How are settings “Ignore User” and “Replay Machine
Settings” analyzed?

If there are active policy assignments, the machine policies are
analyzed and consolidated first. If consolidation of the various
policies results in the “Ignore User” attribute in policy
loopback, policies that would have been applied for the user
are no longer analyzed. This means that the same policies
apply to the user as to the machine.

If “Replay Machine Settings” value is applied in the case of the
policy loopback, once the individual machine policies have
been consolidated, the user policies are then merged with the
machine policies. After consolidation the machine policies are
re-written and override any user policy settings. This means
that if a setting is present in both policies, the machine policy
value overrides the user policy value.

If the consolidation of individual machine policies results in
the standard value, the following applies: User settings take
priority over machine settings.
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Policy setting Explanation

TRANSFER RATE

Connection interval to Determines the period in minutes after which a SafeGuard

server (min) Enterprise Client sends a policy (changes) enquiry to the
SafeGuard Enterprise Server.
Note: To prevent a large number of clients contacting the
server at the same time, communication is always carried out
in a period of +/- 50% of the set connection interval. Example:
Setting “90 minutes” results in a communication period
between the client and the server of 45 to 135 minutes.

LOGGING

Feedback after number of The log system, implemented as Win32 Service “SGM

events LogPlayer”, collects log entries generated by SafeGuard
Enterprise for the central database and stores them in local log
files. These are located in the Local Cache in the
“Auditing\SGMTransLog” directory. These files are
transferred to the transport mechanism which then sends
them to the database via the SGN Server. Transfer takes place
as soon as the transport mechanism has succeeded in creating
a connection to the server.

The log file therefore increases in size until a connection has
been established. To limit the size of each log file, it is possible
to set a maximum number of log entries in the policy. Once
the preset number of entries has been reached the logging
system places the log file in the SGN Server transport queue
and starts a new log file.

CUSTOMIZATION

Language used on client Determines the language in which settings for SafeGuard
Enterprise are displayed on the endpoint computer:
Besides the supported languages, users may select the
computer's operating system language setting.

99



SafeGuard® Enterprise 5.50, Administrator help

Policy setting Explanation

LOGON RECOVERY

Activate logon recovery after
Windows Local Cache
corruption

The Windows Local Cache is the start and the end point for
the data exchange between the endpoint computer and the
server. It stores all keys, policies, user certificates and audit
files. All data stored in the local cache are signed and cannot be
changed manually.

By default logon recovery is deactivated. i.e. the Windows
Local Cache will be restored automatically from its backup. In
this case, no Challenge/Response procedure is required for
repairing the Windows Local Cache. If the Windows Local
Cache is to be repaired explicitly via a Challenge/Response
procedure, set this field to “YES*.

Enable Local Self Help

Enable Local Self Help

Determines whether users are permitted to log on to their
computers via Local Self Help if they have forgotten their
password. Using Local Self Help the user can log on by
answering a specified number of previously defined questions
in the Power-on Authentication. Thus, in case of an
emergency, the user can regain access to their computer even
if neither telephone nor internet connection are available. A
Challenge/Response procedure is not necessary in this case.
Local Self Help helps reducing help desk efforts and cost.
Notice: For the user to be able to use Local Self Help,
automatic logon to Windows has to be enabled. Otherwise,
Local Self Help will not work.

Minimal length of answers

In this field, define the minimum length (in characters) for the
answers to be saved for Local Self Help on the endpoint
computer.

Welcome text under
Windows

In this field you can specify the individual information text to
be displayed in the first dialog when launching the Local Self
Help Wizard on the endpoint computer. Prior to specifying
the text here, it has to be created and registered.

Users can define their own
guestions

As a security officer you can define the set of questions to be
answered centrally and distribute it to the endpoint computer
via the policy. However, you can also grant the users the right
to define their own questions. To entitle users to define their
own guestions, select option Yes in this field.
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Policy setting Explanation

Challenge / Response (C/R)

Enable logon recovery via Determines whether a user is permitted to generate a challenge
C/R in the Power-on Authentication (POA) to regain access to
their computer via a Challenge/Response procedure.

YES: User is permitted to generate a challenge. In this case, the
user can regain access to their computer via a C/R procedure
in case of emergencies.

NO: User is not permitted to issue a challenge. In this case, the
user cannot initiate a C/R procedure to regain access to their
computer in case of an emergency.

Allow automatic logon to Allows the user to log on to Windows automatically after
Windows authentication via Challenge/Response.

YES: User is automatically logged on to Windows.
NO: Windows logon screen appears.

Anwendungsfall: A user has forgotten their password. After
the Challenge/Response procedure, SafeGuard Enterprise logs
the user on at the computer without an SGN password. In this
case automatic Windows logon is switched off and the
Windows logon screen is displayed. The user cannot log on
because they do not know the SGN password (= Windows
password). “YES” allows automatic logon and the user is able
to move on from the Windows logon screen.

Information text Displays an information text when the Challenge button is
pressed in the POA. Information texts can include, e.g. “Please
contact Support Desk on telephone number 01234-56789.”
Prior to specifying a text here, you must create it as a text file
in the policy navigation area under Information text.

IMAGES

Prerequisite:

New images must be registered in the policy navigation area
of the SafeGuard Management Center under Images. The
images will only be available after registration.

Supported formats: .BMP, PNG, JPEG.

Swaps the blue background bitmap with the SafeGuard design
for the background of your choice. Customers might for
example use the company logo in POA and at Windows logon.
Maximum file size for all background bitmaps: 500 KB

Background image in POA | Resolution: 1024x768 (VESA mode)
Colors: unlimited.
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Policy setting Explanation

Background image in POA
(low resolution)

Resolution: 640x480 (VGA mode)
Colors: 16 colors

Logon image in POA

Logon image in POA
(low resolution)

Swaps the SafeGuard Enterprise bitmap displayed in the POA
logon dialog. For example, the company logo can be displayed
in this dialog.

Resolution: 413 x 140 pixels
Colors: unlimited.

Resolution: 413 x 140 pixels
Colors: 16

SafeGuard Logon

SOPHOS

User Name: IJohn

Password:

I
I*********** I

Domain: | MY_COMPANY | -
[ oK ][ Recovery ][ Shutdown ][ Options:-:-]
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15.2 Authentication

The way users log on to their workstation (with or without token) is determined in a policy of type

Authentication.

Policy setting Explanation

ACCESS

Users may only boot from hard disk Determines whether users may start the PC from
the hard drive and/or another medium.
YES: Users can only boot from the hard disk. The
POA does not offer the option to start the PC with
a floppy disk or other external medium.
NO: Users may start the PC from hard disk,
floppy disk or external medium (USB, CD etc.)

LOGON OPTIONS

Logon mode Determines how a user needs to authenticate
themselves at the POA.

User ID/Password

The user may not log on with a token. Logon
must be via user name and password in the
POA.

Token

The user can only log on to the POA using a
token or smartcard. This process offers a
higher level of security. The user is requested
to insert the token at logon. User identity is
verified by token ownership and PIN
presentation. After the user has entered the
correct PIN, SafeGuard Enterprise
automatically reads the data for user logon.

Notice: Once this logon process has been selected,
users can only log on using a previously issued
token.

A combination of the above settings is allowed. To
test whether logon using a token works, first select
both settings. Only deselect logon mode User ID/
Password, if authentication using the token was
successful.
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Policy setting Explanation

Fingerprint

Select this setting to enable logon with Lenovo
Fingerprint Reader

Users to whom this policy applies can then log on
with a fingerprint or a user name and password.
This procedure provides the maximum level of
security.

When logging on, the user swipes his or her
finger over the fingerprint reader. Upon
successful recognition of the fingerprint, the
Power-on Authentication process reads the
user’s credentials and logs the user on to Power-
on Authentication. The system then transfers the
credentials to Windows, and the user is logged
on to the computer.

Notice:

After selecting this logon procedure, the user can
log on only with a pre-enrolled fingerprint or a
user name and password. Token and fingerprint
logon procedures cannot be combined on the same
computer.

Logon options using token

Determines the type of token or smartcard to be
used at the user PC.

Non-cryptographic:
Authentication at POA and Windows based
on user credentials.

Kerberos:

Certificate-based authentication at POA and
Windows.

The SO issues a certificate in a PKI and stores
it on the token. This certificate is imported as a
user certificate into the SafeGuard Enterprise
database. If an automatically generated
certificate already exists in the database, it is
replaced by the imported certificate.

Hint: Challenge/Response is not possible with a

token supporting Kerberos as no user credentials
are provided in the POA that could be used for a
Challenge/Response procedure.
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Policy setting Explanation

PIN used for autologon with token Specify a default PIN to enable the user to
automatically log on at the Power-on
Authentication using a token or smartcard. The
user is requested to insert the token at logon and is
then passed through the Power-on
Authentication. Windows will be started.

PIN rules do not need to be observed.

Notice:

Thisoption isonly available, if Token has been
selected as Logon mode.

If this option is activated, then Pass-through
to Windows must be set to Disable pass-
through to Windows.

Display unsuccessful logons for this user | Displays (setting: YES) after logon at POA and
Windows a dialog showing information on the
last failed logon (user name/date/time).

Display last user logon Displays (setting: YES) after logon at POA and
Windows a dialog showing information on the

last successful logon (user name/date/time)

last user credentials of the logged on user

Disable “forced logoff” in workstation If users wish to exit the endpoint computer for a
lock short time only, they can click Block workstation
to block the computer for other users and unlock
it with the user password.

If this option is set to NO, the user who has locked
the computer as well as an administrator can
unlock the it.

If an administrator unlocks the computer, the
currently logged on user is logged off
automatically. Setting this field to YES changes
this behavior. In this case, only the user can
unlock the computer. The administrator cannot
unlock it and the user will not be logged off
automatically. Note: This setting only takes effect
under Windows XP.
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Policy setting Explanation

Activate user/domain preselection

YES: The POA saves the user name and domain of
the last logged on user. Users therefore do not
need to enter their user names every time they log
on.

NO: The POA does not save the user name and
the domain of the last logged on user.

Pass through to Windows

Note: For the user to be able to grant other users
access to their computer, the user has to be
permitted to deactivate logon passthrough to
Windows.

Let user choose freely

The user can decide by enabling/disabling this
option in the POA logon dialog whether
automatic logon at Windows is to be
performed.

Enforce pass-through to Windows
The user will always be automatically logged
on to Windows.

Disable pass-through to Windows

After the POA logon, the Windows logon
dialog will be displayed. The user has to log on
to Windows manually.

Service Account List

To prevent that administrative operations on a
SafeGuard Enterprise protected computer lead to
an activation of the Power-on Authentication and
the addition of rollout operators as users to the
computer, SafeGuard Enterpriseoffers the
possibility of creating service account lists for
SafeGuard Enterprise endpoint computers. The
users included in these lists are thereby treated as
SafeGuard Enterprise guest users.

Prior to selecting a list here you first have to create
the lists in the Policies navigation are under
Service Account Lists.
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Policy setting Explanation

BitLocker Options

BitLocker Logon mode You can select from the following options for the
BitLocker logon mode.

TPM: The key for logon is stored on the TPM
chip.

TPM + PIN: The key for logon is stored on the
TPM chip and aPIN is also required for logon.
Settings for the PIN are given under PIN and

password.

USB Memory Stick: The key for logon is
stored on a USB stick.

TPM + USB Memory Stick: The key for logon
is stored on the TPM chip and on a USB stick.
Logon can either be with the TPM chip or USB
stick.

BitLocker Fallback Logon mode In case logon fails, SafeGuard Enterprise offers
logon with USB stick as a fallback mechanism or
an error message output.

Note: If you select USB Memory Stick as the logon
mode, this option is not offered.
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Policy setting Explanation

TPM platform validation profile

If TPM can be found on the endpoint computer, it
can be configured which type of TPM platform
validation profile should be used.

The TPM platform validation profile specifies the
measurements that are used to protect BitLocker
encryption keys.

A platform validation profile consists of a set of
Platform Configuration Register (PCR) indices.

Microsoft recommends to use the default TPM
platform validation profile in Windows Vista,
which secures the following:

the encryption key against changes to the Core
Root of Trust of Measurement (CRTM), BIOS,
and Platform Extensions (PCR 0)

Option ROM Code (PCR 2)

Master Boot Record (MBR) Code (PCR 4)
NTFS Boot Sector (PCR 8)

NTFS Boot Block (PCR 9)

Boot Manager (PCR 10)

BitLocker DE Access Control (PCR 11)

Note: This option is only available if you select
TPM as logon mode. If USB Memory Stick is the
selected logon mode, this option is not offered.
For further information on the TPM validation
profile follow this link:
http://msdn2.microsoft.com/en-us/library/
aa376469.aspx

FAILED LOGONS

Maximum no. of failed logons

Determines how many times a user can attempt to
log on using an invalid user name or password.

After incorrectly entering a user name or
password three times in a row for instance, a
fourth attempt will trigger the “Response to a
failed logon” setting.
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Policy setting Explanation

Display ,,Logon failed” messages in POA | Defines level of detail for messages on failed
logons:

Standard: Shows a short description.

Verbose: Displays more detailed information.

Reaction to failed logons

Lock machine Determines whether the PC is locked after failed
attempts to log on.

The computer lock can be lifted by an
administrator who must reboot the PC and log on.
In this context, also take Windows user lock into
consideration.

TOKEN OPTIONS
Action if token logon status is lost Defines behavior after removing the token from
the computer:
Possible actions include:
Lock Computer
Present PIN dialog
No Action
Allow unblocking of token Determines whether the token may be unblocked
at logon.
LOCK OPTIONS

Lock screen after X minutes inactivity Determines the time after which an unused
desktop is automatically locked.

The default value is 0 minutes in which case the
desktop will not be locked.

Lock screen at token removal Determines whether the screen is locked if a token
is removed during a session.

Lock screen after resume Determines whether the screen is locked if the
computer is reactivated from standby mode.
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15.3 Creating forbidden PIN lists for use in policies

For policies of the type PIN a list of forbidden PINs can be created to define character sequences
which must not be used in PINSs.

Note: In the lists, forbidden PINs are separated by a space or line break.

The text files containing the required information have to be created prior to registering them in
the SafeGuard Management Center. The maximum files size for text files is 50 KB. SafeGuard
Enterprise only uses Unicode UTF-16 coded texts. If you do not create the text files in this format,
they will be automatically converted upon registration.

In case of a conversion process, a message will be displayed indicating that the file is being
converted.

To register text files, do the following:
1. In the policy navigation area, right-click Information text and select New > Text.
2. Enter a name for the text to be displayed in the Text item name field.

3. Click [...] to select the previously created text file. If the file needs to be converted, a message
will be displayed.

4. Click OK.

The new text item is displayed as a subnode below Information text in the policy navigation area.
If you select a text item, its contents will be displayed in the window on the right-hand side. The
text item can now be selected when creating policies.

Proceed as described to register further text items. All registered text items will be shown as
subnodes.

Note: Using the Modify Text button, you can add new text to existing text. When clicking this
button, a dialog is displayed for selecting another text file. The text contained in this file will be
appended at the end of the existing text.
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15.4 Syntax rules for PINs

111

PINs can contain numbers, letters and special characters (e.g. + - ; etc.). However, when issuing
anew PIN, do not use any character with the combination ALT + < character > as this input mode
is not available at Power-on Authentication. Rules for PINs used to log on to the system are
defined in policies of the type PIN.

Note: If password rules have been defined in the SafeGuard Management Center, no rules should
be defined in Active Directory.

Policy setting Explanation

RULES

Min. PIN length Displays how many characters a PIN must comprise when
changed by the user. The required value can be entered
directly or increased/reduced using the arrow keys.

Max. PIN length Displays the maximum number of characters a PIN must
comprise when changed by the user. The required value can
be entered directly or increased/reduced using the arrow
keys.

Min. number of letters This setting specifies that a PIN may not consist exclusively
Min. number of digits of letters, numbers or special characters, but must consist of a
Min. number of special combination of at least two (e.g. 15flower etc). This setting is
characters only practical, if a minimum PIN length of greater than 2 has
been defined.

Case sensitive This setting is only effective with Use forbidden PIN list and
User name as PIN forbidden.

Case 1: You have entered “board” in the list of forbidden
PINs. If the Case sensitive option is set to YES, additional
password variants such as BOARD, BoaRD will not be
accepted and logon will be denied.

Case 2: “EMaier” is entered as a user name. If option Case
sensitive is set to YES and option User name as PIN
forbidden is set to NO, user EMaier cannot use any variant
of this user name (e.g. “emaier” or “eMaiER") as a PIN.

Keyboard row forbidden Consecutive key sequences include e.g. “123” or “gqwe”.

A maximum of two adjacent characters on the keyboard is
allowed. Consecutive key sequences relate only to the
alphanumerical keyboard area.
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Policy setting Explanation

Keyboard column forbidden

Refers to keys arranged consecutively in columns on the
keyboard such as “yagl”, “xsw2” or “3edc” (but not “yse4”,
“xdr5” or “cft6”!). A maximum of two adjacent symbols in a
single keyboard column is permitted. If you disallow keypad
columns, combinations like these are rejected as PINSs.
Consecutive key sequences relate only to the alphanumerical
keyboard area.

3 or more consecutive
characters forbidden

Activation of this option disallows key sequences

which are consecutive series of ASCII code symbols in
both ascending and descending order (“abc”; “cba”; “;<”
etc.).

which consist of three or more identical symbols
(“aaa” or “1117).

User name as PIN forbidden

Determines whether user name and PIN may be identical.
YES: Users may use their Windows user names as PINSs.
NO: Windows user name and PIN must be different.

Use forbidden PIN list

Determines whether certain character sequences must not be
used for PINs. The character sequences are stored in the list
of forbidden PINs (e.g. .txt file).

List of forbidden PINs

Defines character sequences which must not be used for
PINs. If a user uses a forbidden PIN, an error message will be
displayed.

Important prerequisite:

A list (file) of forbidden PINs must be registered in the
Management Center in the policies navigation area under
Information text. The list is only available after registration.
Maximum file size: 50 KB

Supported format: Unicode

Defining forbidden PINs

In the list, forbidden PINs are separated by a space or line
break.

Wildcard: Wildcard character “*” can represent any character
and any number of characters in a PIN. Therefore *123*
means that any series of characters containing 123 will be
disallowed as a PIN.
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Policy setting Explanation

Notice:

If the list contains only a wildcard, the user will no longer
be able to log on to the system after a forced password
change.

Users must not be permitted to access the file.

Option Use forbidden PIN list must be activated.

CHANGES

PIN change after min. (days) | Determines the period during which a password may not be
changed. This setting prevents the user from changing a
password too many times within a specific period.

Example:

User Miller defines a new PIN (e.g. “13jk56"). The minimum
change interval for this user (or group to which this user is
assigned) is set to five days. After two days the user wants to
change the PIN to “13jk56”. The PIN change is rejected
because Mrs. Miller may only define a new password after five
days have passed.

PIN change after max. (days) | If the maximum period of validity is activated, the user has to
define a new PIN after the set period has expired.

Notify of forced change A warning message is displayed “n” days before PIN expiry

before (days) reminding the user to change their PIN in “n” days.
Alternatively, the user may change the PIN immediately.

GENERAL

PIN history length Determines when previously used PINs can be reused.

It makes sense to define the history length in conjunction
with the PIN change after max. (days) setting.

Example:

The PIN history length for user Miller is set to 4, and the
number of days after which the user must change their PIN is
30. Mr. Miller is currently logging on using the PIN
“Informatics”. After the 30 day period expires, he is asked to
change his PIN. Mr. Miller types in “Informatics” as the new
PIN and receives an error message that this PIN has already
been used and he needs to select a new PIN. Mr. Miller
cannot use PIN “Informatics” until after the fourth request to
change the PIN (in other words PIN history length = 4).
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15.5 Creating forbidden password list for use in policies

For policies of the type Password a list of forbidden passwords can be created to define character
sequences which must not be used in passwords.

Note: In the lists, forbidden passwords are separated by line breaks.

The text files containing the required information have to be created prior to registering them in
the SafeGuard Management Center. The maximum files size for text files is 50 KB. SafeGuard
Enterprise only uses Unicode UTF-16 coded texts. If you do not create the text files in this format,
they will be automatically converted upon registration.

In case of a conversion process, a message will be displayed indicating that the file is being
converted.

To register text files, do the following:
1. In the policy navigation area, right-click Information text and select New > Text.
2. Enter a name for the text to be displayed in the Text item name field.

3. Click [...] to select the previously created text file. If the file needs to be converted, a message
will be displayed.

4. Click OK.

The new text item is displayed as a subnode below Information text in the policy navigation area.
If you select a text item, its contents will be displayed in the window on the right-hand side. The
text item can now be selected when creating policies.

Proceed as described to register further text items. All registered text items will be shown as
subnodes.

Note: Using the Modify Text button, you can add new text to existing text. When clicking this
button, a dialog is displayed for selecting another text file. The text contained in this file will be
appended at the end of the existing text.
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15.6 Syntax rules for passwords
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Passwords can contain, numbers, letters and special characters (e.g. + - ; etc.). However, when
issuing a new password, do not use any character with the combination ALT + < character > as
this input mode is not available at Power-on Authentication. Rules for passwords used to log on
to the system are defined in policies of the type Password.

Note: If password rules have been defined in the SafeGuard Enterprise Management Center, no
rules should be defined in Active Directory.

Policy setting Explanation

RULES

Min. password length

Displays how many characters a password must comprise
when changed by the user. The required value can be entered
directly or increased/reduced using the arrow keys.

Max. password length

Displays the maximum number of characters a password
must comprise when changed by the user. The required value
can be entered directly or increased/reduced using the arrow
keys.

Min. number of letters
Min. number of digits

Min. number of special
characters

This setting specifies that a password may not consist
exclusively of letters, numbers or special characters, but must
consist of a combination of at least two (e.g. 15flower etc).
This setting is only practical, if a minimum password length
of greater than 2 has been defined.

Case sensitive

This setting is only effective with Use forbidden password
list and User name as password forbidden.

Case 1: You have entered “board” in the list of forbidden
passwords. If option Case sensitive option is set to YES,
additional password variants such as BOARD, BoaRD will
not be accepted and logon will be denied.

Case 2: “EMaier” is entered as a user name. If option Case
sensitive is set to YES and option User name as password
forbidden is set to NO, user EMaier cannot use any variant
of this user name (e.g. “emaier” or “eMaiER") as a password.

Keyboard row forbidden

Consecutive key sequences include e.g. “123” or “gqwe”.

A maximum of two adjacent characters on the keyboard is
allowed. Consecutive key sequences relate only to the
alphanumerical keyboard area.
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Policy setting Explanation

Keyboard column forbidden | Refers to keys arranged consecutively in columns on the
keyboard such as “yagl”, “xsw2” or “3edc” (but not “yse4”,
“xdr5” or “cft6”!). A maximum of two adjacent symbols in a
single keyboard column is permitted. If you disallow
keyboard columns, combinations like these are rejected as
passwords. Consecutive key sequences relate only to the
alphanumerical keyboard area.

3 or more consecutive Activation of this option disallows key sequences

characters forbidden ) ) ) )
which are consecutive series of ASCII code symbols in

both ascending and descending order (“abc”; “cba”; “;<”

etc.).
which consist of three or more identical symbols (“aaa” or
“111”)'
User name as password Determines whether user name and password may be
forbidden identical.

YES: Windows user name and password must be different.
NO: Users may use their Windows user names as passwords.

Use forbidden password list | Determines whether certain character sequences must not be
used for passwords. The character sequences are stored in the
list of forbidden passwords (e.g. .txt file).
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Policy setting Explanation

List of forbidden passwords Defines character sequences which must not be used for
passwords. If a user uses a forbidden password, an error
message will be displayed.

Important prerequisite:

A list (file) of forbidden passwords must be registered in the
Management Center in the policies navigation area under
Information text. The list is only available after registration.
Maximum file size: 50 KB

Supported format: Unicode

Defining forbidden passwords

In the list, forbidden passwords are separated by a line break.
Wildcard: The wildcard character “*” can represent any
character and any number of characters in a password.
Therefore *123* means that any series of characters
containing 123 will be disallowed as a password.

Note:

If the list contains only a wildcard, the user will no longer
be able to log on to the system after a forced password
change.

Users must not be permitted to access the file.

Option Use forbidden password list must be activated.
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Policy setting Explanation

User password
synchronization to other
SGN Clients

This field determines the procedure of synchronizing
passwords when users, who work on several SafeGuard
Enterprise user PCs and are defined as users on these
computers, change their passwords. The following options
are available:

Slow (wait for user to log on)

If a user changes their password on a SafeGuard
Enterprise endpoint computer and intends to log on to
another computer on which the user is also registered,
they have to log on using their old password at the Power-
on Authentication first. Password synchronization will
only be performed after logging on using the old
password first.

Fast (wait for machine to connect)

If a user changes their password on a SafeGuard
Enterprise endpoint computer, password
synchronization with other computers, on which the user
is also registered, will be performed as soon as the other
computer has established a connection to the server. This
is for example the case, when another user, who is also
registered as a user on the computer, logs on to the
computer in the meantime.

CHANGES

Password change allowed
after min. (days)

Determines the period during which a password may not be
changed. This setting prevents the user from changing a
password too many times within a specific period. If the user
is forced to change to change their password by Windows or
if the user changes their password after a warning message
has been displayed stating that the password will expire in x
days, this setting will not be evaluated!

Example:

User Miller defines a new password (e.g. “13jk56™). The
minimum change interval for this user (or group to which this
user is assigned) is set to five days. After two days the user
wants to change the password to “13jk56”.The password
change is rejected because Mrs. Miller may only define a new
password after five days have passed.

Password expires after (days)

If the maximum period of validity is activated, the user has to
define a new password after the set period has expired.
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Policy setting Explanation

Notify of forced change A warning message is displayed “n” days before password

before (days) expiry reminding the user to change their password in “n”
days. Alternatively, the user may change the password
immediately.

GENERAL

Password history length Determines when previously used passwords can be reused.

It makes sense to define the history length in conjunction
with the Password expires after (days) setting.

Example:

The password history length for user Miller is set to 4, and
the number of days after which the user must change their
password is 30. Mr. Miller is currently logging on using the
password “Informatics”. After the 30 day period expires, he is
asked to change his password. Mr. Miller types in
“Informatics” as the new password and receives an error
message that this password has already been used and he
needs to select a new password. Mr. Miller cannot use
password “Informatics” until after the fourth request to
change the password (in other words password history length
=4).
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15.7 Passphrase for SafeGuard Data Exchange

The user must enter a passphrase for secure data exchange via SafeGuard Data Exchange which
is used to generate local keys. The keys generated on the endpoint computers are also stored in
the SafeGuard Enterprise database. The requirements are defined in policies of the type

Passphrase.

For further details on SafeGuard Data Exchange and SafeGuard Portable refer to the SafeGuard

Enterprise User help.

Policy setting Explanation

RULES

Min. passphrase length

Defines the minimum number of characters for the
passphrase from which the key is generated. The required
value can be entered directly or increased/reduced using the
arrow keys.

Max. passphrase length

Defines the maximum number of characters for the
passphrase. The required value can be entered directly or
increased/reduced using the arrow keys.

Min. number of letters
Min. number of digits

Min. number of special
characters

This setting specifies that a passphrase may not consist
exclusively of letters, numbers or symbols, but must consist
of a combination of that least two (e.g. 15 flower etc). This
setting is only practical if a minimum passphrase length of
greater than 2 has been defined.

Case sensitive

This setting is effective when User name as passphrase
forbidden is active.

Example: “EMaier” is entered as a user name. If the option
Case sensitive is set to YES and User name as passphrase
forbidden is set to NO, user EMaier cannot use any variant
of this user name (e.g. emaier or eMaiER) as a passphrase.

Keyboard row forbidden

Consecutive key sequences include e.g. “123” or “qwe” A
maximum of two adjacent characters on the keyboard is
allowed. Consecutive key sequences relate only to the
alphanumerical keyboard area.

Keyboard column forbidden

Refers to keys arranged consecutively in columns on the
keyboard such as “yagl”, “xsw2” or “3edc” (but not “yse4”,
“xdr5” or “cft6”!). A maximum of two adjacent characters in
a single keyboard column is permitted. If you disallow
keyboard columns, these combinations are rejected for
passphrases. Consecutive key sequences relate only to the
alphanumerical keyboard area.
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Policy setting Explanation

3 or more consecutive Activation of this option disallows key sequences

characters forbidden ) ) ) ]
which are consecutive series of ASCII code symbols in

both ascending and descending order (“abc™; “cha”; “;<”

etc.).
which consist of three or more identical symbols (“aaa” or
“11111)'
User name as passphrase Determines whether the user name and passphrase may be
forbidden identical.

YES: Windows user name and passphrase must be different.

NO: Users may use their Windows user names as
passphrases.
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15.8 Device Protection

The core of SafeGuard Enterprise is the encryption of data on different data storage devices.
Encryption can be volume or file based with different keys and algorithms. Policies of the type
Device Protection also include settings for SafeGuard Data Exchange and SafeGuard Portable.
For further details on SafeGuard Data Exchange and SafeGuard Portable refer to the SafeGuard

Enterprise User help.

Policy setting Explanation

Media encryption mode

Used to protect devices (PCs, Notebooks and PDAs) and all
types of removable media.

The primary objective is to encrypt all data stored on local
or external storage devices. The transparent operating
method enables users to continue to use their usual
applications e.g. Microsoft Office as usual.

Transparent encryption means that all encrypted data
(whether in encrypted directories or volumes) is
automatically decrypted in the main memory as soon as it is
opened in a program. A file is automatically re-encrypted
when it is saved.

The following options are available:
No Encryption

Volumebased (= transparent, sector based encryption)
Ensures that all data is encrypted (incl. boot files,
swapfiles, idle files/hibernation files, temporary files,
directory information etc.) without the user having to
change normal operating procedures or consider
security.

Note:

If an encryption policy exists for a volume or a volume type

and encryption of the volume fails, the user is not allowed to

access it.

Windows 7 System Partition:

Note that for Windows 7 Professional, Enterprise and
Ultimate, a system partition is created on endpoint
computers without a drive letter assigned. This system
partition cannot be encrypted by SafeGuard Enterprise.

Access to Unidentified File System Objects:

Unidentified File System Objects are volumes that cannot be
clearly identified as plain or device-encrypted by SafeGuard
Enterprise. If an encryption policy exists for an Unidentified
File System Object, access to this volume will be denied. If

no encryption policy exists, the user can access the volume.
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Policy setting Explanation

Note: If an encryption policy with Key to be used for
encryption set to an option that enables key selection (e.g.,
Any key in user key ring) exists for an Unidentified File
System Object volume, there is a period of time between the
key selection dialog being displayed and access being
denied. During this time period the volume can be accessed.
As long as the key selection dialog is not confirmed, the
volume is accessible. To avoid this, specify a preselected key
for encryption (see description of policy setting Key to be
used for encryption).

Furthermore, this period of time also occurs for
Unidentified File System Object volumes connected to an
endpoint computer, if the user has already opened files on
the volume when an encryption policy takes effect.

In this case, it cannot be guaranteed that access to the
volume will be denied as this could lead to data loss.

Volumes with enabled Autorun functionality:

If Autorun is enabled for a volume for which an encryption
policy exists, the following problems can occur:

The volume is not encrypted.

If the volume is a UFO, access is not denied.

Access to BitLocker To Go encrypted volumes:

If SafeGuard Enterprise is used with BitLocker To Go
support enabled and a SafeGuard Enterprise encryption
policy exists for a BitLocker To Go encrypted volume, access
to the volume will be denied. If no SafeGuard Enterprise
encryption policy exists, the user can access the volume.

Note: If the Autorun settings for a BitLocker To Go
encrypted USB stick are set to the default values, it can
occur that access will not be denied although a SafeGuard
Enterprise encryption policy exists. This only occurs under
Windows Vista.
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Policy setting Explanation

For further information on BitLocker To Go, see SafeGuard
Enterprise and BitLocker To Go on page 278.

File based (= transparent, file based encryption (Smart
Media Encryption))
Ensures that all data is encrypted (apart from Boot
Medium and directory information) with the benefit
that even optical media such as CD/DVD can be
encrypted or data can be swapped with external
computers on which SafeGuard is not installed
(provided policies permit).
Note: Data encrypted u.sing “File based encryption” cannot
be compressed. Nor can compressed data be file based
encrypted.
Boot volumes will never be file-based encrypted. They will
be automatically exempt from file-based encryption, even if
a corresponding rule is defined.

GENERAL SETTINGS
Algorithm to be used for Sets the encryption algorithm.
encryption List of all usable algorithms with respective standards:

AES256: 32 bytes (256 bits)
AES128: 16 bytes (128 bits)
AES256 with diffuser
AES128 with diffuser
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Policy setting Explanation

Key to be used for encryption | Defines which key is used for encryption. You can define
specific keys (e.g. machine key or a defined key) or you can
allow the user to select a key. You can also restrict the keys
which a user is allowed to use.

The following options are available:

Any key in user key ring

All keys from a user’s key ring are displayed and the user
can select any one of them.

Note: This option has to be selected, if you define a
policy for file based encryption for an unmanaged
endpoint computer protected by SafeGuard Enterprise
(standalone).

Any key in user key ring except user key
All except user keys from a user's key ring are displayed
and the user can select any one of them.

Any group key in user key ring
All group keys from a user's key ring are displayed and
the user can select any one of them.

Defined machine key:

The machine key is used - the user CANNOT select a key
Notice: This option has to be selected, if you define a
policy for volume based encryption for a unmanaged
endpoint computer protected by SafeGuard Enterprise
(standalone mode). If you nevertheless select Any key in
user key ring and the user selects a locally created key for
volume based encryption, access to this volume will be
denied.

Any key in key ring, except locally created keys
All except locally generated keys from a key ring are
displayed and the user can select any one of them.

Defined key on list
The administrator can select any available key when
setting policies in the Management Center.

125



SafeGuard® Enterprise 5.50, Administrator help

Policy setting Explanation

The key has to be selected under Defined key for
encryption.

Notice:

If option Defined machine key is used

If SafeGuard Enterprise Device Encryption is not installed
on a endpoint computer (no POA, no volume based
encryption), a policy defining the Defined machine key as
the key to be used for file based encryption will not become
effective on this computer. The defined machine key is not
available on a computer of this type. The data cannot be
encrypted.

Policies for unmanaged endpoint computers protected by
SafeGuard Enterprise (standalone):

Note that only option Any key in user key ring can be used
when creating policies for unmanaged endpoint computers.
In addition, creating local keys must be allowed for this type
of endpoint computer.

In case the media passphrase feature is activated for
unmanaged endpoint computers, the Media Encryption Key
is automatically used as Defined key for encryption, since
no group keys are available on unmanaged endpoint
computers. Selecting another key under Defined key for
encryption when creating a removable media policy for
unmanaged endpoint computers will have no effect.
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Policy setting Explanation

Defined key for encryption This field becomes only active, if you have selected option
Defined key on list in the Key to be used for encryption
field. Click [...] to display dialog Find Keys. Click Find now,
to search for keys and select a key from the list displayed.

In case a policy of Type Device protection with target:
Removable Media this key is used to encrypt the Media
Encryption Key when the media passphrase functionality is
enabled (User may define a passphrase for a device: Yes)
For Device Protection policies for removable media the
settings

Key to be used for encryption

Defined key for encryption

therefore have to be specified independently from each
other.

Policies for unmanaged endpoint computers protected by
SafeGuard Enterprise (standalone):

In case the media passphrase feature is activated for
unmanaged endpoint computers, the Media Encryption Key
automatically is used as Defined key for encryption
automatically, since no group keys are available on
unmanaged endpoint computers.

User is allowed to create a local | This setting determines whether the user can generate a
key local key on their computer or not.

Local keys are generated on the endpoint computer based
on a passphrase entered by the user. The passphrase
requirements can be set in policies of the type Passphrase.
These keys are also saved in the database. The user can use
them on any computer they are logged on to.

Local keys can be used for secure data exchange via
SafeGuard Data Exchange (SG DX).

VOLUME-BASED SETTINGS

Users may add or remove keys | YES: Endpoint computer users may add/remove keys to/
to or from encrypted volume | from a key ring. The dialog is displayed via the context
menu command Encryption / Encryption tab.

NO: Endpoint computer users may not add additional keys
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Policy setting Explanation

Reaction to unencrypted
volumes

Defines how SafeGuard Enterprise handles unencrypted
media:

The following options are available:
Reject (= text medium is not encrypted)
Accept only blank media and encrypt

Accept all media and encrypt

User may decrypt volume

Allows the user to decrypt the volume via a context menu
command in Windows Explorer.

Fast initial encryption

Select this setting to enable the fast initial encryption mode
for volume-based encryption. This mode reduces the time
needed for initial encryption on endpoint computers.
Note: This mode may lead to a less secure state.

For further information, see Fast initial encryption on page
55.

Proceed on bad sectors

Specifies whether encryption should proceed or be stopped
in case bad sectors are detected. The default setting is YES.

FILE BASED SETTINGS

Initial encryption of all files

Automatically starts initial encryption for a volume after
user logon. The user may need to select a key from the key
ring beforehand.

User may cancel initial
encryption

Enables a user to cancel initial encryption.

User is allowed to access
unencrypted files

Defines whether a user may access unencrypted data on a
volume.

User may decrypt files

Enables a user to decrypt individual files or whole
directories (via the Windows Explorer extension <right-
click>).

User may define a Media
Passphrase for devices

Enables a user to define a media passphrase on his
computer. The media passphrase allows to easily access all
used local keys on computers without SafeGuard Data
Exchange via SafeGuard Portable.
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Policy setting Explanation

Unhandled Applications Allows other applications to be defined which are to be
ignored by the SafeGuard Enterprise filter driver and
thereby excluded from transparent encryption/decryption.
The delimiter to be used for these applications is ;.

One example of an unhandled application is a backup
program. To ensure that data is not decrypted when
creating a backup, this application can be exempted from
encryption/decryption. The data is backed up in encrypted
form.

Note: Since these are machine-specific settings, they are not
applied until the endpoint computer is rebooted.

Defining unhandled applications

Typical use:

Backup programs can be defined as exempted so they will
always be able to read and back up encrypted data.
Applications which might trigger malfunctions when used
alongside SafeGuard Enterprise, but do not require
encryption, can generally be exempted from encryption.
The full name of the executable file (optionally including
path information) is used to specify an exempted
application.

Note: Unhandled applications can only be defined for local
storage devices. For a global policy of the type Device
Protection, target Local Storage Devices must be selected.
For all other targets, option Unhandled Applications is not

available.
Removable media only If this option is switched on, SafeGuard Portable is copied to
Copy SG Portable any removable media connected to the endpoint computer.
to Removable Media SafeGuard Portable enables the exchange of encrypted data

with removable media without the recipient having
SafeGuard Enterprise installed.

The recipient can decrypt and re-encrypt the encrypted files
using SafeGuard Portable and the corresponding
passphrase. The recipient can re-encrypt files with
SafeGuard Portable or use the original key for encryption.
SafeGuard Portable does not have to be installed or copied

to the recipient's computer but can be used directly from
the removable media.
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Policy setting Explanation

Default initial encryption key

This field offers a dialog for selecting a key which is used for
file based initial encryption. If you select a key here, the user
cannot select a key when initial encryption starts. Initial
encryption starts without user interaction.

The key selected will always be used for initial encryption.
Example:

Prerequisite: A default key for initial encryption has been
set.

When the user connects a USB device to the computer,
initial encryption automatically starts. The key defined is
used. The user does not have to interfere.

If the user afterwards wants to re-encrypt files or save new
files on the USB device, he can select any key (if allowed and
available). If the user connects a different USB device, the
key defined for initial encryption will be used again. This
key will also be used for all encryption processes that follow
until the user explicitly selects a different key.

Note: In case the media passphrase feature has been
activated, this option is deactivated. The Defined key for
encryption will be used.

Plaintext folder

The folder specified here will be created on every removable
media. Files that are copied to this folder will always
stay plain.
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15.9 Specific machine settings - basic settings

Policy setting Explanation

POWER-ON AUTHENTICATION (POA)

Enable Power-on Defines whether the POA is permanently switched on or
Authentication off.

Note: For security reasons we strongly recommend to keep
the POA switched on. Deactivating the POA reduces the
system security to Windows logon security and increases
the risk of unauthorized access to encrypted data.

Forbid guest user Defines whether a user is entitled to log on to Windows.
Access denied if no connection | Refuses POA logon if the PC has not been connected to the
to the server (days) (0 = no server for longer than a set period.

check)

Only assigned user may log on | Defines whether a user is entitled to log on to Windows.
YES: Only users recognized in POA can log on.
NO: Users not recognized in POA can log on.

Import of new users allowed Determines whether another user can be added to the POA.
for Differentiates between simply machine owners or any user
present in the POA.

Secure Wake On LAN (WOL) | The “Secure Wake On LAN" policy enables the endpoint
computer to prepare for software rollouts in which the
necessary parameters such as temporary deactivation of
POA and atime interval for Wake On LAN can be imported
directly into and analyzed by the endpoint computer. The
rollout team can design a scheduling script using the
commands provided to guarantee maximum endpoint
computer protection despite deactivated POA.

Please be advised that deactivating the POA - even for a
limited number of boot processes - reduces the level of
security for your system!

EXAMPLE:

The SW rollout team notifies SafeGuard Enterprise SO
about a planned software rollout for the 25th September
2010 between 03:00 and 06:00 am. 2 reboots are required.
The local software rollout agent must be able to log on to
Windows.
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Policy setting Explanation

The SO creates the following policy and assigns it to the
corresponding endpoint computers:

Number of auto logons (0 = no WOL): 5

Windows logon permitted during WOL: Yes

Start of time slot for external WOL Start: 24th Sept. 2010,
12:00

End of time slot for external WOL Start: 25th Sept. 2010,
06:00

The SO provides a buffer of 3 for automatic logons.

The security officer sets the time interval to 12 o'clock
midday on the day before the software rollout to allow the
scheduling script SGMCMDIntn.exe to be started promptly
and WOL starts no later than the 25th September at 3:00
am.

The software rollout team produces two commands for the
scheduling script:

- Starting 24th Sept.2010, 12:15 am, SGMCMDIntn.exe /
WOLstart

- Starting 26th Sept.2010, 09.00 am SGMCMDIntn.exe /
WOLstop

The software rollout script is dated 25.09.2010, 03:00. WOL
can be explicitly deactivated again at the end of the script
using SGMCMDIntn.exe /WOLstop.

All endpoint computers logging in before the 24th of
September 2010 and which connect to the rollout servers
will receive the new policy and the scheduling commands.
Any endpoint computer on which the schedule triggers the
command SGMCMDIntn/WOLstart between 24th Sept.
2010, 12:00 midday and 25th Sept. 2010, 06:00 am falls
within the WOL time interval and therefore Wake On LAN
will be activated.
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Policy setting Explanation

Number of auto logons Defines the number of reboots while Power-on
Authentication is switched off for Wake On LAN.

This setting temporarily overwrites the Enable Power On
Authentication setting until the automatic logons reach the
preset number. Power-on Authentication is then
reactivated.

Example: the number of automatic logons is set to 2;
“Enable Power-on Authentication” is switched on. The PC
boots twice without authentication via POA.

For Wake On LAN, we always recommend allowing three
more reboots than necessary to overcome any unforeseen

problems.
Windows logon allowed Determines whether Windows logon is permitted during
during WOL Wake On LAN, e.g. for a software update. This setting is

interpreted by the POA.

Start of time slot for external Date and time can be either selected or input for the start

WOL start and end of the Wake On LAN (WOL).
End of time slot for external Date format: MM/DD/YYYY Time format: HH:MM
WOL start The following input combinations are possible:

Defined start and end of WOL.
End of WOL is defined, start is open.

No entries: no time interval has been set.

In the event of a planned software rollout, the SO should set
the timeframe for the WOL such that the scheduling script
can be started early enough to allow all endpoint computers
sufficient time for booting.

WOLstart: The starting point for the WOL in the
scheduling script must be within the time interval set in the
policy. If no interval is defined, WOL is not locally activated
on the SafeGuard Enterprise protected endpoint computer.

WOLstop: This command is carried out irrespective of the
final point set for the WOL.

Note: From version 5.20 a WOL setting will only take effect,
if a time interval has been defined. In case of a version
update this also means that WOL policies defined in version
5.10 will at first no longer be effective. After migration the
security officer will have to define a timeframe for these
policies in addition.
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Policy setting Explanation

DISPLAY OPTIONS

Display machine identification

Displays either the computer name or a defined text in the
POA title bar.

If the Windows network settings include the machine name
this is automatically incorporated into the basic settings.

Machine identification text

The text to be displayed in the POA title bar.

If you have selected Defined name in the Display machine
identification field, you can enter the text in this input field.

Display legal notice

Displays a text box with a configurable content which is
displayed prior to authentication in the POA. In some
countries a text box with certain content must be displayed
by law.

The box needs to be confirmed by the user before the
system continues.

Prior to specifying a text, the text has to be registered as a
text item in the policy navigation area under Information
text.

Legal notice text

The text to be displayed as a legal notice.

In this field, you can select a text item registered under
Information text in the policy navigation area.

Display additional information

Displays a text box with a configurable content which
appears after the legal notice (if activated).

You can define whether the additional information is to be
displayed

Never
Every system start

Every logon

Additional information text

The text to be displayed as additional information.

In this field, you can select a text item registered under
Information text in the policy navigation area.

Show for (sec.)

In this field you can define how long (in seconds) additional
information is to be displayed.

You can specify the number of seconds after which the text
box for additional information will be closed automatically.
The user can close the text box any time by clicking OK.
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Policy setting Explanation

Enable and show the system The SafeGuard Enterprise System Tray Icon the user can
tray icon access all user functions quickly and easily on the endpoint
computer. In addition, information about the endpoint
computer status (new policies received, ...) can be displayed
in balloon tool tips.

Yes:

The system tray icon is displayed in the information area of
the taskbar and the user is continually informed via balloon
tool tips about the status of the SafeGuard Enterprise
protected endpoint computer.

No:

The system tray icon is not displayed. No status information
for the user via the balloon tool tips.

Silent:

The system tray icon is displayed in the information area of
the taskbar but there is no status information for the user
via the balloon tool tips.

Show overlay icons in Explorer | Defines whether Windows key symbols will be shown to
indicate the encryption status of volumes, devices, folders

and files.
Virtual Keyboard in POA Defines whether a virtual keyboard can be shown on request
in the POA dialog for entering the password.
INSTALLATION OPTIONS
Uninstallation allowed Determines whether uninstallation of SafeGuard Enterprise

is allowed on the endpoint computers. When
Uninstallation allowed is set to No, SafeGuard Enterprise
cannot be uninstalled, even by somebody having
administrator rights, while this setting is active within a

policy.
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Policy setting Explanation

CRYPTOGRAPHIC BASIC INFRASTRUCTURE FRAMEWORK SETTINGS

Windows cryptographic Possible options:

toolkits ) )
SafeGuard Cryptographic Engine

AET SafeSign TPM Support: Random number generator
hardware; requires a special mainboard in the PC.

TOKEN SUPPORT SETTINGS FOR PKCS #11 MODULE 1

Module name Registers the PKCS#11 Module of a token.
The following options are available:

Siemens CardOS API

AET SafeSign Identity Client
Charismathics Smart Security Interface
Aladdin eToken PKI Client

RSA Authentication Client 2.x
RSA Smart Card Middleware 3.x
Actividentity ActivClient

a.sign Client

Gemalto .NET Card

Gemalto Classic Client

Gemalto Access Client

IT Solution trustWare CSP+

Estonian ID Card

NetKey 3.0
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Policy setting Explanation

License information for Siemens and Charismatics:

Note that the use of the respective middleware for the
standard operating system requires a license agreement with
Siemens Medical/Charismatics. To obtain licenses, please
refer to:

Global Siemens Healthcare Headquarters
Siemens AG

Healthcare Sector

Henkestrasse 127

D-91052 Erlangen

Federal Republic of Germany

Tel.: +49 69 797 6602

http://www.charismathics.com/cryptoshop/
shop_content.php

or

sales@charismathics.com

Services to wait for This setting is used for problem solving with specific tokens.
Our Support team will provide corresponding settings as
required.
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16 SafeGuard Configuration Protection

Enterprise networks are currently characterized by a proliferation of easily accessible computer
ports, such as USB, FireWire and PCMCIA. In addition, a variety of communication adapters
(such as Bluetooth, IrDA, and WLAN) and device types (such as storage devices, printers, digital
cameras, smart phones, and PDAS) all enable effortless access to endpoints using these ports and
devices.

These devices enable optimal accessibility and productivity, but they leave endpoints wide open
to infiltration. With the amount of corporate data residing on endpoints estimated at over 60%,
endpoints may be the most valuable, and vulnerable, part of the enterprise network.

Today, enterprise IT is focusing on the tradeoffs between productivity and security. Enterprises'
need for productivity attracts them to innovative devices and security concepts. But they are
severely challenged to maintain the ultimate precautionary measures against leakage, theft, fraud,
virus invasion, eavesdropping and the general misuse of information and resources.

According to Vista research, 70% of IT security breaches originate from within the enterprise.
Thus, enterprises today are making internal security, especially internal access to network
resources, their highest priority, even above gateway solutions like antivirus and firewalls. Today's
greatest enterprise security challenge is providing access to key information without exposing it
to risk and trusting internal users while retaining enough control over their actions to verify their
reliability.

True protection can only be obtained by establishing a "digital wall" around each computer and
by intelligently protecting its ports, while judiciously allowing access of approved devices.
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16.1 The SafeGuard Configuration Protection solution
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Together with SafeGuard PortAuditor (see the SafeGuard PortAuditor User Guide), SafeGuard
Configuration Protection provides a comprehensive solution which enables organizations to see
what ports and devices are being used in their organization (visibility), to define a policy that
controls their usage and to protect data in motion.

SafeGuard Configuration Protection controls every endpoint and every device, over every
network or interface. It monitors real-time traffic and applies customized, highly-granular
security policies over all physical, wireless and storage device interfaces, including:

1. Physical interfaces:
a) USB
b) FireWire
c) PCMCIA
d) Secure Digital (SD)
e) Parallel
f) Serial
g) Modem
2. Wireless:
a) WLAN
b) Bluetooth
c) InfraRed (IrDA)
3. Storage:
a) Removable Storage Devices
b) External Hard Drives
c) CD/DVD Drives
d) Floppy Drives

e) Tape Drives
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SafeGuard Configuration Protection detects and allows restriction of devices by device type,
model, or even specific device serial number. For storage devices, SafeGuard Configuration
Protection allows a security officer to block all storage devices completely. WLAN controls are
based on MAC address, SSID, or network security level.

16.1.1 Features

1. Port Control - SafeGuard Configuration Protection can intelligently allow, block, or restrict
the usage of any or all computer ports in your organization according to the computer on
which they are located, the user who is logged in and/or the type of port. SafeGuard
Configuration Protection controls: USB, PCMCIA, FireWire, Secure Digital, Serial, Parallel,
Modem (e.g. dialup, 3G etc.), WLAN, IrDA, and Bluetooth ports.

2. Device Control — Highly granular identification and approval of devices, including a
comprehensive list of device types and robust white listing of device models and even distinct
devices (by serial number).

3. Storage Control - Special control over external and internal storage devices including
Removable Media, External Hard Drives, CD/DVD, Floppy and Tape drives. Policy can block
usage of device types, models, and even distinct devices (by serial number).

4. Block Hybrid Network Bridging - SafeGuard Configuration Protection allows security
officers to control and prevent simultaneous use of various networking protocols that can lead
to inadvertent or intentional hybrid network bridging (such as WLAN bridging and 3G card
bridging). Configuring SafeGuard Configuration Protection Clients to block access to WLAN,
Bluetooth, Modemes, or IrDA links while the main wired TCP/IP network interface is
connected to a network enables users to employ the various networking protocols only when
they are disconnected from the network - avoiding the creation and potential abuse of a hybrid
network bridge.

Note: Internal ports such as storage busses such as IDE, SCSI, ATA and S-ATA, which are used
to connect internal hard disk drives as well as PCI and PCI-X are allowed by default.

5. Block USB and PS/2 Hardware Key-Loggers - Blocking USB hardware key loggers which can
tap and record every keystroke in your endpoints as well as render PS/2 hardware key loggers
useless.

6. End User Messages —\Whenever SafeGuard Configuration Protection Client enforces policies
on an endpoint computer, a message is provided to the user in order to notify him or her on
blocked ports or devices.
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16.2 Protection by SafeGuard Configuration Protection

SafeGuard Configuration Protection protects your endpoints as follows:

16.2.1 Port control

SafeGuard Configuration Protection can intelligently allow, block, or restrict the usage of any or
all computer ports in your organization according to the computer on which they are located, the
user who is logged in and/or the type of port. SafeGuard Configuration Protection controls: USB,
PCMCIA, FireWire, Secure Digital, Serial, Parallel, Modem (e.g. dialup, 3G etc.), WLAN, IrDA
and Bluetooth ports.

A blocked port is unavailable, as if its wires were cut. An indication that a port is blocked is given
when the computer boots or when a policy is applied that disables a previously allowed port.

16.2.2 Device control
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In addition to controlling port access, SafeGuard Configuration Protection provides another level
of granularity by enabling you to define which devices can access a port.

For USB, PCMCIA, and FireWire ports you can define which device types, device models and/or
distinct devices can access a port, as follows:

Devices Types: This option enables you to restrict access to a port according to the type of
device that is connected to it. Examples of device types are printing devices, network adapters,
human interface devices (such as a mouse) or imaging devices.

The device types that are available for selection are built into SafeGuard Configuration
Protection.

If you would like to allow a device that is not of one of the types listed here, you can use the
Models or the Distinct Devices option, described below.

Models: This option refers to the model of a specific device type, such as all HP printers or all
M-Systems USB Memory Sticks.

Distinct Devices: This option refers to a list of distinct devices each with their own unique
serial number, meaning each is an actual specific device. For example: the CEO's PDA may be
allowed and all other PDAs may be blocked.
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Protection against Hardware Key Loggers

Hardware Key Loggers are devices that can be placed by a hostile entity between a keyboard and
its host computer in order to tap and record keyboard input and steal vital information, especially
identity and password.

With SafeGuard Configuration Protection you can immunize your users against this threat:
SafeGuard Configuration Protection can detect hardware key loggers connected to a USB or
PS/2 port, and your policy can specify whether hardware key loggers should be blocked when
detected.

16.2.3 Storage control

Storage control provides an additional level of detail in which to specify the security requirements
of your organization. This can apply to all storage devices, internal or external, fixed or
detachable. You can block storage devices completely.

Similarly to non-storage devices, described in the previous section, storage devices can be also
approved according to their type, model, or distinct ID.

Autorun control

With SafeGuard Configuration Protection, you can let your end-users use their new sophisticated
storage devices, while ensuring your endpoints are not exposed to potential exploits and risky
applications these devices may carry. You can easily block auto-launch activities as part of your
security policy. Using our unique granular Client technology, you can still allow smart storage
devices to be used and block only their auto-run functionality which may be unsafe.

16.2.4 WLAN control

WLAN control ensures that users only connect to approved networks. You can specify which
networks or ad hoc links are allowed access. You can specify the MAC address of the access
points, SSID of the network, authentication method and encryption methods to define approved
links.
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16.2.5 SafeGuard PortAuditor

16.3
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Although not an integral part of SafeGuard Configuration Protection, SafeGuard PortAuditor is
a tool that goes hand in hand with SafeGuard Configuration Protection and completes it by
providing you with a full view of what ports, devices and networks are (or were previously) in use
by your organization's users. You use the output of a SafeGuard PortAuditor scan to select the
devices and networks whose usage you want to approve.

{2 SafeGuard PortAuditor

File Settings Report Help

SafeGuard® PortAuditor

— Credentials Audit Results Summary - 1
Current Credentials :  UTIMACCNAdministrator Ehange Tiser. } Repmed Load Report. .
Reportl
Computers to Audit
Specify the computers you want to audit:
" grganizational Unit: Headquarter Browse... £
‘ _—J Total Cormputers 17
- . |
Computer Mame(s): J Accessed Computers il
1P Range: J Successfully Audited 2l
Protected by Safend i}
—Audit Filters
; : USBE Devices 63 3
Detect devices connected through the following ports: PCI/PCMCTA Devices 5 o
¥ usp W Firewire ¥ PCMCIA ¥ PCI [ Internal Storage ¥ WiFi FireWire Devices 0 1]
Mure Eiltore: Internal Storage a 1]
WiFi Metworks il
More... 1 1
| Storage Devices 46 o
e G Communication Adapters = o
Report narme: ‘Reportl
Reports directory: ‘C:\ngram Files\UtirmacoySafeGuard P Browse...
Gathering all information.. This may take several minutes ||
Wirite data to file: C:\Program FilesyUtimacoySafeGuard PortauditorhAudits\R
Checked 0 Computers,
Got information from 0 Computers,

Audit finished successfully

Wiew Report J Export RESLI'tS{

Exit

More detail is provided in the SafeGuard PortAuditor User Guide.

Configuration protection policies

A configuration protection policy specifies which ports are allowed, blocked, or restricted.
Restricted means that only specified device types, device models, distinct devices, or WLAN
connections can gain access through this port.

A policy specifies the access permissions of storage device types, storage device models, and
distinct storage devices, as well as WLAN connections, enabling you to specify whether they are
allowed, blocked, or restricted (in the same manner as for devices).

A policy can also block Hardware Key Loggers that are connected to a USB or a PS/2 port.
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Hardware Key Loggers are devices that can be placed by a hostile entity between a keyboard and
its host computer in order to log keyboard input. Your policy can specify whether hardware key
loggers should be blocked when detected by SafeGuard Configuration Protection.

SafeGuard Configuration Protection takes a positive security approach, meaning all devices are
allowed unless you define a policy blocking their access.

In the sections that follow we describe how to define a policy.

16.3.1 Defining configuration protection policies: workflow

The following is an overview of the workflow for defining a new policy. A reference is provided
from each of these steps to a sub-section that describes it in detail.

The workflow suggests a simple and straightforward order for performing these steps, from
which you can deviate, if you prefer.

Step 1: Scan computers and detect port/device/ WLAN usage: use SafeGuard PortAuditor to
scan the computers in your network in order to detect the devices and WLAN networks that
are currently connected and those that were previously connected (specified in their
computer's registry), as described in the SafeGuard PortAuditor User Guide. You will use this
information when defining a policy in order to easily specify which ports and devices are
allowed, blocked, or restricted.

Step 2: Plan your policy describes the information that you should gather in order to properly
plan the best endpoint protection policy for your organization.

Step 3: Create a policy describes how to create a new policy. You can create as many policies
as needed, one for your entire organization or a different one for each group of computers or
users.

Step 4: Define port control describes how to define the port control aspect of your policy,
meaning which ports are allowed, which are blocked and which are restricted to be used only
by certain devices. In addition, this section describes how to prevent hybrid network bridging.

Step 5: Define device control describes how to define more specifically which devices are
allowed to connect through the restricted ports on your endpoints.

Step 6: Define storage control describes how to define more specifically which storage devices
are allowed to connect to your endpoints.

Step 7: Define WLAN control describes how to define which WLAN connections are
approved.

Step 8: Define file control describes how to define the permissions for file types transferred
from and to storage devices.
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Step 9: Save and publish the policy describes the options for saving the policy in the policy
database and publishing it so it can be associated to the relevant endpoint computers.

16.3.2 Step 1: Scan computers and detect port/device/WLAN usage
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Although not an integral part of SafeGuard Configuration Protection, SafeGuard PortAuditor is
a tool that goes hand in hand with SafeGuard Configuration Protection and completes it by
providing you with a full view of what ports, devices and networks are (or were previously) in use
by your organization's users. You use the output of a SafeGuard PortAuditor scan to select the

devices and networks whose usage you want to approve.
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16.3.3 Step 2: Plan your policy

Before you start defining your policy, you should take the time to plan the policy best suited to
your organization. The best SafeGuard Configuration Protection policy for your organization is
one that meets its security needs while still fulfilling the requirements of the people who need
access through the ports your organization's computers.

The first thing to plan for is the types of OU (Organizational Units) and groups to which the
policies will apply.

User and computer policies

By default, SafeGuard Configuration Protection uses User Group and Computer Group
definitions that are controlled by Active Directory. Each option has its own benefits, as described
below.

Per user groups: Defining your policies per user groups enables you to be specific regarding
the permissions for each user.

Policies that apply to users override policies that apply to computers.

If you decide to manage your organization by assigning policies to user groups, we
recommend that you still define one or more general policies for computers. This enables the
protection of each computer port even when no user is logged in.

Using the combination of user policies and computer policies means that, for example, you
can block USB storage devices on all the Customer Service department's computers, but you
can allow the manager of the department a more permissive policy according to his/her user
name and password, regardless of the computer into which he/she is logged.

Per computer groups: Defining your policies by computers enables the protection of the
endpoints of your organization's computers regardless of the user who is logged in.

SafeGuard Configuration Protection enforces policies as follows: it first applies a user policy, if
one exists for the user that is currently logged in. If not, SafeGuard Configuration Protection
looks for a policy that applies to the computer, and uses it, if found. This means that when no user
is logged in, the computer-bound policy is used. It is therefore advised to distribute user-based
policies, so that a user is given the same policy regardless of the computer into which he or she is
logged, and to set computer based policies that are more restrictive. These computer-based
policies should still grant access to such devices as a mouse and keyboard, to be used when no
user, or a user outside of the domain, is logged in.

The initial configuration of the SafeGuard Configuration Protection Client allows all port and
device activity, meaning that nothing is blocked. A permissive configuration is necessary so that
all port activity is not automatically blocked immediately following the installation of the
SafeGuard Configuration Protection Client.

This means that until you actually define and distribute policies to your endpoints (per user or
per computer), the machine that was just installed with SafeGuard Configuration Protection
Client will continue to operate as before (no blocking of ports and devices).
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Note: The machine policy is used as fallback policy in case the user policy cannot be used or is
being tampered. It is therefore recommended to create both machine and user policy while the
user policy is the more permissive one.

Note: Depending on the endpoint computer, it can take several seconds for the SafeGuard
Configuration Protection Client to enforce a change of policies after logon. This means in case
the machine policy is more restrictive than the user policy it takes a few seconds before the user
gains access to the devices.

16.3.4 Step 3: Create a policy

Policies are created as described for all other policies.

16.3.5 Step 4: Define port control
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This step includes setting port permissions as well as hybrid network bridging permissions.

Port permissions

SafeGuard Configuration Protection enables positive security by allowing access to all portsin all
computers to which a policy is distributed unless that policy specifies that access to that port is
blocked, as follows. For each port (USB, FireWire, PCMCIA, Secure Digital, Serial, Parallel,
Modem, WLAN, IrDA, or Bluetooth), you can specify the following:

Allow: This option specifies that the port can be used for any purpose, without any restrictions
on this communication channel.

Block: This option means that no access can be performed through this port. The port is
unavailable as if its wires were cut.

Restrict: For USB, FireWire, PCMCIA, and WLAN ports you also have the option to specify
that access to ports of this type is Restricted. A Restricted setting enables you to define more
specifically (meaning with higher granularity) which devices or connections are allowed to
access the port. For example, you can specify that only USB devices of a specific model or even
specific USB devices (meaning distinct devices with a unique serial number) are allowed
access. For physical ports, this is done using the Device Control option described in Step 5:
Define Device Control and the Storage Control option described in Step 6: Define Storage
Control. For wireless ports, this is done using the WLAN Control option described in Step 8:
Define WLAN Control.

Note: The Device Control and WLAN Control aspects of a policy only apply to ports that are
restricted.
The Storage Control aspect of a policy applies both to restricted and allowed ports.

For each port, specify whether its action type is Allow, Block, or Restrict by selecting the
appropriate option in the drop-down menu.
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Note: Internal ports such as storage busses such as IDE, SCSI, ATA and S-ATA, which are used
to connect internal hard disk drives as well as PCI and PCI-X are allowed by default.

Note: The settings for SecureDigital in the Physical Ports section are relevant when SecureDigital
is used as a port. In case SecureDigital is connected through a USB adapter, it becomes a USB
mass storage device. If SecureDigital is connected directly to the PC or laptop, recognition
depends on the actual PC or laptop model.

Hybrid Network Bridging permissions

SafeGuard Configuration Protection allows administrators to control and prevent simultaneous
use of various networking protocols that can lead to inadvertent or intentional hybrid network
bridging (such as WLAN bridging and 3G card bridging). Configuring SafeGuard Configuration
Protection Clients to block access to WLAN, Bluetooth, Modems, or IrDA links while the main
wired TCP/IP network interface is connected to a network enables users to employ certain
networking protocols only when they are disconnected from the network - avoiding the creation
and potential abuse of a hybrid network bridge.

Hybrid Network Bridging permissions are set in the Anti Hybrid Network Bridging section.

16.3.6 Step 5: Define device control

In the Port Control section, for USB, FireWire, and PCMCIA ports you can specify that access to
ports of these types is restricted (this is true for WLAN ports, too, which is discussed in Step 8:
Define WLAN Control). Selecting Restrict enables you to define more specifically, using the
Device Control section, which devices are allowed to access these ports.

The Device Control section enables you to specify which device types are allowed access, and to
assign the corresponding White List, which you use to specify which device models or distinct
devices are allowed access. If a device is not defined as allowed in one of the ways described below,
then itis blocked. The Device Control aspect of a policy applies to all the ports that are Restricted.

Device Control - settings

All Devices (top area): in this area you can Allow, Restrict, or Block access to all device types.
If you select Allow or Block for All Devices, the rest of the section is disabled.
You can also Allow or Block hardware key loggers.

Devices Types (middle area): if you have selected the Restrict option for All Devices as
described in the previous paragraph, this option enables you to allow or restrict access to a
device according to its type. For example: Printing Devices, Network Adapters, or Imaging
Devices.
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The device types available for selection are built into SafeGuard Configuration Protection. If
you would like to allow a device that is not of one of the types listed here, add it to your list of
approved devices — the White List - using the Approved Model or the Distinct Devices
option, described below. A description of the supported Device Types is provided in
Supported Device Types.

Unknown Devices (bottom area): This option enables you to determine whether access to
unknown devices is granted or not.

Device Control - White List

The section offers to assign a White List for Device Models and/or a White List for Distinct
Devices:

White List for Device Models: This option refers to the model of a specific device type, such
as a specific model of HP printers, such as LaserJet 4050N. Specify a White List file containing
such devices.

White List for Distinct Devices: This option refers to distinct devices with a unique serial
number, meaning an actual specific device. Specify a White List file containing such devices.
For example: the CEO’s personal printer may be permitted to connect, while other printing
devices are not.

Note: This section is disabled whenever you select Allow or Block in the All Devices option. See
Defining Device Control.

Note: In cases where a device belongs to more than one group, and those groups have the same
permissions, SafeGuard Configuration Protection will choose between the groups arbitrarily.

Defining device control

1. Inthe All Devices section, specify in the drop-down menu whether All Devices are Allowed,
Restricted, or Blocked.

Note: Select Allow or Block when you do not want to apply granular device control at this point
in time. Alternatively, use this option when you wish to override existing granular definitions but
want to return to them at a later time.

2. Ifyou select Allow or Block for All Devices, there is nothing more you need to do in the Device
Control section and you can now skip to Step 6: Define Storage Control.

3. Ifyou selected Restrict for All Devices, define whether Hardware Key Loggers are Allowed or
Blocked.

Note: If the SafeGuard Configuration Protection Client suspects a USB Hardware Key Logger is
connected to the keyboard, and Hardware Key Loggers are Blocked, the keyboard is blocked, too.
To activate the keyboard, advise the user to connect it directly to the computer.
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Note: When you block Hardware Key Loggers, both USB and PS/2 Key Loggers are blocked.
When SafeGuard Configuration Protection Client protects against PS/2 Key Loggers, no user
message is displayed. Nevertheless, the Key Logger device is rendered useless, since the
information it logs is scrambled.

In addition, note that when a PS/2 Key Logger is blocked while working with a PS/2 Keyboard
Video Mouse (KVM), the KVM switching between computers will not work from the keyboard.
You can switch computers by pressing the KVM itself.

4. If you selected Restrict for All Devices, set permissions for each Device Type in the Device
Types section as follows:

a) Allow: allows all devices of this type.

b) Restrict: all devices are blocked unless they are specifically approved in the White List
described in Approving Devices and WLAN Connections.

5. Select the White List for Device Models and White List for Distinct Devices to add to your
allowed devices in the White List as described in White Lists - Approving Devices and WLAN
Connections.

16.3.7 Step 6: Define storage control
Storage devices may typically be the main conduits for information leakage in an organization.

SafeGuard Configuration Protection enables you to control access by allowing full access, or
blocking any device that is identified as a storage device. This includes removable media such as
USB Memory Sticks, digital cameras and so on, as well as traditional devices, such as floppy
drives, CD/ DVD drives, external hard drives, and tape drives.

The Storage Control aspect of a policy is enforced across all ports through which a storage device
can connect. This includes Allowed or Restricted ports, as well as ports that are not protected by
SafeGuard Configuration Protection. On a port that is Blocked all storage devices are blocked,
since blocking a port is similar to cutting its wires.

Note: Since attacks and leakage directly via internal hard drives is not common, SafeGuard
Configuration Protection does not handle blocking or restricting of these drives, so as not to
disrupt ongoing work.
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Storage control - settings

This section includes the following areas:

1. All Storage Devices: in thisareayou can Allow, Restrict, or Block access to all storage devices.
If you select Allow or Block for All Storage Devices, the rest of the section is disabled.
You can also determine whether you want to allow or block the Autorun feature available on
some storage devices such as CD/DVD.

2. Storage Types: if you have selected the Restrict option for All Storage Devices, this option
enables you to allow, or restrict access to a storage device according to its type. For example:
Removable Devices or CD/DVD Drives. The device types available for selection are built into
SafeGuard Configuration Protection and include the following types and options:

a) Removable Media: Applies to all plug-and-play storage devices, such as USB Memory
Sticks, Digital Camera, Portable MP3 players, and so on.

b) Allowsmart functionality of Removable Media: Set this option to Allow to allow the usage
of removable media that implement smart functionality. Set this option to Block to block
the smart functionality of such devices.

¢) External Hard Drives
d) CD/DVD Drives
e) Floppy Devices

f) Tape Devices

Removable Media, External Hard Drives, CD/DVD Drives and Floppy Drives can additionally be
set to Read Only.

Use the White List to approve the usage of specific Storage Models or Distinct Storage Devices.
A description of the supported Device Types is provided in Supported Device Types. For an
explanation of how to define options in this section refer to Defining Storage Control.

Storage Control - White List

The section offers to assign a White List for Storage Device Models and/or a White List for
Distinct Storage Devices:

1. White List for Storage Device Models: This option refers to the model of a specific storage
device type, such as a specific USB Memory Stick model.

2. White List for Distinct Storage Devices: Distinct storage devices with a unique serial
number, meaning an actual specific device. For example: the CEO's personal USB Memory
Stick may be permitted to connect, while other USB Memory Sticks devices are not.
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Note: This section is disabled whenever you select the Allow or Block option for All Storage
Devices.

Note: Select Allow or Block when you do not want to apply granular storage device control at
this point in time, but plan to define it later on. Alternatively, use this option when you wish to
override existing granular definitions but want to return to them at a later time.

16.3.8 Step 7: Define WLAN control

In addition to devices, SafeGuard Configuration Protection controls and monitors your WLAN
connections in order to ensure that endpoint computers use authorized, secure connections only.
In the Port Control section, you can specify that access to a WLAN port is Restricted. Selecting
Restricted enables you to define more specifically, using the WLAN Connection Types section,
which networks are allowed to access this port.

Note: When restricting the use of WLAN as a port, SafeGuard Configuration Protection
monitors and regulates WLAN connections over Microsoft WZC infrastructure. Any device
driver that would try to access the network card, not using WZC will be blocked.

Note: If you are using a lot of WLAN cards which enforce proprietary drivers you can only Allow
or Block WLAN as a port.

WLAN Control - settings

WLAN Connection Types: this option enables you to Allow or Restrict access to WLAN
networks, and to Allow or Block WLAN Peer-to-Peer connections. In the case of WLAN
networks, if you choose Restrict you may further specify which specific networks are approved.

WLAN Control - White List

White List for WLAN: This option refers to distinct networks, including their authentication and
encryption properties.

Note: This section is disabled whenever you select the Allow option for networks.
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Defining WLAN control
To define WLAN control:

1. Gotothe WLAN option in the Wireless Ports section. Set WLAN to Restrict. This enables the
options below WLAN Connection Types.

2. Inthe WLAN Connection Types section set permissions for WLAN Networks (Infrastructure)
as follows:

a) Allow: allows connection to all WLAN networks.

b) Restrict: all networks are blocked unless they are specifically approved in the White List as
described in White Lists - Approving Devices and WLAN Connections.

3. Inthe WLAN Connection Types section set permissions for Peer-to-Peer (Ad Hoc) as follows:
a) Allow: allows all peer-to-peer WLAN connections.

b) Block: blocks all peer-to-peer WLAN connections.

In this option, more granular permissions are not available.

16.3.9 Step 8: Define File Control
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SafeGuard Configuration Protection allows you to set permissions not only for storage devices,
but also for the files transferred to and from these devices. This is achieved by inspecting files for
their type as they are transferred to/from external storage devices. This technology allows for
highly reliable classification of files by inspecting the file header contents rather than using file
extensions, thus preventing users from easily bypassing the protection by renaming file
extensions.

By inspecting both files downloaded to external storage devices and those uploaded to the
protected endpoint, multiple benefits can be achieved:

An additional protection layer to prevent data leakage
Prevention of the introduction of viruses/malware via external storage devices

Prevention of the introduction of inappropriate content via external storage devices, e.g.
unlicensed software, unlicensed content (e.g. music and movies), non work-related content
such as private pictures etc.

With this feature, you can define policies which approve/block specific file types on the inbound
and outbound channels.
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SafeGuard Configuration Protection’s File Control includes the following:
File Type Control - the ability to control transfer of files according to their type.

File Control is applicable to removable storage devices, external hard disks and CD/DVD.

File Control - settings

This section includes the following areas:

1. Storage Type: in this area you can Apply file type control to storage types or Exclude storage
types from file type control.
The storage types available for selection are built into SafeGuard Configuration Protection
and include the following:

a) Reading from removables

b) Writing to removables

¢) Reading from external hard drives
d) Writing to external hard drives

e) Reading from CD/DVD media

2. Ifyou select Apply or Exclude for at least one of the storage types the rest of the section (File
Types) is activated. You can set the following permissions for each file type:

a) Allow
b) Read Only
c) Write Only

d) Block
The permissions for file types apply to all storage types to which you have applied file control
in the Storage Types section.
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The following table lists the file types and extensions supported by SafeGuard Configuration
Protection File Type Control.

File Type Extensions Description

Microsoft Office DOC Microsoft Word Document
DOCX Microsoft Word Document
DOCM Microsoft Word Document
DOT Microsoft Word Template
DOTX Microsoft Word Template
DOTM Microsoft Word Template
RTF Rich Text Format
PPT Microsoft PowerPoint Presentation
PPTX Microsoft PowerPoint Presentation
PPTM Microsoft PowerPoint Presentation
POT Microsoft PowerPoint Template
POTX Microsoft PowerPoint Template
POTM Microsoft PowerPoint Template
PPS Microsoft PowerPoint Show
PPSX Microsoft PowerPoint Show
PPSM Microsoft PowerPoint Show
PPA Microsoft PowerPoint Add-In
PPAM Microsoft PowerPoint Add-In
XLS Microsoft Excel Workbook
XLSX Microsoft Excel Workbook
XLSM Microsoft Excel Workbook
XLSB Microsoft Excel Workbook
XLT Microsoft Excel Template
XLTX Microsoft Excel Template
XLTM Microsoft Excel Template
XLA Microsoft Excel Add-In
XLAM Microsoft Excel Add-In
MPP Microsoft Project Project
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Published
Documents

Web Pages

Images

MPT
VSD
VDX
VSS
VSX
VST
VTX
PUB
ONE
ADP
ADE
PDF

PS

EPS
HTML
HTM
MHT
MHTML
PHP
HLP
CHM
ASP
ASPX
ASMX
JHTML
JSP

JPG
JPEG
GIF
BMP
DIB

Microsoft Project Template
Microsoft Visio Drawing
Microsoft Visio Drawing
Microsoft Visio Stencil
Microsoft Visio Stencil
Microsoft Visio Template
Microsoft Visio Template
Microsoft Publisher
Microsoft OneNote Sections
Microsoft Access Project
Microsoft Access Project Extension

Adobe Acrobat Document

Post Script Document
Encapsulated Post Script
HTML Web Page
HTML Web Page
Archived Web Page
Archived Web Page
PHP Script

Windows Help File
Compiled Help File
Active Server Page
ASP.NET Web Page
ASP.NET Webservices
Java HTML Web Page
Java Server Page

JPEG Image

JPEG Image

GIF Image

Bitmap Image

Device Independent Bitmap Image
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PNG PNG Image

TIF Tagged Image Format

TIFF Tagged Image Format

MDI Office Document Imaging File

ING JNG Image

MNG MNG Image

ICO Windows Icon

CUR Windows Cursor

WMF Windows Metafile Image

EMF Enhanced Windows Metafile Image

FH9 Macromedia Freehand 9 Graphics

JP2 JPEG-2000 Image

PBM Portable Bitmap

PGM Portable Graymap Bitmap

PPM Portable Pixelmap Bitmap

PSD Adobe Photoshop Graphics

CDR CorelIDRAW Vector Graphics

SVG Scalable Vector Graphics
Multimedia WAV Waveform Audio

WMA Windows Media Audio

MP2 MPEG Audio

MP3 MPEG Audio

AIFF Audio Interchange

AlF Audio Interchange

AU AU Audio

RA RealMedia Streaming Media

MID Musical Instrument Digital Sound

MIDI Musical Instrument Digital Sound

RMI Musical Instrument Digital Sound

SDS Musical Instrument Digital Sound Sample

VOC Creative Lab's Soundblaster Audio
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Text & Program
Code

OGG
VOX
FLAC
MPEG
MPG
AVI
ASF
WMV
MOV
SWF
FLI
FLC
TXT

CSV

PRN

CPP

C

H

XML

F

T90
MAKEFILE
MAKEFILE.IN
PL1

ASM

PAS

JAVA

M4

BCPL

CS

PL

Ogg Vorbis Codec Audio
Dialogic Audio

Free Loseless Codec Audio
MPEG Multimedia

MPEG Multimedia

Audio Video Interleave
Advanced Streaming Format
Windows Media Multimedia
QuickTime Video Clip

Flash Animation File

FLIC Animation

FLIC Animation

Text File

Formatted Text (Comma Delimited)

Formatted Text (Space Delimited)

C++ Program Code
C/C++ Program Code
C/Java Header File

XML File

FORTRAN Program Code
FORTRAN Program Code
Compilation Control File
Compilation Control File
PL1 Program Code
Assembler Program Code
PASCAL Program Code
JAVA Program Code
Meta4 Program Code
BCPL Program Code
Visual C#NET Program Code

Perl Program Code
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PM Perl Program Code Module
PY Python Program Code
PDB Visual C++/.NET Program Database
BAS BASIC Program Code
VB Visual Basic Program Code
VBS VBScript Script
JS JavaScript Source Code
Executables EXE Executable
DLL Dynamic Link Library
PIF Windows Program Information File
BAT Batch
COM Command
OCX ActiveX - Object Linking and Embedding (OLE)
Control Extension
CMD Command
CPL Windows Control Panel Extension
SCR Windows Screen Saver
VXD Virtual Device Driver
SYS System Device Driver
CLASS Java Bytecode
PYC Python Compiler Script (Bytecode)
LIB Program Library Common Obiject File Format
(COFF)
INS InstallShield Script
OBJ Object File
0] Object File
Compressed ZIP ZIP Compressed Archive
Archives
ARJ ARJ Compressed Archive
RAR WIiInRAR Compressed Archive
GZIP GZIP Compressed Archive
TAR Tape Archive
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CD/DVD Disc
Images

Databases

Microsoft Outlook

JAR
ACE
HQX
LZH
LHA
AR
ARC
CAB

**

I1SO

BIN
CIF
CCD
IMG
MDF
DAA
C2D
MDB
ACCDB
ACCDT
MDA
MDW
MDE
MYD
MYI
FRM
DBF
DBT
GDB
PX
PST

JAR Compressed Archive

WinAce Compressed Archive

Macintosh BinHex 4 Compressed Archive
LHA Compressed Archive

LHA Compressed Archive

AlIX Small Indexed Archive

LH ARC Compressed Archive

Cabinet Compressed Archive

Compressed Installation Files (e.g. EX_, DL )
ISO Disc Image

BIN Disc Image

EasyCD Creator Disc Image
CloneCD Disc Image

CloneCD Disc Image

Alcohol 120% Disc Image

PowerISO Disc Image

WinOnCD Disc Image

Microsoft Access Database

Microsoft Access Database

Microsoft Access Database Template
Microsoft Access Add-In

Microsoft Access Workgroup
Microsoft Access Compiled Database
MySQL MyISAM Database

MySQL MyISAM Database Index
MySQL MyISAM Generic Dictionary
dBase Database

Microsoft FoxPro Database

Borland InterBase Database

Paradox Database

Outlook Personal Folder

160



SafeGuard® Enterprise 5.50, Administrator help

DBX Outlook Express E-mail Folder
PGP Encryption PGP Pretty Good Privacy (PGP) Encrypted
ASC Pretty Good Privacy (PGP) Armored Encrypted
CTX Pretty Good Privacy (PGP) Ciphertext
Computer-Aided DWG AutoCAD Drawing
Design (CAD)
DXF AutoCAD Interchange
ASM Pro/ENGINEER Assembly
PRT Pro/ENGINEER Model
Adobe FrameMaker DOC Adobe FrameMaker/FrameBuilder Document
FM Adobe FrameMaker Document
FRM Adobe FrameMaker Document
BOOK Adobe FrameMaker Book
MIF Adobe FrameMaker Interchange Format

16.3.10 Step 9: Save and publish the policy

Policies are saved and published as described for all other policies.
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16.4 White Lists - approving devices and WLAN connections

The explanations in the following sections refer to adding approved devices to the Device Control
White List and adding approved storage devices to the Storage Control White List. Where
differences exist between adding storage and non-storage devices, they are pointed out and
explained.

Explanations on how to add approved WLAN networks can be found in Adding WLAN
Connections.

SafeGuard Configuration Protection provides you with three levels of permissions:

Devices Types and Storage Types: This option enables you to allow or restrict access to an
endpoint according to the type of device that is connected. For example: Removable Media,
Network Adapters, Human Interface devices (such as a mouse), or Imaging Devices. The
device types and storage types available for selection are built into SafeGuard Configuration
Protection and are found in the Device Control section and the Storage Control section.

A device type may be allowed (default), blocked, or restricted. If you restrict a device type,
all devices of this type are blocked unless specifically approved in a White List.

White List for Device Models: This option refers to approving models of devices or storage
devices, such as all HP printers or all M-Systems USB Memory Sticks.

White List for Distinct Devices: This option refers to approving distinct devices or storage
devices, each with its own unique serial number, meaning each is an actual specific device.
For example, if you wish to approve the use of the CEO’s USB Memory Stick and block all
other USB Memory Stick devices, you should set the Removable Media storage type to
Restrict, and then enter the identifying parameters of the CEO's USB Memory Stick in a
White List for specific Distinct Storage Devices.

This section describes how to
create a White List and

how to add approved models or distinct devices to a White List either from the list of devices
whose usage was detected in your organization by SafeGuard PortAuditor, or manually.
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16.4.1 Creating White Lists
To register a White List, proceed as follows:
1. Select White List in the policy navigation area.
2. In the context menu of White List, click New > White List.
3. Infield White List name enter a name for the White List.
4. Selecting the White List type
White Lists can be created for:
Device Models
Distinct Devices
Storage Device Models

Distinct Storage Devices
WLAN Networks

The individual White Lists can be selected when defining policy settings.

5. Specify whether you want to create the White List manually or whether you intend to use the
result of a scan of the computers by SafeGuard PortAuditor as a source.

Note: The results of the SafeGuard PortAuditor scan have to be available (XML file), if you intend
to create the White List based on this source.

a) Create White List manually
If you select this option, an empty White List will be opened in the SafeGuard Management
Center after clicking OK. In this empty White List you can create entries manually.

b) Import from SafeGuard Port Auditor Result
If you select this option, the result of the scan by SafeGuard PortAuditor will be imported.

You can select the file provided by SafeGuard PortAuditor via the [...] button.

After clicking OK the contents of the imported file will be displayed in the SafeGuard
Management Center.
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16.4.2 Adding a device using a SafeGuard PortAuditor file
Prerequisite: Creating a device information file

In order to create a file that contains the information about the devices you wish to approve, use
SafeGuard PortAuditor to scan the required computers. SafeGuard PortAuditor scans the
selected computers and reports on all devices and WLAN networks currently or previously
connected to those computers. The audit results are stored in an . XML file. To learn about
SafeGuard PortAuditor refer to SafeGuard PortAuditor 3.2 User Guide.

16.4.2.1 Step 1: Get device information

In this step you specify the file from which to gather the information about devices that will be
added, i.e. the location of the SafeGuard PortAuditor . XML file that contains the required device
information. After you have selected the required file using [...], click OK to continue.

16.4.2.2 Step 2: Select devices

Step 2 displays a table of the devices detected on the endpoints in your network and enables you
to select the ones to add. The table is divided into categories, depending on whether the White
List to which you are adding devices is a Device Models White List or a Distinct Devices White
List, and whether you are adding storage devices or non-storage devices.

Selectable devices have a check box beside them which you should check if you want to approve
the device model or the distinct device, as the case may be. You can also select or deselect all or
marked devices when you right-click in the table.

Note: You cannot add storage devices to the Device Control White List.

Note: You cannot add devices or storage devices without a distinct ID to a Distinct Devices
White List.

Occasionally, a device may not be identified as a storage device by SafeGuard PortAuditor. This
may happen, for example, when a device class has not been embedded by the manufacturer. In
this case, if you know that it is in fact storage, you may add it to your policy's storage white list.

You must avoid adding storage devices to a Device Control White List or adding non-storage
devices to a Storage Control White List, as they will be ignored by the SafeGuard Configuration
Protection Client.

Note: When you add a device that already belongs to another device White List in this policy, and
the White List permissions differ, the most permissive will apply.
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16.4.2.3 Step 3: Save White List

Save the White List by clicking the icon in the SafeGuard Enterprise toolbar.

Using the Modify contents button you can insert the contents from another file into the White
List.
New entries will be appended at the end of the White List.

16.4.3 Adding a device manually
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If you have created an empty White List, you have to add the entries manually.

Or if you want to add devices to an existing White List, as in the case of devices that have not been
connected to any endpoint in your organization and therefore do not appear in the SafeGuard
PortAuditor audit results, you also have to add them manually.

The following instructions apply both when adding storage devices (in Storage Control) and when
adding non-storage devices (in Device Control).

Note: When you add a device that already belongs to another device White List in this policy, and
the White List permissions differ, the most permissive will apply.

To add a device manually:
1. Click the 5 icon in the SafeGuard Enterprise toolbar to add a new entry to the White List.
2. Enter the required information in the following fields:

a) Port— optional

b) Device Description — optional

c) Device Information — optional

d) Vendor (Vendor ID) — optional

e) Product (Product ID) — optional

f) Hardware ID/Instance ID — required

Double-check that you have entered the correct data in all fields and save the White List.

Selecting an entry and clicking the ﬁ icon in the SafeGuard Enterprise toolbar removes the entry
from the White List.

Note: Vendor ID (VID), Product ID (PID), Hardware ID (HID) and Instance ID (11D) can be
found in the SafeGuard PortAuditor scan results, on a sticker attached to the product itself or in
Windows Device Manager.



SafeGuard® Enterprise 5.50, Administrator help

16.4.4 Adding WLAN connections

WLAN links are added to the WLAN Network White List in much the same way this is done in
the case of devices; add a WLAN White list, then add approved links to this White List using the
data from the SafeGuard Port Auditor file, or manually.

16.4.4.1 Adding a WLAN link manually

If you want to add WLAN links that were not detected by SafeGuard PortAuditor, and as a result
cannot be added using the import mechanism, you can do so manually.

Entering WLAN Network Information

Now you define the parameters a network must match in order for it to be approved for
connection.

You can identify a network by its name and/or by its MAC address. After you enter a network
name or a MAC address, you can also specify authentication and data encryption parameters
which must be matched. Only networks matching all the parameters are approved.

To add a WLAN link manually:
1. Open the White List for WLAN connections.
2. Click the % icon in the SafeGuard Enterprise tool bar to add a new entry to the White List.

3. Enter Network Name, MAC Address or both. It is required to add information to at least one
of the two fields.

4. If you want to specify the Network Name only, enter the name and continue with step 6.
5. If you want to specify the MAC Address only, enter the address and continue with step 6.

6. Todefine security settings, specify the required Authentication and Data Encryption settings
from the dropdown list. Adding information to these fields is optional.

Note: The Data Encryption options available in the dropdown list depend on the selected
Authentication type. For example, for WPA authentication, the encryption options are TKIP or
AES, whereas in the case of 802.1X authentication only WEP encryption is available for selection.

7. Double-check that you have entered the correct data in all the fields and save the White List.

166



SafeGuard® Enterprise 5.50, Administrator help

16.5 Supported device types

This chapter lists the device types that SafeGuard Configuration Protection provides for your
selection when building a policy.

For non-storage devices you can restrict the usage of devices on USB, FireWire, and PCMCIA
ports. SafeGuard Configuration Protection provides a selection of built-in types in the Device
Control window to enable you to define which types of devices are approved or blocked. If you
require control of a device type that is not listed here, you can use the Distinct Device restriction
feature described in White Lists -Approving Devices and WLAN Connections.

For storage devices, SafeGuard PortAuditor is able in most cases to identify whether a device is
astorage device or anon-storage device, by detecting its volume, or using its embedded class data.
This ability helps categorize and organize device lists into storage devices and simple (non-
storage) devices for your selection, thus enabling you to define your policy more easily. SafeGuard
Configuration Protection provides a selection of built-in types in the Storage Control window to
enable you to define which types of devices will be approved or blocked.

The following device type lists are divided into non-Storage devices and storage devices.

16.5.1 Non-storage device types
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The following lists the non-storage built-in device types for which a policy can be defined in
SafeGuard Configuration Protection.

Note: Device Control for non-storage devices can only be defined for USB, FireWire, and
PCMCIA ports.

1. Human Interface Device — devices used to control the operation of computer systems.
Typical examples include keyboards and pointing devices, such as: mouse, trackballs, and
joysticks.

2. Printing Devices — Printers connected over USB, PCMCIA, or FireWire.

3. Personal Data Assistants (PDAs) - These include:
a) Windows Mobile / Pocket PC Devices
b) Blackberry Devices

c) Palm OS Devices

4. Mobile Phones — New models of cellular phones, categorized in USB as 'Wireless USB
Devices'.

5. Network Adapters - Communication devices such as: Ethernet network adapters, WLAN
adapters, and USB-connected ADSL and cable modems.
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6. Imaging Devices - Primarily devices such as scanners and digital still cameras.

7. Audio/Video Devices - devices such as: microphones, telephones, volume controls, web
cameras, digital camcorders, digital television tuners and digital still-image cameras that
support video streaming.

8. Smartcards - smartcard devices.

9. Content Security Devices - used to provide special security features, such as strong
authentication, biometric identification and software licensing.

16.5.2 Storage device types

Protection of storage devices applies to all non-blocked ports, meaning that it applies to the
specified storage device no matter to which port it is connected as long as that port is not defined
as blocked.

Note: Device Control for storage devices can be defined for any port type including, for example,
parallel ports, USB, FireWire, and PCMCIA ports.

The following lists the storage built-in device types that are supported by SafeGuard
Configuration Protection.

Removable Media — These devices range from storage-only devices, such as USB Memory
Sticks and SD flash cards, to devices that have a unique purpose, but appear to the computer
as a new storage drive, such as portable digital music players, digital cameras and PDA:s.

External Hard Drives — hard disk devices which are externally attached (e.g. via USB).
CD/DVD Drives — both internally and externally attached.
Floppy Devices — both internally and externally attached.

Tape Devices — both internally and externally attached.
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17 User-computer assignment

SafeGuard Enterprise manages the information about which users are allowed to log on to a
particular machine in a list which is referred to below as the UMA (User-Machine-Assignment).

For a user to be included in the UMA, they must have logged on once to a computer on which
SafeGuard Enterprise has been installed and be registered in the SafeGuard Management Center
as a “full” user in terms of SafeGuard Enterprise. A “full” user is one for whom a certificate has
been generated after the first logon and for whom a key ring has been created. Only then can this
user data be replicated on other computers. After replication, the user can log on to this computer
at the POA.

In the standard setting, the first user to log on to the computer after the installation of SafeGuard
Enterprise is entered in the UMA as the owner of that computer.

This attribute allows the user, having authenticated themselves at Power-on Authentication, to
enable other users to log on to that computer (see Importing further users on page 181). They will
also be added to the UMA for this computer.

An automatic list is thereby generated which determines which user is allowed to log on to which
computer. This list can be edited in the SafeGuard Management Center.

17.1 User-computer assignment in the SafeGuard Management Center
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Users can be allocated to specific computers in the SafeGuard Management Center. If a user is
assigned to a computer in the SafeGuard Management Center (or vice versa) this allocation is
incorporated into the UMA. The user data (certificate, key, etc.) is replicated on this computer
and the user can log on to this computer.

When setting this assignment, the administrator can also specify who can allow other users to log
on to this computer.

Under Type the Management Center indicates how the user was added to the SafeGuard
Enterprise database. Adopted means that the user has been added to the UMA on a endpoint
computer.

Note: If no one is assigned in the Management Center and no user is specified as the owner, the
first user to log on after the installation of SafeGuard Enterprise on the computer is entered as the
owner. This user can then allow further users to log on to this computer, see Importing further
users on page 181.

If users are assigned to this computer in the Management Center at a later date, they can then log
on at the Power-on Authentication. Nevertheless such users must be full users (with existing
certificate and key). The owner of the computer does not need to assign access entitlements in this
case.
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The following settings are used to specify who is allowed to add users to the UMA:
Ownership: If this setting is activated, the user can be registered as the owner of a computer.

User is Owner: This setting means that this user is entered in the UMA as the owner. No
further users can be included in UMA. Only one user per computer can be entered in the
UMA as the owner.

The Import of new users allowed for policy setting in policies of the type Specific Machine
Settings determines who is allowed to add further users to the UMA.

Import of new users allowed for

Nobody
Even the user entered as the owner cannot add more users to the UMA. The option for an
owner to add further users is switched off.

Owner (default setting)
Users can only be added to the UMA by the owner.

Note: A Security Officer may always add users in the SafeGuard Management Center.

Everybody
Lifts the restriction that users may only be added by the owner.
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Example:

The following example shows how you can assign logon entitlements in SafeGuard
Management Center to just three users (User_a, User_b, User_c) for Computer_ABC.

First: Specify the response you require in SafeGuard Enterprise Management Center.
SafeGuard Enterprise is installed on all endpoint computers during the night. In the
morning, the users are to log on to the computer according to their logon details.

1. In SafeGuard Management Center, assign User_a, User_b and User_c to
Computer_ABC. (Users & Computers -> Select computer_ABC -> Assign
user via Drag&Drop). You have thereby specified a UMA.

2. In acomputer policy select the setting Import of new users allowed for to
Nobody. Since User_a, User_b and User_c are not allowed to add new users is
not necessary to specify a user as an owner.

3. Assign the policy to the computer and/or to a point within the directory
structure at which it will be active for the computer.

When the first user logs on to Computer_ABC (see Logging on on page 179), an autologon is
implemented for the POA. The computer policies are sent to the endpoint computer. Since
User_a is included in the UMA and will become a full user when logging on to Windows.
The user's policies, certificates and keys are sent to the endpoint computer. The POA is
activated.

Note: The user can check the status message in the SafeGuard System Tray Icon (balloon
tool tip) when this process has completed.

User_a is now a full user in terms of SafeGuard Enterprise and after the first logon can
authenticate him or herself at the POA and is automatically logged on.

User_a now leaves the computer and User_b wants to log on. As the POA is activated, there
is no more autologon.

User_b and User_c have two options for gaining access to this computer.

a) User_a deactivates the Passthrough Logon to Windows option in the POA
logon dialog and logs on.

b) User_b uses Challenge/Response to log on at the POA.
In both cases, the Windows logon dialog is displayed.
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User_b can enter his or her Windows credentials. The user's policies, certificates and keys
are sent to the endpoint computer. The user is activated in the POA. User_b is now a full
user in terms of SafeGuard Enterprise and after the first logon can authenticate themselves
at the POA and will be automatically logged on.

While the computer policy specifies that no one can import users to this computer, since
these users are already in the UMA, User_b and User_c nevertheless gain “full” user status
at the Windows logon and are activated in the POA.

No other users will be added to the UMA or will ever therefore be able to authenticate
themselves at the Power-on Authentication. Any users logging on to Windows who are not
User_a, User_b or User_c are excluded from the UMA in this scenario and will never be
active in the POA.

Users can always be added later on in the SafeGuard Management Center. However, their
key ring will not be available after the first logon as synchronisation will only be triggered by
this first logon. After logging on again, the key ring will be available and the users can access
their computers according to the policies applying. If they have never successfully logged on
to an endpoint computer, they can be added as described above.

Block User

If you activate the check box in the Block User column the user is no longer allowed to log on to
the relevant computer. Furthermore, the computer will be automatically shut down, if the
relevant user is logged on as soon as the policy with this setting becomes active on the computer.

17.1.1 Groups

Computer groups can also be assigned to a user (account) and/or user groups can be assigned to
a computer in the SafeGuard Management Center.

Example: Service account

Therefore it is for instance possible to use a single service account to service a large number
of computers. For this purpose the computers concerned must be in a single group. This
group is then assigned to a service account (user). The owner of the service account can
then log on to all computers within this group

Also, by assigning a group containing different users, these users can then log on to a specific
computer in a single step.

172



SafeGuard® Enterprise 5.50, Administrator help

17.2 Assignment of user and computer groups

To assign a user to a group of computers, proceed as follows:

Note: You can assign individual users to a computer or vice versa using the same process as for
groups.

1. Click Users & Computers.
2. Toassign a group of computers to single user, select the user.

3. Click the Computer tab in the action area.

All computers and computer groups are displayed under Available computers.
4. Drag the selected groups from the list of available groups into the action area.

5. You will see a dialog asking whether the user should be the owner of all computers.

If there is no specified owner in SafeGuard Enterprise Management, the first user to log on to
this computer is automatically entered as the owner. The user is the entitled to allow other
users to access this computer. The condition is that the user “Can be owner”.

Answering Yes to this question means that the first user to log on to this computer becomes
the owner and can allow access to other users.

Answering No to this question means that the user will not be the owner of this computer.

It is not generally necessary for a service account owner to be the owner of the computer. This
setting can be changed after initial assignment.

6. After answering the question, all computers from the assigned group are displayed in the
action area.

The user can log on to all computers assigned in this way.

A user group can be assigned to a single computer using the same process.
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18 Tokens and smartcards

Tokens and smartcards are hardware components that help an authorized user with the
authentication process on a computer system. They can be used to store certificates, digital
signatures and biometric details. Data cannot be manipulated.

Nowadays, authentication using a user name and password often no longer meets the customer's
need to have the best possible protection against external access. So, as an alternative and to
improve security, SafeGuard Enterprise provides logon using tokens and smartcards. Token
logon is based on the principle of a two-stage authentication: A user has a token (ownership), but
can only use the token, if they know the specific token password (knowledge). When a token or
smartcard is used, users only need the token and a PIN for authentication.

Note: From SafeGuard Enterprise's perspective, smartcards and tokens are treated in the same
way. So the terms “token” and “smartcard” can be understood as the same thing in the product
and in the manual.

Tokens are supported:
in the Power-on Authentication
at operating system level
to log on to the Management Center

When a token is issued to a user, data such as the manufacturer, type, serial number, logon data
and certificates are stored in the SafeGuard Enterprise database. In such cases, tokens are
identified by the serial number and then recognized in SafeGuard Enterprise.

This gives important benefits:
It is evident which tokens are in circulation and which users they are assigned to.
It is evident when they were issued.

If a token is lost, the Security Officer can identify it and block it for authentication. This
prevents the misuse of data.

However, the Security Officer can use Challenge/Response to temporarily allow logon without a
token, e.g. if a user has forgotten their PIN.
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18.1 Smartcards

To be able to use a smartcard with SafeGuard Enterprise, a card reader and a card driver for the
PC are both required as well as the smartcard. Also, for the smartcards and card readers to
communicate with SafeGuard Enterprise certain middleware, in the form of a PKCS#11 module,
is required.

18.1.1 Smartcards and smartcard readers/drivers
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SafeGuard Enterprise supports non-cryptographic and cryptographic logon procedures with
Power-on Authentication. With non-cryptographic smartcards, user 1D and password are stored
on the card. Cryptographic smartcards are used to authenticate RSA key pairs (certificates).

Windows

On the Windows operating system level, PC/SC-compatible card readers are supported. The
PC/SC interface regulates the communication between the PC and smartcard. Many of these
card readers are already a part of the Windows installation.

Smartcards require PKCS#11 compatible smartcard drivers if they are to be supported by
SafeGuard Enterprise.

Power-on Authentication

Refer to the Release Notes for a detailed list of all the supported smartcards, smartcard readers
and smartcard drivers.

With Power-on Authentication, the PC/SC interface is supported which regulates the
communication between PC and smartcard. The supported smartcard drivers are a fixed
implementation and users may not add other drivers. The appropriate smartcard drivers have
to be enabled by means of a policy in SafeGuard Enterprise.

The interface for smartcard readers is standardized and many card readers have a USB
interface or an ExpressCard/54 interface and implement the CCID standard. In SafeGuard
Enterprise this is a prerequisite to be supported with Power-on Authentication. Plus, on the
driver side, the PKCS#11 module has to be supported.
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18.1.2 Supported smartcards with Power-on Authentication

SafeGuard Enterprise supports a large number of smartcards and smartcard readers, plus
common smartcard drivers with Power-on Authentication. With SafeGuard Enterprise, tokens/
smartcards which support 2.048-bit RSA operations are supported. As support for smartcards is
enhanced from release to release, the tokens and smartcards supported in whatever is the current
version of SafeGuard Enterprise are listed in the Release Notes.

18.1.3 Supported middleware

The middleware in the list below is supported via the relevant PKCS#11 module. PKCS#11 is a
standardized interface for connecting cryptographic tokens/smartcards to different software.
Here, it is used for the communication between cryptographic token/smartcard, the smartcard
reader and SafeGuard Enterprise.

Manufacturer Middleware

Activldentity ActivClient

Aladdin eToken PKI Client

AET SafeSign Identity Client

Charismatics Smart Security Interface

RSA RSA Authentication Client 2.x
RSA Smart Card Middleware 3.x

Siemens CardOS API

A-Trust a.sign Client

Gemalto Gemalto .NET Card
Gemalto Classic Client
Gemalto Access Client

IT Solution GmbH IT Solution trustWare CSP+

Sertifitseerimiskeskus AS Estonian 1D Card

T-Systems NetKey 3.0

176



SafeGuard® Enterprise 5.50, Administrator help

License information for Siemens and Charismatics:

Note that the use of the respective middleware for the standard operating system requires a
license agreement with Siemens Medical/Charismatics. To obtain licenses, please contact:

Global Siemens Healthcare Headquarters
Siemens AG

Healthcare Sector

Henkestrasse 127

D-91052 Erlangen

Federal Republic of Germany

Tel.: +49 69 797 6602

http://www.charismathics.com/cryptoshop/shop_content.php
or
sales@charismathics.com

The middleware is set using a policy in SafeGuard Enterprise. The SafeGuard Enterprise Client
configuration package must also be installed on the PC on which the Management Center is
running.

18.2 USB tokens

Like smartcards, USB tokens consist of a smartcard reader and a smartcard, both units being
located in a single casing.

18.2.1 Supported USB tokens with Power-on Authentication

SafeGuard Enterprise supports a wide range of USB tokens. As a prerequisite, the smartcard used
must be supported by the Power-on Authentication of SafeGuard Enterprise and the respective
drivers must be supported as well. The USB tokens also have to be supported by the relevant
middleware.

As support for tokens is enhanced from release to release, the tokens and smartcards supported
in the respective version of SafeGuard Enterprise are listed in the Release Notes.
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18.3 Working with tokens

Proceed as follows in order to be able to use tokens for authentication:
1. Initialize empty tokens

2. lIssue tokens for users and security officers

3. Write certificates and keys on tokens

4. Define policies for tokens

You can also use tokens that have data from a different application for authentication providing
that there is enough storage space for the certificates and logon information on them.

SafeGuard Enterprise provides you with the following features so that you can easily administer
tokens:

Display and filter token information
Initialize, change, reset and block PINs
Read and delete token data

Block token

178



SafeGuard® Enterprise 5.50, Administrator help

18.4 Initializing a token

Before an “empty”, unformatted token can be issued to a user in SafeGuard Enterprise, it needs
to be prepared for use - i.e. initialized - according to the instructions provided by the token
manufacturer. When it is initialized, basic information e.g. the standard PIN, is written to it. The
token manufacturer's initialization software is used to do this.

Please refer to the token manufacturer concerned for more information.

18.4.1 Installing middleware on the endpoint computer

Next install the correct middleware, both on the PC which the SafeGuard Management Center is
running on and the relevant user PC, see Supported middleware on page 176.

18.4.2 Activating middleware (PKCS#11 module)
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Before issuing the token you need to assign the correct middleware in form of the PKCS#11
module by defining a policy in the SafeGuard Management Center. You should do this both for
the computer which the SafeGuard Management Center is running on and for the user PC. Only
then can SafeGuard Enterprise communicate with the token. You can define the setting for
PKCS#11 module, using a policy, as follows.

Prerequisite: the middleware is installed on the relevant PC and the token has been initialized.
The SafeGuard Enterprise Client configuration package must also be installed on the PC which
the Management Center is running.

In the SafeGuard Management Center, click Policies.
1. Plug the token into the USB interface. SafeGuard Enterprise reads in the token.

2. Create a new policy of the type Specific Machine Settings or select an existing policy of this
type.

3. Inthe work area on the right-hand side, under Token support settings > Module Name,
select the appropriate middleware. Save the settings.

4. Assign the policy.

SafeGuard Enterprise can now communicate with the token and administer the token. The token
can now be issued.
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18.5 Issuing a token

When a token is issued in SafeGuard Enterprise, data is written on the token which is then used
for authentication. This data consists of credentials and certificates.

In SafeGuard Enterprise, tokens can be issued for these user roles:
Tokens for normal users
Tokens for Security Officers (SO)

Both user and Security Officer (SO) can access the token. The user is the person who should use
the token. Only the user can access private objects and keys. The SO can only access public
objects, but can reset the user's PIN.

18.5.1 Issuing a token or smartcard to a user
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Prerequisite: The token must be initialized and the relevant PKCS#11 module must be activated.
The SafeGuard Enterprise Client configuration package must also be installed on the PC which
the Management Center is running.

Open the Management Center and click Users & Computers.

1.

2.

Connect the token to the USB interface. SafeGuard Enterprise reads in the token.

Mark the user for whom a token is to be issued, and open the Token Data tab in the work area
on the right-hand side.

In the Token Data dialog, proceed as follows:
a) Select the user ID and domain of the user selected and enter your Windows password.

b) Click Issue Token.
In dialog Issue Token select the appropriate slot for the token.
Issue a new User PIN and repeat the entry.

Under SO PIN enter the standard PUK received from the manufacturer or the PIN issued
when the token was initialized.

Note: If you only fill in the User PIN (required) field, the user PIN must match the PIN which
was issued when the token was initialized. You then have no need to repeat the user PIN or input
a SO PIN.

7.

Click Issue token now.

The token is issued, the logon information written on the token and the token information saved
in the SafeGuard Enterprise database. You can display the data in the Token area in tab Token
Information.
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18.5.2 Issuing a token or smartcard to a Security Officer

When SafeGuard Enterprise is installed for the first time, the first Security Officer (SO) already
has the option of having themselves issued with a token and specifying the logon mode (see

Installation Guide). For all other security officers, a token is issued in the SafeGuard Enterprise
Management Center.

Prerequisite: The token must be initialized and the relevant PKCS#11 module must be activated.
You need the rights to be able to make entries for the SO.

In the SafeGuard Management Center, click Security Officers.

x
- Security Officer Properties
Enabled: [w]
Short Mame: | |
Description: |
Cell phone: |
|

E-mail:

‘alid From:
Walid until:
Logon From:
Lagon unkil:
Token logon:

Certificate:

EEEE
lopiss =

® Mo token O optional

O Mandatory

j Create, ., Irnpork. ..

M Master
[ Security
[[] Helpdesk Officer
[ Audit Officer

[[] Recovery Officer

"Security Officer Roles, Domains & Workgroups

@ v .Auko registered
v UTIMACO EDU

0] 4 | Cancel |

1. Connect the token to the USB interface. SafeGuard Enterprise reads in the token.

2. In the navigation window on the left, mark Security Officer and in the context menu select
New > New Officer.

3. Ifthe SO is to authenticate either with or without a token, in the work area on the right-hand
side activate Token logon: Optional.

4. If the SO is to only authenticate with the token, activate Token logon: Mandatory. With this
setting, the private key remains on the token. The token must always be plugged in, or the
system will need to be rebooted.

5. Ifyou wish to create a new certificate, click Create. Enter the password for the certificate twice
and confirm with OK. Specify the location for saving the certificate.
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6. If you wish to import certificates, click Import. Open the relevant certificate file. Searching is
first done in a certificate file, then on the token. The certificates may remain in whatever the
storage location is.

7. Activate the roles and domains that are to be assigned to the SO.

8. Confirm the entries with OK.

The SO is created, the token is issued, the logon data is, depending on the setting, written on the
token, and the token information is saved in the SafeGuard Enterprise database. You can display
the data in the Token area in tab Token Information.

18.6 Putting certificates on a token or smartcard

Not only logon information but also certificates can be written to a token. Just the private part of
the certificate (.p12 file) may be saved on the token. However, users then normally can only access
their private key when logging on with the token. It is recommended that PKI certificates are
used.

You can assign authentication data to different types of token:
by generating certificates directly on the token
by assigning data which is already on the token
by importing certificates from a file

Note: CA certificates cannot be obtained from a token and stored in the database or certificate
store. If you wish (or need) to use CA certificates, these need to be available in file form and not
just on a token. This also applies to CRLs (Certificate Revocation List).

Moreover, the CA certificates must match the CRL on the token before users can log on to the
computers concerned. Please check that the CA and CRL are correct. SafeGuard Enterprise does
not carry out this check!

SafeGuard Enterprise can then only communicate with expired certificates if old and new keys
are present on the same card.

18.6.1 Generating certificates with tokens
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You can generate new certificates straight from the token if, for example, there is no certificate
structure present.

Note: If only the private part of the certificate is written on to the token, the user can only access
their private key with the token. The private key then only resides on the token. If the token is lost,
the private key can no longer be accessed.
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Prerequisite: The token is issued.

In the SafeGuard Management Center, click Users & Computers.

1.

2.

4.

Plug the token into the USB interface. SafeGuard Enterprise reads in the token.

Mark the user for whom a certificate is to be generated, and open the Certificate tab in the
work area on the right-hand side.

Click Generate and assign certificate by token. Note that the length of the key must match
the size of the token.

Select the slot and enter the token PIN. Click Create.

The token generates the certificate and assigns it to the user.

18.6.2 Assigning token certificates to a user

If there are already certificates on the token which you wish to assign to the user, proceed as
follows:

Prerequisite: The token is issued.

In the SafeGuard Management Center, click Users & Computers.

1.

2.

4.

Plug the token into the USB interface. SafeGuard Enterprise reads in the token.

Mark the user for whom you want to assign a certificate, and open the Certificate tab in the
work area on the right-hand side.

Click the Assign a certificate from a token icon in the SafeGuard Management Center
toolbar. Select the relevant certificate from the list and enter the token's PIN.

Confirm with OK.

The certificate is assigned to the user.

18.6.3 Putting a certificate from a file onto the token

If you want to add the private part of the certificate (.p12 file) from afile to the token, proceed as
follows:

Prerequisite: The token is issued.

In the SafeGuard Management Center, click Tokens.
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4.

Plug the token into the USB interface. SafeGuard Enterprise reads in the token.

Mark the token to which you want to add the private part of the certificate and, in the work
area on the right, open the Logon Information & Certificates tab.

. Click the P12 to token icon in the SafeGuard Management Center toolbar. Select the relevant

certificate file.

Enter the token's PIN and the password for the .p12 file and confirm with OK.

The private part of the certificate is added to the token. Now you need to assign it to a user, see
Assigning token certificates to a user on page 184.

Note: For a token with Kerberos support you need to select this procedure. The certificate must
be recognized by SafeGuard Enterprise and added to the token. If there is already an auto-
generated certificate, the imported certificate will overwrite it.

18.7 Assigning policies for tokens

When you assign policies you can specify other token options. These relate to:

PINs

Logon mode

Defining token PINs for POA autologon

What happens when the status of the token is no longer recognized
Unblocking the token

The middleware to be used (PKCS#11 module)

18.8 Using tokens to log on at the Power-on Authentication
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To log on at the Power-on Authentication using a token, proceed as follows:

Prerequisite: Note that the USB support is activated in the BIOS. The token support must be
initialized and the token issued for you.

1.

2.

3.

Plug the token into the USB interface.
Switch on the PC and wait until the Power-on Authentication stops.

Enter the token PIN.

You are logged on to SafeGuard Enterprise.
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Logon mode at the Power-on Authentication

There are two ways of logging on using a token. A combination of both logon methods is possible.
Logging on with user ID/password
Logging on with token

When logging on with token/smartcard, you can either select the non-cryptographic method
or the Kerberos (cryptographic) method. With Kerberos, Challenge/Response procedures are
not possible, as there is no logon information available in the POA.

The security officer specifies the method to be used for users and computers in a policy of type
Authentication.

18.9 Enabling POA autologon with default token PINs

With a policy distributed default token PIN automatic user logon may be achieved at the Power-
on Authentication. This saves issuing each single token separately and enables users to
automatically log on at the Power-on Authentication without any user interaction.

When a token is used at logon and a default PIN is assigned to the computer, the user is passed-
through at the Power-on Authentication without having to enter any PIN.

As a security officer you may set the specific PIN in a policy of type Authentication and assign it
to different computers or computer groups, for example to all computers residing in the same
location.

To enable autologon with a default token PIN, proceed as follows:
1. In the SafeGuard Management Center, click Policies.

2. Select a policy of type Authentication.

3. Under Logon Options in Logon mode, select Token.

4. In PIN used for autologon with token, specify the default PIN to be used for autologon. PIN
rules do not need to be observed in this case.

Note: This setting is only available if you select Token as possible Logon Mode

5. InPass-through to Windows set Disable pass-through to Windows. If you do not select this
setting when a default PIN is specified, you will not be able to save the policy.

If you want to enable the Pass-through to Windows option, you can later create another
policy of type Authentication with this option enabled and assign it to the same computer
group, so that the RSOP finally has both policies active.
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